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them, he enjoys the pictures immensely.
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Is a Macintosh the computer for you? I can
unequivocally answer, “Yes!” Why am I so
sure? Because Apple has been producing the
best consumer computers and programs for
many years now — desktops, laptops, and soft-
ware that surpass anything else now offered on
the market. (Yes, that includes companies
you've heard of, such as Dell, Microsoft, and
Gateway.) Macs are designed to be easy and
fun to use, and computing beginners will find
that Apple has a knack for writing the best per-
sonal computer software around.

Let me be honest: I'm not easily impressed
when it comes to computers. As a cynical old
computer programmer (and curmudgeon), ['ve
used every version of Windows that His
Gateness has produced, including the latest
Windows 7. I've used many Mac versions all
the way back to 1989. I am very sure that
you'll have the same great experience 1've had
using a Mac. They're just easy and fun!

The current operating system, Mac OS X (now
in version 10.7, called “Lion”) performs like a
Ferrari and looks as good, too. And don't let
that term OS throw you. That's just the name
for the engine under the hood. See? Easy. (And
the X in OS X is pronounced ten, not ex. Now
you're in the know.)

The book you hold in your hands is written
especially for seniors, using the classic For
Dummies design. You'll find easy-to-follow and
lighthearted step-by-step instructions for using
the major features of both your computer and
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Conventions Used in This Book

This book contains a helpful, simple
set of conventions. Here's what you

find:

The Tip icons in this book
point out information you
don’t want to miss.

w= Any fext you have o type (a
command that tells the computer to
do something or information such
as your name), appears in bold
like this: Type me. Then press the
Return key (on the keyboard).

w=» When you need to perform a set
of menu commands in a certain
order, they appear like this:
Edit=>Copy. In this example, you
click the Edit menu and then
choose the Copy menu item.

w= When you have fo tell the

computer what to do — like make
a word bold — you can use
keyboard shortcuts instead of a
menu. Keyboard shortcuts look like
this: 38+B. You press and hold the
88 key and then press B. (No need
to press Shift to make a capital
letter: Just press B or whatever.)

w= |f | mention a specific message
that appears on screen, it looks
like this: This message is
displayed.
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Lion. What you don’t find in this book is wasted space or a bunch of
intimidating computer terms. Everything is explained from the ground
up, just in case you've never touched a computer, let alone one from
Apple.

About This Book

This book is organized in a linear fashion (straight through) although
you don't have to read it that way (and certainly not in one session).
Having said that, you can certainly hop right to whatever chapter fits
the bill for you. If you do go to a more advanced topic — or just need
a refresher on something — I give you lots of signposts to other
related chapters where you can find more information.

The book is divided into parts, each of which covers a different area of
Mac knowledge. For example, you'll find parts on software, the Internet,
and Mac maintenance. And each chapter discusses a specific application,
connection, or cool feature of your Mac. So, feel free to begin reading
anywhere or skip chapters at will. I do recommend that you read this
book from front to back, like any good mystery novel, but it's your
choice. (Watch out — oncoming spoiler: For those who want to know
right now, Bill Gates did it.)

What's Truly Required

All you need to follow along with this book is a Mac running Mac OS
X version 10.7 (Lion). (A desk and good light and a mousepad are all
up to you.) Even if you have a Mac running an earlier version of OS X,
this book will still become a trusted friend although some of the
screenshots (figures) throughout the book will look a little different
than what you will see on your screen, and some things I talk about
might not quite jibe. If you're at the point of buying your Mac —
maybe you're standing in a bookstore right now! — go right to
Chapter 1 for some helpful advice on your choices and options.
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Here's the good news: You don’t require any of the following:

w= A degree in computer science: Apple designed Lion
and Macs for regular people, and I designed this
book for people of various experience levels. Even if
you've never used a Mac, you'll find safe waters here.

w= A fortune spent on software: Almost every program
covered in this book is included with Mac OS X
Lion — and the size of this volume gives you a
rough idea of just how complete Lion is! Heck,
many folks buy Macs just because of the free soft-
ware they get, such as iMovie and iPhoto.

w= An Internet connection: Granted, you can’t do
much with Apple Mail (e-mail) without an Internet
connection, but computers did exist before the
Internet. You can still be productive with Mac OS X
without receiving buckets of spam (junk e-mail).
And if you do already have an Internet connection,
this book helps you connect and become familiar
with the best of what's online!

nection. See Part IV for help on getting online. And
I also recommend using a power strip cord with a
surge protection feature for powering your Mac, but
that’s your call, too.

How This Book Is Organized

I did my best to emulate the elegant yet simple design of the Mac by
organizing this book into logical parts, with cross-references where
appropriate.

@ I'm guessing you probably do want an Internet con-
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Part I: Buying and Setting Up Your Mac

This part begins by helping you choose the right Mac for your needs.
You'll also find coverage on setting up your Mac, walking you through
the basics of plugging in cord A to slot B, using the mouse, and setting
the date and time.

Part II: Getting Started with Your Mac

With your Mac all set up, this is the part where the rubber meets the
road. Here, find the lowdown on the basic tasks that you'll do all the
time: copy files, run programs, and the like. See how to navigate and
customize your Desktop (your screen), work with files and folders,
and add and use printers, scanners, and faxes. This part also contains
oh-so-handy help on, um, Help for those times when you're temporar-
ily stuck (which won't happen very often!).

Part 11I: Having Fun and Getting Things Done with Software

Sweet! This part jumps right in among the crown jewels of Mac soft-
ware: Pages (word processing), Numbers (spreadsheets), iPhoto, the
DVD Player, iTunes, and playing games in Lion. Get ready to connect
your digital camera and MP3 player, too!

Part 1V: Exploring the Internet

Time to go online and find all the wonderful stuff available through
the Internet: e-mail, shopping, research, genealogy . . . all good stuff.
Here, you can read about Safari (Apple’s hot-rod web browser), which
is the “engine” that takes you online to the Internet. I tell you all
about Apple Mail (the e-mail program that comes on your Mac) and
iChat (Apple’s instant messaging application) and the automatic
online synchronizing provided by iCloud.

Part U: Taking Care of Your Computer

Maintenance may not sound exciting, but it keeps your Mac running
smoothly and your productivity high. Plus, the security information in
this part helps reduce your risks of identity theft, virus infection, and
swindles while you're on the Internet or using e-mail.
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Get Going!

I have just a few recommendations on how to proceed from here:

2

2

[T 2

[T 2

2

[T 2

2

Whether you're thinking about buying a new Mac or
your new Mac is still in the box unopened in your
living room, start with Part I.

If you want help setting things up, start with Part II.

If you already set up your Mac and you're familiar
with Lion basics, start with Part II1.

If getting online and using e-mail is your top prior-
ity, start in Part IV. Just realize that you might need
to go back through earlier chapters to set things up.

There’s also a cheat sheet! Find it at www . dummies.
com/cheatsheet/macsforseniors.

For all other concerns, use the index or check out the
table of contents to jump directly to the chapter you
need.

I might update this book from time to time. If so,
you can find those updates at www . dummies.com/
go/macsforseniorsfdupdates.

A Final Word

[ want to thank you for buying this book, and I hope that you find
that this edition of Macs For Seniors For Dummies answers the ques-
tions you have along the way! With this fearless guide in hand, I
believe that you and your Mac will bond as I have with mine. (That
sounds somewhat wrong, but it’s really not.)
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Always remember this as you make your way through this book or
come back to it for help: Take your time! Finding out how to use your
computer isn't a race, and if something doesn’t go quite right, don’t
worry. You won't break anything, there are no stupid questions, and
learning new things takes practice and a little patience. You don’t have
to be a graphic artist, professional photographer, or video editor. With
your Mac and its software by your side, you don’t have to be! All you
“have to be” is ready to have fun and learn.
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Buying and Setting
Up Your Mac

The 5th Wave By Rich Tennant
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“I'm ordering our new MacBook. Do
gou want it left-brain or right-brain
orientedz”
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Buying a Mac

S hopping for a Mac can leave you dazzled
by a long list of features, functions, acro-
nyms, and assorted hoohah. This chapter is
here to help explain what to look for, and why,
while you're shopping for a Mac, especially if
this is your first Mac.

The best part? I wrote it in common English,
with the least amount of technobabble possible.
(That’s my job!)

In this chapter, I show you

w= Tasks and work that your Mac can
perform

w=s Differences between hardware and
software

w= Differences between the models in
Apple’s Mac computer line

w= Features you should look for while shop-
ping for a monitor

w= Specifications you should look for when
comparing the central processing unit
(also known as CPU — the computer’s
brain) and memory
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Know What Your Mac Can Do

10

I would bet that you already know why you want a computer. You
have an idea what you want to do with a Mac, but you may not know
all the things you can do with a computer.

To help get you excited about owning a Mac, here’s a (very) short list
of only a few of the more popular uses for a computer these days. See
whether any of these uses reflects what you want to do, or you see any
tasks that you want to learn more about:

w= The Internet: You knew I would start with the web
and e-mail. Now you can also add online games,
instant messaging, chat rooms, shopping, banking,
and Internet radio to the mix. The Internet literally
expands in front of your eyes, and your Mac can be
your doorway to the online world.

w= Digital media: Whether your interest is photogra-
phy, video, or music (making it or listening to it),
your Mac comes with everything you need to get
started.

w= Data collection: If genealogy is your passion — or
collecting baseball cards or cataloging your DVD
library — your Mac can help you enter, organize,
and present your data.

w= Productivity stuff: Oh, yes! Your Mac can work hard
as well, with productivity programs such as Microsoft
Office and iWork. Compose documents, create
spreadsheets, and build professional-looking presen-
tations on your Mac with ease.

This list offers only a few high points. The more time you invest learn-
ing about your Mac and the software that’s available, the more you'll
get from it.
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Understand Hardware and Software

First-time computer owners often become confused about what consti-
tutes hardware and what should rightly be called software. It’s time to
clear things up!

In the computing world, hardware is any piece of circuitry or any com-
ponent of your computer with a physical structure. For example, your
Mac’s monitor is a piece of hardware, as is your keyboard. So are the
components you normally can’t see or touch (the ones buried inside
the case), such as your Mac’s power supply. And even your computer’s
case is technically a piece of hardware even though it’s not electrical.

Figure 1-1 illustrates a common piece of hardware — in this case, an
Internet router that connects a DSL or cable Internet connection with a
home network.

An Infernet router is a piece of hardware.

Figure 1-1

The other side of the computing coin is the software you use. Software
refers to programs you interact with onscreen. Examples include a

11
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word processing program that displays your typing, or a chess program
that enables you to move pieces onscreen. Figure 1-2 shows Apple’s
Aperture image editor, a photo editing program that helps you see and
organize digital photos.

® Aperture File Edit View Images Stacks Metadata Window Help 4 [ | <> &) Fri3:.07 AM Mark Chambers Q

[@)s]s] Aperture O
- : - : :
(7] 4 5. ) 5 =, " Q B
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Projects | Metadata | Adjustments

[Aproeats 1] =1 3 |

b i Library Q

¥ =1 Nature
¥ (=] Bird types
2] Birds of Prey
[ Blue jays
[ Humminghirds
Owls
] variety
» (27 Locations
|| Online portolia
[Ls: Slideshow selects (Five star) Q
¥ =1 Road Trip
] Book Layout
-] Daily Weh Journal
¥ (7] Light Tables
Arizona Light Table
California Light Table
New Mexico Light Table
Utah Light Table
S NEEY A S wary (=) (=)o =]
» (5] Games -
LLss Selects
¥ =1 Wedding
I 5-Star a
» [*7] Imaging
=] Proof Book
|| Wedding Web Proais

[image pate 1) [a] e = RG] [

| vault

Q
D
*

Apple's Aperture image editor is a software program.
Figure 1-2

Essentially, computer hardware and software work together so that
you can do various tasks on your computer.

When you hear folks discussing a software upgrade,
patch, or update, they're talking about (you guessed
it) another piece of software! However, the upgrade-
patch-update program isn’t designed to be run more
than once; rather, its job is to apply the latest

12
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features, fixes, and data files to a piece of software
that’s already installed and running on your Mac, to
update it to a new version. (Virtually all software
developers refer to successive editions of their soft-
ware, such as Version 1.5 or Version 3; the later the
version, generally the more features the software
includes.) In Chapter 17, you find out how to main-
tain your Mac with updates.

Choose a Desktop or Laptop

First, some quick definitions: A desktop Mac is designed to sit on your
desk, and uses a separate monitor, keyboard, and mouse. Examples are
the iMac, Mac mini, and Mac Pro. The iMac is a special case: It's an
“all-in-one” computer, where the monitor and computer are both
housed in the same case to save space. However, the keyboard and
mouse still reside separately from the iMac’s “picture frame” case.

On the other hand, a laptop Mac is portable. You can carry the whole
package with you because laptops have a built-in keyboard, a trackpad
(the square pointing device which takes the place of a mouse), and

an attached monitor. MacBooks are laptop computers. Laptops are

as powerful as most of the Mac desktop line, and MacBooks offer
desktop-type features, such as high-resolution graphics, up to 17"
screen displays, large hard drives, and wireless networking.

So, should you buy a desktop or a laptop Mac? If portability is a
requirement — maybe your job or your lifestyle demands travel —
you'd want to opt for a laptop, like a MacBook Air or MacBook Pro.

If you're sitting on the fence and portability is a lesser requirement,
though, I generally recommend getting a Mac desktop system, for
these three reasons:

w= MacBooks aren’t as upgradeable as desktops.
Although you can attach plenty of peripheral (exter-
nal) devices (like a printer or scanner) to a MacBook
by using cables, high-end Mac desktops are easier to
upgrade because you can add newer, more powerful

www.it-ebooks.info
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Bottom line, if portability isn't important, opt for a desktop — Mac
mini, iMac, or Mac Pro — depending on the processing power you
need, as described in the following section, and the desk space you

hardware inside your computer. For example, you
might upgrade the graphics card on a Mac Pro —
and that’s impossible to do on a laptop.

MacBooks are more expensive than desktop Macs
of similar capability. My friend, you pay dearly for
that portability. If you don’t need it, jump to the
desktop side of the fence. It's as simple as that.

Laptops cost much more to repair. Part of the
MacBook portability stems from the Apple practice
of shoehorning all hardware onto one circuit board
to save space. So, if one piece malfunctions, you
have to take apart the whole thing, which isn't an
easy task.

have available.

Know How Much Computing Power Is Too Much

14

Take a moment to consider which tasks your Mac will be used for —
not only now but also a year or two down the road. If you plan to try
your hand at any of the following tasks, feel free to label yourself as a

power user:

nmp

Iy

High-resolution photography or video editing: If
you want to edit high-resolution digital photography
(images from a 16 megapixel camera, for example)
or any type of video editing (including the iMovie
application that’s part of iLife), you need a Mac with
horsepower. Think of serious hobbyists or profes-
sional photographers or videographers.

Running resource-hogging software: The perfect
example is Adobe Photoshop, a program you use to
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work with high-resolution images that demands the
highest level of horsepower your Mac can deliver,
along with requirements for more system memory
(or RAM). Today’s 3-D games also require a powerful
Mac to run well.

If the preceding points apply to you, you need a powerful iMac desk-
top, Mac Pro desktop, or MacBook Pro laptop.

®

If you know the specific programs you'll be running,
check the requirements for that software on the man-
ufacturer’s website or from the program’s packaging
(typically found on the side of the box). That way,
you can gain a better idea upfront whether you need
to invest in a more expensive, more powerful Mac
Pro or MacBook Pro.

On the other side of the coin, these activities require less computing
power:

2

2

[T 2

2

2

Surfing the web
Sending and receiving e-mail
Keeping track of a large, digital music library

Using programs such as Microsoft Office and iWork
for tasks such as creating documents

Storing and sharing digital photos and video of
friends and family

If the preceding tasks are more your speed, any Mac in the current
product line would suit you, including the significantly less-expensive
Mac mini or standard MacBook Air.

®

If you have a large library of digital audio and
video — say 40 to 60GB — you should note that the
MacBook Air has a relatively small amount of

15
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storage, so you'll need an external hard drive to hold
all that stuff.

Choose a Price Range

If you're working on a limited budget and you want a new Mac com-
puter (rather than search for a used machine), your choice becomes
simpler. The least expensive Mac — the Mac mini — is no pushover,
and it handles the Office and iWork suite programs that [ mention in
the preceding section (with aplomb, even).

inexpensive is that it doesn’t come with a keyboard,
mouse, or monitor. Yup, you have to buy those items
separately. Or if you're lucky, you can scavenge a flat-
panel monitor, keyboard, and mouse from an old
computer or from a friend who has spare computer
hardware on hand.

@ However, part of the reason why the Mac mini is

The least expensive iMac also fits into a smaller budget, and it includes
everything you need, including its built-in monitor. On the laptop
side, the standard-issue MacBook Air provides plenty of punch for
those same Office and iWork productivity programs.

Power users, you have few choices: If you're going to run top-of-the-
line software that requires top-of-the-line performance, you're limited
to the most expensive iMac, Mac Pro, or MacBook Pro. 'Nuff said.

Table 1-1 illustrates price ranges for each model in the Apple line as of
this writing.

Apple controls its hardware prices quite closely, so
you won't find a huge price difference between order-

ing directly from Apple.com (or an Apple Store) and
from another store.

16
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Table 1-1 Macintosh Computer Price Ranges
Computer Model Best Suited For Price Range Pros & Cons
Mac mini desktop Entry level to typical ~ $600-800 No monitor, DVD
ome computing drive, keyboard, or
mouse
iMac desktop Midrange to power ~ $1,200-2,000 Builtin monitor
user
Mac Pro desktop Power user $2,500-5,000 No monitor
MacBook Air laptop  Typical home $1,000-1,600 No builtin DVD
computing drive
MacBook Pro laptop ~ Midrange to power  $1,200-2,500 Builtin DVD drive,
user but significantly
heavier than the
MacBook Air

When you order a Mac from Apple.com, though, you can tweak these
prices by a significant amount by using the Configure feature. For
example, you might save $200 on the price of an iMac by opting for
less storage capacity. (On the other hand, if you're looking to improve
the performance of your pick, you might decide to spend more on a
faster video card than the standard model sports.) See the section
“Compare Processors, Memory, and Hard Drives” for more informa-
tion about these options.

Select a Monitor

No matter how powerful your Mac may be, if it's hooked up to a low-
quality monitor, you'll see only chunky, dim graphics. Not good.
Hence this section, where I tell The Truth about the two most impor-
tant specifications you should consider while shopping for a monitor:
resolution and size:

If you decided on an iMac (desktop) or a MacBook
(laptop), you can skip this section because those
computers have built-in monitors. However, keep in
mind that you can hook up external (add-on)

www.it-ebooks.info


http://www.it-ebooks.info/

Part I: Buying and Setting Up Your Mac

18

nmp

-y

monitors to any Mag, so if you expand your system,
you may want to return here.

Resolution: Your video system’s monitor resolution is
expressed in the number of pixels displayed horizon-
tally and also the number of lines displayed vertically.
(A pixel is a single dot on your monitor.) For example,
a 1024 x 768 resolution means that the monitor dis-
plays 1024 pixels horizontally across the screen and
768 pixels vertically. (Any resolution less than 1280 x
800 is barely usable these days. Higher resolutions are
1440 x 900, 1600 x 1200, and 1920 x 1080.)

Just remember, the more pixels, the higher the reso-
lution. And the higher the resolution, the more
information you can fit on the screen, but the
smaller that stuff appears, which I find a strain on
my older (read: wiser and more mature) eyes. The
good news, though, is that higher resolutions make
graphics look crisper.

Only you can determine the best display resolution.
The decision is completely personal, like choosing a
keyboard that feels “just right.” While shopping for a
monitor, try a wide range of resolutions to see which
one suits your optic nerves.

Size: Monitors come in several sizes, starting at
approximately 17 inches. All monitors are measured
diagonally, just like how TVs are. You can easily find
larger monitors, at 24 inches and even larger.

In general, the larger the monitor, the easier it is on
your eyes. At the same resolution, a 19" monitor dis-
plays the same images as a 17" model, but the image
is physically bigger, and the details stand out more
clearly.
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For general home use, a 17" monitor is fine. If you
prefer to view larger text and graphics, or do graph-
ics-intensive work for several hours at a time, or plan
to do a lot of gaming, I would point you toward a
19" monitor at minimum. (As my editor says, pick-
ing out a monitor size is much easier if you visit
your local electronics store and “stare to compare,”
just like you would when shopping for an HDTV.
Check out which monitor sizes are easiest on both
your eyes and your budget.)

And what about that old CRT (cathode ray tube)
monitor that you once used with your PC? Is it worth
rescuing? To be honest, I recommend that you get rid
of a CRT monitor in favor of a flat-screen LCD or
LED monitor. Older CRT monitors can’t handle the
high resolutions offered with today’s Macs.

Compare Processors, Memory, and Hard Drives

When you hear Mac owners talk about the speed and performance of
their computers, they're typically talking about one of four different
components (or all these components as a group):

[T 2

2

System memory, or random access memory
(RAM): The more memory your Mac has — and the
faster that memory is — the better your computer
performs, especially on Mac OS X Lion (pronounced
oh-ess-ten, not ex), which is the operating system on
a Mac. I'm sure that you've heard of Windows, the
operating system used by virtually all home PCs.
Well, Lion does the same job in the Apple world that
Windows performs in the PC world.

Central processing unit (CPU): Macs now use either
an Intel Core i5/i7 processor or its faster cousin, the
Xeon. A processor performs all the millions of calcu-
lations required for both your software and Mac OS
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X Lion to work. The speed of your processor is mea-
sured in gigahertz (gHz) — and, of course, the faster
the speed of your processor, the faster your Mac
performs.

significant performance boost, so a quad-core proces-

@ Each core that’s built into your processor provides a
sor is faster than a dual-core processor.

w= Hard drive space: The higher your hard drive capac-
ity, the more documents, programs, songs, and mov-
ies you can store and use. (Some current Mac laptops
and desktops can be ordered with solid-state drives,
which are lower in capacity but faster and more reli-
able than traditional hard drives. MacBook Air mod-
els offer anywhere from 64GB to 256GB of
solid-state storage.)

w= Graphics processing unit (GPU): This item is the
graphics chip used on your Mac’s video hardware.
The more memory allotted to your video chip and
the faster it is, the smoother and more realistic your
3-D graphics.

For a typical home Mac owner, a minimum of 2 gigabytes (GB) of
RAM and a Core i5 processor should provide all the power you need.
Power users shouldn't settle for less than 4GB of RAM and the fastest
processor that Apple offers for your specific model. (Mac Pro owners
can even opt for a monstrous 12-core system, with two 6-core Xeon
processors. Talk about supercomputing!)

Decide Which Software Vou Want

When you buy a Mac directly from Apple, you also can immediately
purchase a few Apple programs and extras for your new system. These
add-ons include the ones in this list:

20
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w= jWork: The Apple office productivity suite includes
Pages, for word processing; Numbers, for spread-
sheets; and Keynote, for creating presentations. I dis-
cuss Pages in Chapter 8 and Numbers in Chapter 9.
Each application in iWork can be bought separately
for about $20.

w= One to One: This new Apple service is great for
those Mac owners living close to an Apple Retail
Store. You get personal help from an Apple techni-
cian on setting up and using your new Mac, along
with assistance on the software you've installed.
One to One will set you back $99 for a year’s
subscription.

w= AppleCare: AppleCare is the Apple extended war-
ranty and service plan. I recommend AppleCare for
any MacBook owner because your laptop tends to
endure quite a bit of road warrior treatment while
you're traveling. (Prices vary according to the type of
computer.)

Buy Online or at the Apple Store

Should you spend your money online? In my opinion, the short
answer is yes because of three important advantages to online
shopping:

w= You may escape paying sales tax. Depending on
your location (and the location of the online store),
you may not have to pay any sales tax on your Mac
purchase, and that’s a hefty advantage.

w= You don’t need a nearby Apple Store. Some of us
aren’t lucky enough to live within easy driving dis-
tance of an Apple Retail Store or Apple reseller, but
Apple.com is open 24/7, and shipping on new Mac
computers is free.
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m= Apple.com is a premiere web store: You can not
only configure your Mac while browsing to save
money or increase performance (as I mention earlier
in this chapter), but also rest assured that Apple fol-
lows a strict privacy statement and offers secure

encrypted shopping. That means your credit card
information is safe.

You gain two major advantages by shopping in person, however: You
can ask questions and receive answers from a trained salesperson
before you buy, and you can drive away with that fancy box in your
trunk (without having to wait a few days).
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Setting Up
Vour Mac

Remember the classic iMac advertisements

that touted the one-plug approach to the

Internet? The entire campaign was centered on
one idea: The Internet was supposed to be easy
to use.

That's the Mac Way, and our good friends at
Apple do their best to make sure that hardware
and software work together as closely as possi-
ble. (Read about hardware and software in
Chapter 1.) Their hard work means that you're
left with as few configuration and technical
details as necessary while setting up your sys-
tem. In this chapter, I cover the relatively few
details you still do have to worry about.

In this chapter, I show you how to

w= Find the perfect spot for your Mac and
then unpack it.

w= Connect all the gizmos and doodads that
came with your Mac.

w= Set up your account, as well as any addi-
tional accounts you need.
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Choose a Location for Your New Mac

If you choose the wrong spot to park your new Mac, I can guarantee
that you'll regret it. Of course, not all domiciles and office cubicles
offer a choice — you have one desk at work, for example, and nobody
will hand over another one — but if you can select a home for your
Mac, consider these important points:

w= Keep things cool. Your new Mac is silent, but that
superfast Intel processor generates heat. Make sure
that the location you choose is far from heating
vents and shielded from direct sunlight. If you're
using a laptop, I also recommend a cooling pad,
which elevates the base of your laptop to allow air to
circulate underneath (some even include a fan).

w= Qutlets are key! Your computer needs a minimum
of at least one nearby outlet, and perhaps as many
as three:

e A standard AC outlet (using a current adapter if
you're traveling abroad, if necessary).

terruptable power supply (UPS) unit comes in
handy, providing multiple AC outlets from a sin-
gle jack. At the same time, these strips also pro-
vide protection against power surges, while
making it easy to turn off all your peripherals
with a single ON/OFF switch while you're away
on vacation.

@ Here’s where a surge suppressor strip or an unin-

e A telephone jack (if you have an external USB ana-
log modem for connecting to the Internet or send-
ing and receiving faxes)

e A nearby Ethernet jack (if you use your Mac’s built-

in Ethernet port for connecting to a wired Ethernet
network, a DSL. modem, or a cable modem)

24
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If you prefer to send your data over the airwaves,

@ consider wireless networking for your Mac. Your
local Apple reseller can offer an AirPort Extreme
wireless base station that provides a wireless net-
work with a shared Internet connection among
all the computers in your home or office. (The
Apple Time Capsule unit also acts as a base sta-
tion, with the extra protection of a wireless
backup drive.)

w= Don't forget the lighting. In the words of Moms
everywhere, “You can’t possibly expect to work with-
out decent lighting! You'll go blind!” You need a
desk lamp or floor lamp, at a minimum.

w= Plan to expand. Allow an additional foot of space
on each side of your Mac on your desk. That way,
you have room for external peripherals, more power-
ful speakers, and an external keyboard and mouse if
you need one.

Unpack Vour New Mac

You're going to love this section because the configuration of a Mac is a
piece of cake. (Sorry about the cliché overload, but this really is easy.)

Follow these guidelines when unpacking your system:

w= Check for damage. I've never had a box arrive from
Apple with shipping damage, but I've heard horror sto-
ries from other people (who claim that King Kong
must have been working for That Shipping Company).

you find significant damage, take a photograph

@ Check all sides of the box before you open it. If
(just in case).
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Search for all the parts. When you're removing
those chunks o’ foam, make certain that you check
all sides of each foam block for parts snuggled
therein or taped for shipment.

Keep all packing materials. Do not head for the
trash can with the box and packing materials. Keep
your box and all packing materials for at least a year,
until the standard Apple warranty runs out. If you
have to ship your computer to an Apple service cen-
ter, the box, including its original packing, is the
only way for your machine to fly.

Smart computer owners keep their boxes much lon-
ger than a year. If you sell your Mac or move across
the country, for example, you need that box. Trust me
on this one.

Store the invoice for safekeeping. Your invoice is a
valuable piece of paper indeed. Save the original
invoice in a plastic bag, along with your computer’s
manuals and original software and other assorted
hoohah. Keep the bag on your shelf or stored safely
in your desk and enjoy a little peace of mind.

Read the Mac manual. “Hey, wait a minute, Mark.
Why do I have to read the manual from Apple along
with your tome?” Good question, and here’s the
answer: The documentation from Apple might con-
tain new and updated instructions that override what
I tell you here, including some subtle configuration
differences between each Mac model. (For example,
“Never cut the red wire — cut the blue wire instead,”
or something to that effect.) Besides, Apple manuals
are rarely thicker than a restaurant menu.

You can always download the latest updated manu-
als for Apple computers in electronic format from the
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Apple website at http: //support.apple.com/
manuals. Adobe PDF format is the standard for read-
ing documents on your computer, and Lion (the
operating system on your new Mac) can open and
display any PDF document. I always keep a copy of
the PDF manual for my MacBook Pro on my hard
drive, just in case.

Get Power

After your new Mac is resting comfortably in its assigned spot, you
need to make that important first required connection: the power
cable. Plug the cable into the corresponding socket on the Mac first,
and then plug ‘er into that handy wall outlet. (Don't turn the com-
puter on yet; we're not quite to that point.)

Figure Qut Ports

N4
IIO’

Before you make any connections between the outside world and your
Mac, this is a good spot to cover the ports on your Mac. In computer-
speak, a port isn't where the cruise ship docks — ports are those rows
of holes on the sides of your computer. Each port connects a different
type of cable or device, allowing you to easily add all sorts of function-
ality to your computer.

Here's a list of what you'll find and a quick rundown on what these
ports do. These connections are for external devices and networking:

w= FireWire: This port is the standard in the Apple uni-
verse for connecting external hard drives and DVD
recorders, but it does double duty as the connector
of choice for peripherals such as your digital video
(DV) camcorder. (A peripheral is another silly tech-
nonerd term that means a separate device you con-
nect to your computer, such as a camera or printer.)
All of today’s Mac computers have at least one
FireWire 800 port onboard, except for the MacBook
Air (which carries only USB ports).
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USB: Short for Universal Serial Bus, the familiar USB
port is the jack-of-all-trades in today’s world of com-
puter add-ons. Most external devices that you con-
nect to your Mac (such as a portable hard drive,
scanner, and digital camera) use a USB port, and so
does the iPod. Depending on the Mac model you're
using, you can have up to four USB ports (even
MacBooks sport two of them). Macs include USB 2.0
support, but at the time of this writing Macs do not
offer USB 3.0 ports.

Thunderbolt: The Thunderbolt port is the new
“Konnection King.” Thunderbolt provides the abso-
lute fastest performance for all sorts of external
devices, everything from external hard drives to
monitors. Unfortunately, the Thunderbolt standard
is still a relative newcomer on the Apple scene, so it’s
harder to find Thunderbolt peripherals at the time of
this writing, and they cost significantly more than
their USB and FireWire counterparts. Hopefully, the
prices on Thunderbolt devices will drop as their pop-
ularity increases.

Ethernet: All of today’s Macs, except the MacBook
Air, include a standard gigabit Ethernet port, so your
Mac is ready to join your existing wired Ethernet net-
work. (Alternatively, you can go wireless for your
network connection.) Gigabit indicates the speed of
the network connection — today’s Macs can handle
the fastest network speeds you're likely to encounter
at your home or office, so feel free to be smug.

As I mention earlier, the MacBook Air is designed to
be completely wireless, so it doesn’t have a wired
Ethernet port. If necessary, you can add a USB
Ethernet adapter to have a wired network port on
your Air.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 2: Setting Up Your Mac

1O

HDMI

=

ho

digital

Connections for external video and audio are described in this list:

w= DVI connector: This port lets you send the video sig-
nal from your Mac to a DVI monitor (or, depending
on the model, even to S-Video output for your TV
and VCR).

w=  HDMI connector: Some Mac models allow you to
send video to an HDMI-equipped monitor or high-
definition TV.

w= Headphone/optical output: You can send the high-
quality audio from your Mac beast to a set of stan-
dard headphones or an optical digital audio device,
such as a high-end home theater system.

w= Optical line in: Last (but certainly not least) is the
optical audio Line In jack, which lets you pipe the
signal from another audio device into your Mac. This
one comes in particularly handy when you record
MP3 files from your old vinyl albums or when you
want to record loops in GarageBand (the music cre-
ation application that’s included in iLife).

Access the Internet

'\P’.

If you have active Internet access or a local computer network, you
need to also make at least one of the connections in this section.

For dial-up: If you get on the Internet by dialing a standard phone
number, and your computer has an external Lion-compatible USB
modem (a little box connected to your telephone line that makes all
kinds of squeaks and skronks when you get on the Internet), you
should make three more connections:

Plug your USB external modem into one of the USB
ports on your Mac. (The connector only goes in one way,
which is a Good Thing.)
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Plug one of the telephone cable’s connectors into your
external modem.

Plug the other telephone cable connector into your tele-
phone line’s wall jack.

NetZero, AOL, or some other company, should pro-

@ Your ISP (Internet service provider), such as AT&T,

G 1.

vide you with account information and details on
configuring your Internet settings for dial-up access.

High-speed Internet service: If your Internet connection is supplied
by DSL or cable, the connection between your broadband modem and
your Mac is likely through an Ethernet cable. If you're in an office or a
school with a local computer network, you can probably connect by
using your Mac’s built-in Ethernet port. You make two connections:

Plug one end of an Ethernet cable into the Ethernet port
on the Mac. (An Ethernet connector looks like a tele-
phone cable connector, but it’s a little wider. If you can't
locate the cable, yell for help from your network guru or
cable/DSL provider.) The MacBook Air doesn’t have an
Ethernet port built in although you can add one by buy-
ing a USB-to-Ethernet connector.

Plug the other end of the Ethernet cable into the Ethernet
port from your network.

Your network port is probably one of the following: an
Ethernet wall jack, an Ethernet hub or switch, or a cable
or DSL Internet router (or sharing device).

Use Keyboard/Mouse/Monitor

30

If your Mac arrives with a wireless mouse, keyboard, or trackpad,
insert the batteries as shown in the setup guide, and always turn on
the wireless devices before you turn on your Mac.
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If you have a wired USB keyboard and mouse, on the other hand, a
couple of connections are necessary:

Plug the USB connector from your keyboard into one of
the USB ports on your Mac.

Plug the USB connector from your mouse into one of the
USB ports on your keyboard.

Apple provides USB ports on most keyboards to prevent you from
using up all your USB ports just for necessary gear.

As I mention in Chapter 1, some Apple models have their monitors
built in, like the all-in-one iMac or the MacBook line of laptops. If you
have one of these models, pat yourself on the back and do the Built-In
Technology Dance because your monitor is good to go.

If, however, you need to connect a monitor to your Mac Pro system,
follow these steps:

Plug your monitor into a wall socket and turn it on. (No,
you won't see anything yet because you haven’t yet pow-
ered on your computer.)

Plug the DVI connector from your monitor into your
Mac’s DVI port, or to the DVI adapter provided with your
Mac. (DVI stands for Digital Visual Interface, which you
don't really need to know, but it makes great coffee-table
trivia.)

panel monitors and TVs, but if you didn't get one

@ DVI cables are standard equipment with today’s flat-

with yours, you can pick up a DVI cable at your local
electronics store.

may also be able to connect to an HDMI monitor

@ Depending on the model of Mac you've chosen, it

or high-definition TV using an HDMI port. The
Thunderbolt port included on the latest Mac models
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can also be used to connect a monitor to your
system.

Use Vour Mouse

Okay, you may have used a mouse before on other computers, but if
you're using a new Apple Magic Mouse, there’s more you should
know. The wireless Magic Mouse from Apple (and shown in Figure
2-1) is shaped like most mice you've likely used with other computers,
but here are two major differences:

w= [t has no buttons. The entire surface of the mouse
acts as the buttons! Press down with one finger any-
where on the top surface to left-click, and on the
top-right corner to right-click (the top-left corner for
you lefties).

w= [t recognizes multitouch gestures. The surface of
the mouse can also be used like a laptop’s trackpad.
In fact, you can also opt to use an Apple Magic
Trackpad rather than a mouse with your desktop
Mac. If you've used an iPhone, iPad, or iPod touch,
you're familiar with many of these gestures already.
For example, if you're reading a long web page that
covers multiple screens, press your finger on top of
the mouse and move your fingertip down to scroll
down and display the additional text.

Figure 2-1

32
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s The Magic Mouse uses an advanced laser optical

system and doesn’t require a mouse pad or special
surface to work. However, if you would rather not
use your mouse on that expensive desk, a standard
mouse pad might come in handy.

When you move your mouse across your desk, the mouse cursor
moves along with it across your screen, in the same direction. Lion is
always aware of what your mouse cursor is on top of at the moment,
allowing you to left-click, right-click, and double-click items to launch
applications or turn things on and off. (More on this in upcoming
chapters.) In the same fashion, moving your finger across the surface
of a trackpad produces the same cursor movement on your screen.

Turn On Your Mac and Run Mac 0S X Setup

After you press the Power button on your Mac — on either the side of
the keyboard, or the front or back of the case — you hear the soon-to-
be-familiar boot chime, and the Apple logo appears on your screen. A
progress bar appears below the Apple logo to indicate that Mac OS X
is loading.

In moments, you'll marvel at those beautiful rounded edges, brushed
stainless steel surfaces, and liquid colors of the Mac OS X interface.
Your Mac runs Lion, the latest version of the Mac OS X operating sys-
tem (most PCs run Windows as an operating system). But wait —
you're not quite done yet. Mac OS X needs to be personalized for you,
just like your smartphone or your car’s six-way power seat. And to do
that, use the handy Setup Assistant, which automatically appears the
first time you boot Mac OS X Lion.

These assistant screens change periodically — and they’re completely
self-explanatory — so I won't march you through each one step by
step. However, here are a few tips that provide a bit of additional over-
the-shoulder help while you're setting things up:

w= How rude! Mac OS X defaults to U.S. formats and
keyboard layouts. If you're outside the United States
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(or other English-speaking countries), though, rest
assured, that Mac OS X does indeed provide full sup-
port for other languages and keyboard configura-
tions. To display these options in the list boxes, click
the Show All button at the bottom of the keyboard
assistant screen.

Accounts are important. Mac OS X will ask you to
create your account, which identifies you when you're
using your Mac. Mac OS X uses the name and pass-
word you enter to create your account, which you
use to log in if you set up a multiuser system for sev-
eral people. When you're creating your account, don't
forget your password! That's very important. And here’s
a big hint: Passwords are case-sensitive, so THIS is
different from this or ThiS. Enter a password hint if
you want, but don’t make the hint easy to guess. For
example, My first dog’s name is probably preferable to
Plays Seinfeld on TV. Never write down your pass-
words, either; crib sheets work just as well for others
as for you.

I need to fix that. You can click the Back button at
any time to return to previous assistant screens. Mac
OS X, the bright child that it is, automatically saves
your choices for you so that when you click
Continue to return, everything is as you left it.

Extra stuff. Whether you decide to accept the news,
offers, and related-product information from Apple
is your decision. However, you can easily find this
same information on the Apple website, so there’s
no need to engorge your e-mail inbox.

Local area network (LAN) connections. If you're
connecting your Mac to an existing network (or
you're using an Internet router), click Yes when
you're asked whether you should use the configura-
tion supplied by the existing server.
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w= Have your Mail settings handy. If you set up iCloud
(Apple’s online system for sharing data between your
Mac, iPhone, iPod touch, and iPad), Mail sets up
your free iCloud e-mail automatically — again, this
is A Good Thing. However, if you're setting up an
existing account, make sure that you have all the silly
settings and numbers and names that your ISP sup-
plied when you signed up. This stuff includes your
e-mail address, mail server variety, user account ID,
password, and outgoing mail server. (Lion does the
best it can to help you fill out this information auto-
matically, but it can only do so much.)

Change Your Account Password

One task performed by the Lion Setup Assistant is the creation of your
user account, where you enter a username and choose a password.

Many folks like to change their passwords regularly. I should know —
I'm one of them. It’s especially important to be able to change your
password if someone else discovers it — and that includes kids who
may not treat your files and documents with the respect they deserve!

I recommend that you change your account password
at least once every six months for extra security.

You can easily change the password for your personal account. Follow
these steps:

1. Move the mouse cursor over the Apple icon (®) in the
upper-left corner of your Lion Desktop and then click
that icon.

2. Click the System Preferences menu item that appears.

Lion displays the System Preferences window.
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3. Click the Users & Groups icon to display the settings you
see in Figure 2-2.

Click to change your password.

[-NsNa] Users & Groups
| «| > || Showal | Q
_ Password Login Items
: ! é | Change Password... |
m Benjamin Franklin =
Standard
1 Guest User Full name: Mark Chambers
Sharing only
}I Apple ID: rs@mail.com | Change... |
Address Book Card: | Open... |
[ Allow user to reset password using Apple ID
¥ Allow user to administer this computer
Q‘ Login Options
|_| Enable parental controls | Open Parental Controls... |
+ | = - -
¢ Click the lock to prevent furgher changes. ( ? )
Select your account. Login Options button

New User button
Figure 2-2

4. Click your account in the list on the left side of the Users
& Groups pane.

5. Click the Change Password button to display the sheet
you see in Figure 2-3.

disabled — or “grayed out” — click the padlock icon at
the bottom of the window. If prompted, type your old
password to unlock the pane.

@ If you can’t click the Change Password button because it’s

36
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(3] Users & Groups
| [Showait ]
Old password: < -
Q New password: +Q—
word... |
m Benjamin Fra Verify: %
Star d
L Fugsl‘IUSIer Password hint
) (Recommended)
| Change...
Cancel | | Change Password |
Address Book Card: | Open... |
Allow user to reset password using Apple ID
¥ Allow user to administer this computer
ﬁ Login Options
Enable parental controls | Open Parental Contrals...

+ | = | #-
o
I Click the lock to prevent further changes. (?7)
.

Figure 2-3
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Type your old

password here.

Type your new
password in
both boxes.

6. Type your old password and then press Tab on your key-
board to move to the next field.

7. Type a new password in the New Password text box and
then press Tab to move to the next field.

8. Type your new password a second time in the Verify text
box. (This ensures that you didn’t accidentally type it

wrong the first time.) Press Tab to continue.

9. Type a short password hint that reminds you of the pass-
word you chose (just in case you forget it).

10. Click the Change Password button.

1 1. Click the red button in the upper-left corner of the
System Preferences window to close System Preferences
and save your changes.
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Add Another Account to Your System
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If you share your Mac with other people, it's time to add one or more
accounts. (If you are the only person who uses your Mac, you can
guiltlessly skip over this task.) “But why give another person a unique
account, rather than just let them use my account?” Good question! If
a person has a unique user account, Lion can track all sorts of things,
leaving your computing environment (such as your Desktop and files
and settings) blissfully pristine. A user account keeps track of informa-
tion such as

w=  Address Book contacts

w= Safari (Apple’s Internet browser) bookmarks and
settings

w= Desktop settings (including things like background
images and screen resolutions)

w= iTunes libraries, just in case that significant other
buys his or her own music (sigh)

User accounts keep other people from accessing your stuff, and you can
lock other accounts out of where-others-should-not-be, such as certain
applications, iChat, Mail, and websites (including that offshore
Internet casino site that your nephew favors).

Each user account you create also has a separate, reserved Home folder,
where that person should store all his documents. Each user's Home
folder has the same default subfolders, including Movies, Music,
Pictures, Sites, and such. A user can create new subfolders within his
Home folder at any time.

Here's one more neat fact about a user's Home folder: No matter what
the account level is, most of the contents of a Home folder can’t be
viewed by other users. (Yes, that includes admin-level users. This way,
everyone using your Mac gets her own little area of privacy.) Within
the Home folder, only the Sites and Public folders can be accessed by
other users — and only in a limited fashion.
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A word about accounts and levels

Get one thing straight right off the bat: You are the administrator of your Mac.
In network-speak, an administrator (or admin, for short) is the one with the
power to Do Unto Others — creating new accounts, deciding who gets access
to what, and generally running the multiuser show. In other words, think of
yourself as the Monarch of Mac OS X (the ruler, not the butterfly).

Next up is the standarcHevel account. Perfect for most users, this type of account
allows access to just about everything but doesn’t let the user make drastic
changes fo Lion or create new accounts themselves.

Finally, the managed account with parental controls is a standard account with
specific limits assigned by either you or another admin account. This account
is useful for the underage set who might be using your Mac.

Remember: Never assign an account administrator-level access unless you
deem it truly necessary. Standard accounts are quick and easy to set up, and
| think they provide the perfect compromise between access and security. You'll
find that standard access allows your users to do just about anything they need
to do, with a minimum of hassle.

“All right, Mark,” you're saying by now, “enough pregame jabbering —
show me how to set up new accounts!” Your Mac already has one
admin-level account set up for you (created during the initial Lion
setup process), and you need to be logged in with that account to

add a user. To add a new account, follow these steps:

=73 1. Click the System Preferences icon (which sports a num-
E* e . / . .
ees  ber of gears) in the Dock — that's the strip of icons at the
bottom of your screen. From within the System
Preferences window, click the Users & Groups icon to

display the Users & Groups pane (refer to Figure 2-2).
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2. Click the New User button — the one with the plus sign
at the bottom of the accounts list — to display the New
Account sheet shown in Figure 2-4.

Users & Groups

New Account: | Standard

Fa | Full Name:
m Benjami Account name
Standard

LY ressword ‘¢ <€ Click this icon for
Verlty pange... password suggestions.

Password hint
{Recommended)

?) Cancel | | Create User |

@ Login Optians
+ | — | @~

Enable parental controls | Open Parental Controls...

l
Ji{ Click the lock to prevent further changes. (7)

Figure 2-4

Groups pane is locked. You can toggle the padlock
icon in the lower-left corner of most of the panes in
System Preferences to lock (prevent) or unlock
(allow) changes to be made to the settings.

@ If the New User button is grayed out, the Users &

To gain access, do the following:
a. Click the padlock icon to make changes.

b. If Lion prompts you for your admin account password (the
account you're using), enter it. (This password is the one
you entered during Setup, when you created your per-
sonal user account.)

c. Click OK. You see a snappy animation as the padlock
opens, and now you can click the New User button.

40
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3. Click the New Account pop-up menu and specify the
account-level status.

e Choose Standard (unless the user should be
assigned an Administrator or Managed with
Parental Controls account).

¢ You should have only one or two administrator-
level users, and your account is already an admin
account.

4. Type the name that you want to display for this account
in the Name text box. Press Tab to move to the next field.

behave! (For example, Bob had only one letter o, the

@ Lion displays this name on the login screen, so
last time I checked.)

5. (Optional) Although Lion automatically generates the
user’s short name, for use in programs and for naming the
user’s Home folder, you can type a new one. (No spaces,
please, and it’s a good idea to use all lowercase letters for
the short name.) Press Tab again.

6. In the Password text box, type the password for the new
account. Press Tab to move to the next field.

I generally recommend a password of at least six charac-
ters, using a mixture of letters and numbers.

the key button (to the right of the Password text box)
to display the Password Assistant, from which Lion
can automatically generate password suggestions of
the length you specify. Click the Suggestion pop-up
menu or type directly into the field, and Lion auto-
matically adds into the Password field the password
you generated.

@ If you run out of password ideas, no problem! Click

www.it-ebooks.info

41


http://www.it-ebooks.info/

Part I: Buying and Setting Up Your Mac

7. In the Verify text box, retype the password you chose.
Press Tab again to continue your quest.

8. (Optional) Lion can provide a password hint after three
unsuccessful login attempts. To offer a hint, type a short
question in the Password Hint text box.

word hints are taboo. (I never use them. If someone
is having a problem logging in to a computer I
administer, you had better believe that I want to
know why.) If you do offer a hint, keep it vague. Avoid
such hints as “Your password is the name of the
Wookie in Star Wars.” Geez. Instead, use something
personal, such as “My first pet’s name.”

@ Keep in mind that from a security standpoint, pass-

9. Click the Create User button.

The new account shows up in the list to the left of the
Accounts pane.

Switch between Accounts

After you create more than one account, your significant other has to
reach his or her stuff, too. You can switch accounts in two ways:

w= Reboot or log off. Click the familiar Apple symbol
(#) on the menu bar at the top of the Desktop —
it's in the upper-left corner. On the menu that
appears, you can choose to restart your Mac (which
shuts down your computer and reboots it) or log out
(which presents the other person with the Lion login
screen). From the login screen, a new person can
enter his username and password.

42
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w= [Ise Fast User Switching. This feature allows another
user to sit down and log in while the previous user’s
applications are still running in the background. This
strategy is perfect for a fast e-mail check or for skim-
ming your eBay bids without forcing someone else
completely off the Mac. When you turn on Fast User
Switching, Lion displays the active user's name on
the right side of the Finder menu bar.

To use Fast User Switching, you must turn it on from the System
Preferences window. Follow these steps:

1. Click the System Preferences icon in the Dock (it sports a

number of gears) and then click the now-incredibly-
familiar Users & Groups icon to display the Users &
Groups pane (refer to Figure 2-2).

2. Click the Login Options button.

If the pane is locked, don't forget to click the padlock
icon and type your account password to unlock it.

3. Select the Show Fast User Switching Menu check box to

enable it, and then choose how the current user should
be displayed in the menu bar by clicking the pop-up
menu. You can select the user’s full name, short name, or
account icon — the default, full name, is a good choice.

4. Click the red button in the upper-left corner of the

System Preferences window to close System Preferences
and save your changes.

After Fast User Switching is turned on, follow these steps to use it:

1. Click the current user’s name in the upper-right corner of

the Desktop menu, as shown in Figure 2-5.
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CRARS 9 2 ® O« e <€ Click your username to

i achine : - | switch to a different user.

he Day =

| & Mark Chambers !
Time Artist Albun ist Playe|
0:08 I McKay Login Window. )i4f

(z/ Continuous Lzy
Users & Groups Preferences..

Figure 2-5

2. Click the name of the user who wants to log in.

Lion displays the login window, just as though the com-
puter had been rebooted.

Because the previous user’s stuff is still running, you
definitely should not reboot or shut down the
computer!

After the password is entered, you'll see the entire screen
rotate, and the second user’s Desktop appears. Spiffy! If
you click the username in the menu again, you'll see that
each logged-in user has an orange check mark.

3. To switch back to the previous user, do the following:
a. Click the username again on the Finder menu.
b. Click the previous user’s name.

For security, Lion prompts you for that account’s login
password.

If either user is completely finished with the Mac, that user can simply
click the Apple menu and choose Log Out, and the other user can log
back in and return to the tasks at hand.

44
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Set Vour Mac’s Date and Time

Nothing's more irritating than a blinking 12:00 on a VCR or DVD
player, and the same is true on your Mac. Personally, if I don’t have
the correct time, I get downright ornery. Luckily, Lion makes it easy to
set your clock — in fact, if you have broadband Internet service, you
can let your Mac set the time automatically!

Follow these steps to set your Mac’s date and time:

1. Click the clock display in the menu bar at the top of your
Desktop. From the menu that appears, click Open Date &
Time Preferences to display the Date & Time pane.

2. Click the Date & Time tab at the top of the window to
display the settings you see in Figure 2-6.

860 Date & Time
| > || ShowAll | Q

= | Time Zone | Clock |

Set date and time automatically: Apple Americas/U.5. (time.apple.com)

11/17/2011 |5

— Type the current time.

November 2011
SMTWTFS
12 3 45
6 7 8 9101112
13 14 15 16 18 19

20 21 22 23 2§ 25 26
27 28 29 30

To set date and time formats, Jse Language & Text preferences. | Open Language & Text...

il
'] QH\ Click the lock to prevent further ghanges. (7)

Click today’s date to set the system date.
Figure 2-6
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3. Click today’s date within the minicalendar to set the sys-
tem date.

4. Click in the field above the clock and type the current
time to set the system time.

5. Click the red button in the upper-left corner of the
System Preferences window to close System Preferences
and save your changes.

and then click your approximate location on the
world map to choose a time zone. You can also click
the Closest City pop-up menu and choose the city
that's closest to you (and shares your same time
zone).

@ To set your Mac’s time zone, click the Time Zone tab

And as long as you have cable or DSL Internet access, the Mac can use
an Internet time server to synchronize the time and date. Follow these

steps:

1. Click the clock display in the menu bar at the top of your
Desktop, and then click Open Date & Time Preferences
from the menu that appears.

2. Click the Set Date & Time Automatically check box to
enable it, and then choose from the pop-up menu a
server that corresponds to your location.

the time in text or icon format by selecting the Show
the Date and Time in Menu Bar check box. You can
also optionally display seconds, AM/PM, and the day
of the week; have the time separator characters flash;
or use a clock based on 24 hours.

@ Click the Clock button, and you can choose to view
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3. Click the red button in the upper-left corner of the
System Preferences window to close System Preferences
and save your changes.

Bam! Now your Mac updates the system time automatically — you're
the technosavvy Mac owner! (You no longer even have to keep track
of daylight saving time.)

Turn Off Vour Mac

First things first. As the guy on the rocket sled probably yelled, “This is
neat, but how do you stop it?” The Big Three — Sleep, Restart, and
Shut Down — are the Mac OS X commands that you use when you
need to take care of other business. All three appear on the friendly
Apple menu () in the upper-left corner of your Desktop.

Each option produces a different reaction from your Mac:

w= Sleep: You don’t need a glass of water or a bedtime
story when you put Mac OS X to Sleep, which is a
power-saving mode that lets you quickly return to
your work later. (“Waking up” from Sleep mode is
much faster than booting or restarting your com-
puter, and it can conserve battery power on laptops.)
To awaken your slumbering supercomputer, just
click the mouse or press any key on the keyboard.
MacBook owners can typically put their laptops to
sleep by simply closing the computer, and wake the
beast by opening it again.

w= Restart: Use Restart if your Mac suddenly decides to
start thinking “outside the box” and begins acting
strangely — for instance, if your USB ports suddenly
lock up or your FireWire drive no longer responds.
Naturally, you need to save any work that’s open.
(Some applications and Apple software updates also
require a restart after you install them.)
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w= Shut Down: When you're ready to return to the

humdrum real world and you're done with your Mac
for now, use the Shut Down option. Well-behaved
Mac applications automatically prompt you to save
any changes you made to open documents before
the computer turns itself off (or restarts). If you con-
figured your Mac with multiple accounts, you can
shut down Mac OS X from the login screen as well.

48
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Getting Started
with Your Mac

The 5th Wave By Rich Tennant

AFTER SETTING UP THE COMPUTER.,
NED AND LORETTA SELECT THE

“Oh -1 like this background much better than
the basement.”
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Getting Around
the Mac Desktop

ou use the Desktop and the Finder (two

Lion screen elements) to take care of most
of the chores that every Mac owner performs
repeatedly. In this chapter, you learn basic Lion
spell-casting, using the Desktop and Finder
windows.

I also introduce you to the Dashboard within
Lion, where you can use all sorts of widgets —
mini-applications — to take care of common
tasks (like displaying dictionary definitions
and today’s local weather).

To do stuff with your Mac, you move among
the Desktop, the Finder, programs, and win-
dows. As you read this chapter, don’t worry if
you feel like there’s a piece you're not quite
“getting.” If you hang in there until the end,
you'll be able to

w= Open and close windows.
w= Find important features.

w= NMove around the interface with ease.
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Tour the Desktop

52

Your Mac Desktop is comparable to your physical desk: It holds the
most important elements in a convenient view, ready when you need
them. The Desktop includes the following elements (most of which
are shown in Figure 3-1):

m= The Finder menu bar: From here, you can give com-
mands to the Finder. (You give the Finder lots of
commands as you use your Mac.) I talk about the
Finder in the next section.

w= The Apple menu: Click the Apple icon at the left
side of the Finder menu bar, and you'll find a num-
ber of menu commands that affect the entire system.
Here’s where you can access the documents and
applications you've recently used, restart or shut
down your Mac, and display information about
your computer.

w= The Dock: The Dock keeps at the ready the icons
you use most often. You use these icons to launch
programs or open files, as I explain in the section,
“Open and Switch Programs from the Dock,” later in
this chapter. When you first begin using your Mac,
the icons you see are defaults, which Apple has pre-
set for you. As you use your Mac more and more,
though, you may decide to customize the Dock with
the icons that you use most often.

w= The icon representing your hard drive: All Macs
have at least one internal drive, which is the storage
device for all the data you want to save permanently.
You can always double-click the drive icon to open a
Finder window and display your files and folders.

w= Jcons for files and folders you decide to park on
the Desktop: A new Desktop is similar to a new
desk: It starts off pretty clean. You can keep files on
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your Desktop in the same way you can pile papers
on your desk. You're generally better off, though,
organizing files into folders so that you can find
them easily. In fact, Lion is already equipped with
default folders for stuff like photos and music. You
find out more about working with files and folders
in Chapter 5.

Apple menu Finder menu Hard drive icon
_£] Finder File Edit View Go Window Help $ O & B 7 4 Mon2:46 AM Mark Chan*rs Q
g e
?bfc::vl Th\lj I\(-;af 800 @} mark .
0 are Update.. B p— —— e & B
App Store... PR = | m ||~ w8 © ||| (8] » r—
" Wolfgang
System Preferences... il ETORTIGERIonIGEL ey
Dock > % Dropbox
] Recent Items » : AlliMy Files | ;-T E
|| Desktop = . ]
Force Quit- R & ok p—
7 Appliations sty s S s
Restart... 1 Documents
Shut Down.. 52 utilities - -
Log Out Mark Chambers... 3%Q [ Cames - Hoak
SHARED ‘% E_H

[ blackdragon =

i Library Movies
=) acerserver

DEVICES
= Ludwig .
.. Antoni @) &N
& Time Mach... =
|- Johann
| Windows XP | Wolfgang » (1] Users » % fiark

K PBOBOOTT S AESW B
L . 2 =
| |

Finder Dock icon The Dock  Finder window
Figure 3-1

w= Any open Finder and program windows: Windows
are containers in which you interact with a program
or a tool. Right now, you just need to know that
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windows appear on your Desktop. The next section
explains how to open a Finder window, and later
sections in this chapter explain how to run programs
to open their windows as well as how to work with
those windows.

Discover the Finder

When you need to see the contents of your hard drive or copy items
from one location to another, you open a Finder window. In other
words, the Finder is the starting point for many of the tasks you per-
form with your Mac. Here are ways to open a Finder window:

w= The easiest way is to double-click the Mac’s hard
drive icon on the Desktop. Refer to Figure 3-1.

w= Alternatively, click the Finder icon on the Dock.
Figure 3-1 illustrates the Dock with the rather per-
spective-crazy Finder icon on the far-left side. Is that
icon supposed to be one face or two faces? I'm still
confused, and I've been using the Mac since 1989.

is always available — and you can always switch to it,
even when several other applications are open and
chugging away. If you ever need to return to the
Finder, just click outside any window border (on any
empty portion of the Desktop).

@ The Finder is always running, so the Finder menu bar

Use the Lion Icons

54

Icons are more than little pictures. And because these graphical sym-
bols truly are representations of the components of your Mac OS X
system, they deserve a section of their own. In fact, you'll encounter
icons everywhere: on your Desktop (as you already know) as well as
on the Dock and in Finder windows. For example, Mac OS X uses
icons to represent the various hardware devices on your computer,
including your
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wep  Hard drive
w= CDs or DVDs (if one is loaded)

w=  iPod

You get the idea. Just double-click a hardware icon to display the fold-
ers and files it contains, as you do with your hard drive and CD/DVD
drive.

sents, and what it does, click the icon once to highlight
it and then press 88+I. This key combination opens the
Info dialog, shown in Figure 3-2, which tells you which
kind of icon it is, where the item it represents is located,
and how big the file is (if applicable). You also see a
version number for applications — a handy way of
quickly determining which version of a program you're
running — and when the file was created and last
modified.

@ For complete details on what any icon is, what it repre-

8 00 -} TextEdit Info

/ TextEdit 8.3 MB
A Modified: Saturday, August 20, 2011 2:15 PM

¥ Spotlight Comments:

¥ Ceneral:

Kind: Application (Intel)
Size: 8,270,831 bytes (10 MB on disk)
Where: [Applications
Created: Saturday, August 20, 2011 2:15 PM
Maodified: Saturday, August 20, 2011 2:15 PM
Version: 1.7

Copyright: Copyright © 1995-2011 Apple Inc. Flnd detolls GbOUt an icon.

All rights reserved.

|_| Open in 32-bit mode
Locked

¥ More Info:

Last opened: Yesterday 8:19 PM

Figure 3-2

I cover file and folder icons later in this book in Chapter 5.
55
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Open and Switch Programs from the Dock

The Dock couldn’t be any easier to use — and I like easy. The follow-
ing steps walk you through basic Dock tasks and navigation. Hint:
You can have more than one program open at a time. Sweet.

1. Click a program icon on the Dock to run a program. The
program window opens. (Note that some programs you
run from the Dock don’t open a window, such as the
Dashboard. Almost all programs, however, display a
window.)

Several programs appear on the Dock by default,
such as Safari, the App Store, and iTunes.

2. Click a different icon on the Dock, and watch as another
window opens. This second window covers up the win-
dow you opened in Step 1 — but that’s okay.

3. Click the icon that you originally clicked in Step 1 to
move the first window to the front. (You can also click
any part of the window that’s peeking out — if it is —
but you won't always have that option.) Now you see the
window you opened in Step 1 again.

4. You can continue switching between windows, or even
add a third, until you get the hang of it or just get bored
watching the windows dance around on your screen.

most common functions you use on the Dock. Find
out how to customize the Dock with your favorite
programs, documents, and more in the section, “Add
Favorite Programs (And More) to the Dock.”

@ Running a program and loading a document are the

56
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Run Programs from the Hard Drive

r -
L 4&

You can start a program from the Dock, but that’s not always the best
way to start a program. This list describes a few more handy ways you
can launch a program from your hard drive:

2

®

2

[T 2

Use Launchpad. See the rocket ship icon on the
Dock, as shown in Figure 3-17? (It always reminds
me of the spaceships from the Flash Gordon movie
serials.) Click the rocket icon to display Lion’s
Launchpad, where all your program icons hang out.
If you've used an iPhone, iPod touch, or iPad in the
past, you'll recognize this scrolling display immedi-
ately. Just click once on a program icon to run that
program, and Launchpad disappears.

If your Launchpad stretches over multiple screens,
you can click anywhere on the Launchpad back-
ground and drag to the left or right to display addi-
tional icons.

Navigate to the corresponding program folder.
Although not as quick or elegant a solution, you can
always use the Finder window to locate and run a
program. Double-click the hard drive icon on your
Desktop (refer to Figure 3-1), and then double-
click the folder (and subfolders, if necessary) that
contain the program. After the program icon is dis-
played in the Finder window, double-click it to run
the program. For example, to run Chess — which
isn't on the Dock — you double-click the hard drive
icon on your Desktop and then double-click the
Applications folder to display the Chess icon. Now
you can double-click the Chess icon to play a game.

Double-click a document or data file that's
“owned” by the program. For example, double-click
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an MP3 audio file to open iTunes. You find out
more about working with files in Chapter 5.

Double-click an alias you created for the program.
An alias is nothing more than a handy shortcut to
something else, like a folder. For tips on using an
alias, see Chapter 5.

Add Favorite Programs (And More) to the Dock

In terms of importance, the Dock ranks right up there with the com-
mand center of a modern nuclear submarine. For that reason, it had
better be easy to customize, and naturally, Mac OS X doesn't let you
down. The Dock is a convenient way to keep handy the stuff you use
most often: the programs you run the most, and even folders and web-
sites that you open many times every day.

58

You might be satisfied with just the icons that Apple places in the
Dock. Or, you can easily customize the Dock by adding your own
applications, files, and folders there:

m= Add any program to the Dock. Add a program to

the Dock when you need to run it often, and you'd
rather not have to locate it in Launchpad every time!
To find the icon for a program that isn’t already on
the Dock, use the Finder to locate the program (as I
describe in the previous section). Then click and drag
its icon into the area to the left side of the Dock
(that’s the side to the left of the dotted line that
appears on the Dock). You know when you're in the
proper territory because the existing Dock icons
obligingly move aside to make a space for it.

Don't release the mouse on the right side of the
Dock. Attempting to place an application on the
right side of the Dock sends it to the Trash (if the
Trash icon is highlighted when you release the but-
ton). If you make this mistake, see Chapter 5 for tips
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on retrieving your application. You don’t want to
empty the trash in this case, but you do find the steps
you need in that section.

Add a file to the Dock. When you're continually
opening a particular file to make additions or changes
(such as on your budget spreadsheet), it's handy to
have that file on the Dock. You can add individual file
icons to the Dock by dragging the icon into the area
to the right side of the Dock. (Attempting to place
them to the left side of the Dock opens an application
with the contents, which usually doesn’t work.) Again,
the existing Dock icons move aside to create a space
when you're in the right area.

Chapter 5 explains how to work with files and fold-
ers, including how to find a file’s icon so that you
can add it to the Dock. For now, just know that you
have the ability to do so.

Add several files or a folder to the Dock. Lion uses
the Stacks feature, which I discuss in the next section,
which allows you to add multiple files (or the con-
tents of an entire folder) to the Dock.

Add a website link. You can drag any website page
address (commonly called a URL, or Universal
Resource Locator) from Safari (your web browser)
directly into the area to the right of the Dock. Then,
clicking that icon automatically opens your browser
and displays that page.

Remove an icon from the Dock. If you add enough
icons to the Dock, the icons get downright tiny and
hard to see. To prevent this, it's a good idea to
remove icons that you don't need and keep your
Dock svelte (so that you can add more items later).
Close the program that uses the item (if necessary)
and then click and drag the icon off the Dock. You
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see a rather silly (but somehow strangely satisfying)
animated cloud of debris, and the icon is no more.
Note, however, that the original application, folder,
or volume is not deleted — just the Dock icon itself
is permanently excused. You can drag icons to rear-
range them, too.

Stack Files or Folders on the Dock

60

Stacks are groups of items (documents, applications, or folders) that
you want to place on the Dock for convenience — perhaps the files
needed for a project you're working on or your favorite game applica-
tions. For example, I have on my Dock a stack that holds all the proj-
ect files I need for the book I'm now writing. A stack can be
temporary, and you can remove it from the Dock like any other icon
(as I demonstrate in the preceding section), or it can be a permanent
addition to the Dock.

w= To create a stack: Just select and drag to the right
side of the Dock the group of items you want to
include. As always, the Dock opens a spot on the
right side of the Dock to indicate that you're in
the zone.

w= To display the items in a stack: Click it:

e [f the stack holds relatively few items, they're
displayed in a cool-looking arc (as shown in
Figure 3-3), and you can click the item you want
to open or launch.

e [f the stack is stuffed full of many items, the stack
opens in a grid display, allowing you to scroll
through the contents to find what you need.

w= To remove a stack from the Dock: Right-click the
Stack icon and then choose Remove from Dock from
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the menu that appears. Alternatively, just drag that
sucker right off the Dock.

()
E
i

E

EPBOSOOTY HHESHW  @O|

ltems in a stack

Figure 3-3

Downloads folder, situated next to the Trash, is the
default location for any new files you download from
the Internet by using Safari or receive in your e-mail.
Lion bounces the Downloads Stack icon to indicate
that you received a new item. Chapter 14 introduces
you to web browsing with Safari, and Chapter 15
walks you through downloading files from an e-mail.
The second stack is the Documents folder, the location
where most Lion applications (like Pages, TextEdit,
and Preview) save the documents you create.

@ Apple provides two stacks already set up for you. The

Change the Dock Size and Location

You can change the size of the Dock directly from the Desktop!
Increasing its size can make it easier to see, and decreasing its size can
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make room for viewing other items onscreen. Follow these steps to
change the size of the Dock:

1. Move the cursor over the top edge of the Dock’s reflective
base, and the cursor turns into a funky line with arrows
pointing up and down.

2. The altered cursor is your cue to click and drag up or
down, which expands and shrinks the Dock, respectively.

hover the pointer over it. The magnification feature
can also make the Dock icons easier to see, or if you
don't like it, you can turn off magnification. When
magnification is turned on, the icons in the Dock
grow really big. Check out the somewhat oversized
icons in Figure 3-4.

@ Notice how a Dock icon grows larger whenever you

System Preferences

-

Magnification changes the icon size.
Figure 3-4

Follow these steps to change the magnification settings:

1. Click the Apple (%) menu in the upper-left corner of the
screen.

2. Choose Docke>Magnification from the submenu that
appears. Choose the Turn Magnification On/Off menu
item to toggle icon magnification.
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3. If you want to adjust the amount of magnification, you're
in luck. Click the Apple (%) menu and choose Dockrs
Dock Preferences to open the System Preferences win-
dow, and then drag the Magnification slider to the right
to increase the size of the magnified icons.

To adjust the Dock’s hiding feature or location, click the Apple ()
menu and choose the Dock item to display the submenu. Here's how
these options work:

w= Hiding: Choose the Turn Hiding On/Off menu item
to toggle the automatic hiding of the Dock. With
hiding on, the Dock disappears off the edge of the
screen until you move the pointer to that edge. (This
feature is helpful if you want to make use of as much
Desktop territory as possible for your applications.)

You can press 38+Option+D to toggle Dock hiding
on and off from the keyboard.

w= Position: Click one of three choices (Position on
Left, Bottom, or Right) to make the Dock appear on
the left, bottom, or right of the screen, respectively.

Empty the Trash

As you work with your Mac to create files and folders and perform
other tasks, it can become cluttered. Eventually, you want to delete
some items, as I explain in Chapter 5 (which focuses on working with
files and folders). From time to time, you may want to empty the
Trash (the electronic bin on the Dock where deleted items are depos-
ited) so that your deleted items aren’t occupying space that you can
use for other things. When you're compelled to take out your Mac’s
trash, follow these steps:

1. Click the Trash icon on the Dock to open the Trash.
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2. Double-check the Trash contents and make absolutely
sure that you want to delete its contents. You can retrieve
files from the Trash, as I explain in Chapter 5, but you
can’t retrieve those files after you empty it.

3. Click the Empty button at the top right of the Trash win-
dow (or you can choose the Empty Trash menu item
from the Finder menu). This is an all-or-nothing deci-
sion, so make sure first that you're ready to delete.

Secure Empty Trash. Lion securely erases the contents
of the Trash so that even a dedicated Mac technician
couldn’t recover anything!

@ For an extra level of security, you can choose Finder=>

Display the Dashboard and Widgets

One of Lion’s most popular features is the Dashboard, which you can
use to hold widgets and display them with the press of a button.
(Okay, I know that sounds a little wacky, but bear with me.) Widgets
are small applications — dubbed “applets” — that typically provide
only one function. For example, the Dashboard comes complete with
a calculator, clock, weather display, and quick-and-simple calendar
widgets. Figure 3-5 illustrates the Dashboard in action.

Click the Dashboard icon on the Dock to display your
widgets, ready for you to use.

2. To add a widget to your Dashboard, click the Add button
(which bears a plus sign, naturally) in the lower-left cor-
ner of the Dashboard screen.

3. When a scrolling menu strip appears at the bottom of the
Dashboard display, browse your options. You can drag
new widgets directly to your Dashboard from this menu.
(For more information on downloading widgets, check
out Chapter 12. You'll find a huge number of widgets to
download on the Apple website.)
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4. To rearrange the widgets that are already populating the
Dashboard, click and drag them to the spot you want.

5. When you're done with your widgets, press Esc or click
the arrow at the lower right to return to the Lion
Desktop.

Calculator is one widget on the Dashboard.

Q widget

widgeet | wijit
noun informeal
[y @ small gadget or mechanical device, esp. one
whose name is unknown or unspecified
* Computing an application, or a component of
Monday 4 January2012  » :00 an interface, that enables a user 1o perform a
T >aymen function or access a service.

1.2 3 4 5 867
o 8 910 11 12 13 14 ORIGIN 1930s: perhaps an alferation of GADGET.
15 16 17 18 19 20 21

22 23 24 25 26 27 28
29 30 31

-k © </»| 4 20123anuary 174/ @ Dilbert =
HERE'S A BILLION i Ask THE
DOLLARS TO SETTLE e il TNy
YOUR CLATM OF WHERE WE HOLD OUR ||  FLYING
DISCRIMINATION SECRET MEETINGS. |!| UNICORN
AGAINST SHORT, BALD, WITH THE
NEARSIGHTED GUYS. GOLDEN KEY. @l

Y

Dibercom  DibenCanGon@gman com

Copy Image URL to clipboard

@ O
Figure 3-5

Search Vour Mac with Spotlight

The Spotlight feature lets you search your computer as quickly as you
can type. You can use Spotlight to quickly search your Mac for docu-
ments, Address Book contacts, Mail messages, folders, and drives that
your Mac can access. (Spotlight isn't for searching the Internet, but I
cover that in Chapter 14.) To search for items with Spotlight, follow
these steps.
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1. Open a Finder window by clicking the Finder icon on the
Dock.

Figure 3-6 illustrates the Spotlight search field, which is
always available from the Finder menu bar.

® Finder File Edit View Go Window Help B <) (= Wed 1:48 AM
— A d

Search for a term.

Figure 3-6

2. Click the magnifying glass icon once, and the Spotlight
search box appears.

3. Simply click in the Spotlight text box and begin typing.
Matching items appear on the Spotlight menu as soon as
you type, and the search results are continually refined
while you type the rest of your search terms. Check out
my tips and shortcuts for typing search terms a little later
in this section. You can see a preview of the contents of
any item by hovering your pointer over that item in the
Spotlight menu.

egories directly on the Spotlight menu, including
Messages, Definition, Documents, Folders, Images,
and Contacts. Spotlight takes a guess at the item
that's most likely the match you're looking for and
presents it in the special Top Hit category, which
always appears first.

@ The top 20 most-relevant items are grouped into cat-

4. If you don't find what you're looking for in the search
results, try again. To reset the Spotlight search and try
typing different text, click the X icon that appears on the
right side of the Spotlight box. (Of course, you can also
press Backspace to reach the beginning of the text box,
but that method is a little less elegant.)
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5. To open the Top Hit item like a true Lion power user,
just press Return. (Folks, it just doesn’t get any easier
than that.)

6. To open any other item, you can click it once to
e Run it if the item is a program.

e Open it in System Preferences if it's a setting or
description in a Preferences pane.

e Open it within the associated program if the item is a
document or a data item.

e Display it within a Finder window if the item is a
folder.

Literally any text string is acceptable as a Spotlight search. However,
here’s a short list of the common search tips I use every day:

w= To find contact information: Enter any part of the
names or address. Because Spotlight has access to the
Lion Address Book, you can immediately display
contact information by using any portion of a name
or address.

w= To find an e-mail message: Type the sender’s
address or any unique word or phrase you remember
from the message. If you need to open a specific
e-mail message, but you'd rather not launch Mail
and spend time digging through the message list,
enter the person’s e-mail address or any text string
contained in the message you're looking for.

w= To display a file or folder name in the results list:
Type it. This is the classic search favorite. Spotlight
searches your entire system for that file or folder in
the blink of an eye.
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w= To find out how to adjust System Preferences: Type
a keyword for the item you want to adjust. Now
things start to get really interesting! For example, type
the word background in the Spotlight field. Some of
the results are System Preference panes! That's right —
every setting in System Preferences is referenced in
Spotlight. (For example, the Software Update pane
contains the word background, and the Desktop back-
ground setting is in the Desktop & Screen Saver pane
in System Preferences.)

w= To search web pages: Whoa. Stand back, Google.
You can now use Spotlight to search the web pages
you recently displayed in Safari! (Note, however,
that this new feature doesn’t let you search the entire
Internet, like Google does — only the pages stored
in your Safari web cache.)

the files of a particular type on your system by using the
file type as the keyword. For example, to provide a list
of all images on your system, just use images as your
keyword — the same goes for movies and audio, too.

@ Here’s another favorite timesaver: You can display all

View the Finder in Icon View

The default appearance of a Finder window in Mac OS X uses the
familiar large-format icons that have been a hallmark of the Macintosh
operating system since Day One. This view, Icon view, is shown in
Figure 3-7. You can display the contents of a Finder window in Icon
view by clicking the Icon View button on the Finder window toolbar.
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Icon view is the default.
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Figure 3-7

Using Icon view has a number of advantages:

m= Jtems are larger in Icon view. Items are easier to
recognize in this view than in List or Column view.

w= Dragging-and-dropping can be easier. Copying and
moving items from one window to another is often
more convenient when using larger icons.

w= Selecting multiple items can be easier. Because of
the size of the icons, you might find it easier to select
more than one item in a Finder window while in
Icon view.
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@ You don't have to use Icon view. (In fact, most Mac

OS X power users whom I know consider Icon view
rather inefficient and slow.) The next few sections in
this chapter cover other ways to view items in the
Finder. In addition to Icon view, as shown in Figure
3-7, Mac OS X offers three other window view
modes: List, Column, and Flow.

List Finder Items in List Uiew

4.

70

List view displays the folders in a hierarchical fashion, with each sub-
folder appearing indented underneath its parent folder. You can
change to this view by clicking the List icon in the Finder toolbar.
To display the contents of a folder, follow these steps:

Click to select a drive from the Devices list.

Click the small, right-facing triangle next to the folder
name. The triangle rotates downward to indicate that you
expanded the folder.

Alternatively, double-click the folder icon to display the
contents in the Finder window.

If you need to display the contents of a subfolder (a folder
stored inside the original folder), click the triangle next
to the subfolder name to expand it and display the sub-
folder’s contents.

To collapse the contents of the folder, click the small tri-
angle again; it rotates to face the right.

Figure 3-8 illustrates the same Finder window in List view.
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List View button List view displays views hierarchically.
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Figure 3-8

See Jtems in

Column Uiew

This view is my favorite — thanks, Apple! It’s efficient and fast as all
get-out. Figure 3-9 shows the same window in Column view, in which
the drives on your Mac OS X system are displayed on the left. Each
column on the right represents a lower level of subfolders. You switch
a Finder window to Column view by clicking the Column View button
on the Finder window toolbar.

To navigate in Column view, follow these steps:
Click the drive in the Devices list.

Click to select a folder in the first column on the right to
display its contents. To display a subfolder’s contents,
click the subfolder’s icon. The contents appear in the next
column to the right. When you “drill down” deeper, the
columns shift automatically to the left.
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Column View button ~ Column view displays folders and subfolders.
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Figure 3-9

3. When you click to select a file or program (rather than a
folder), the Finder displays a preview and a quick sum-
mary of the selected item in the right-most column.

Each column has its own, individual scroll bar (for
those really big folders), and you can drag the col-
umn handle at the bottom of the separators to resize
the column width to the left. When you hold down
the Option key and drag a column handle, all col-
umns are adjusted at one time.

Surf Items in Flow View

In Flow view, shown in Figure 3-10, each document or item is show-
cased in a preview pane (and with an accurate thumbnail, if possible).
You can display a Finder window in Flow view by clicking the Flow
View button on the Finder window toolbar.
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Flow view displays each
file in a preview pane.
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Figure 3-10

Here are some other tricks to using Flow view:

w= Resize the preview pane. Say you need more room
in the file list. You can resize the preview pane by

2

[T 2

dragging the three-line handle on the bottom edge of

the pane.

Expand and collapse. You can expand and collapse
the folders in Flow view just like in List view, using

the rotating triangles.

Scroll the preview pane. You can click the scroll
buttons or drag the scroll bar under the preview
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pane to move through the contents of your drive in
quite a classy visual display.

Open Windows

If you're following along in this chapter, you now know a few ways to
open windows. But this section is focused only on window-opening. If
you want something to open but aren’t sure how to make it so, these
pointers can help:

w= Windows are generally opened automatically.
Usually, a window is opened by an application
(when you first run it or it needs to display a docu-
ment) or by Mac OS X itself (when the Finder opens
a window to display the contents of your hard
drive). I explain how to run a program earlier in this
chapter. I explain how to open a file, and thus the
file’s associated program, in Chapter 5.

w= Some programs even let you open new windows
on the fly. For example, Figure 3-11 illustrates a
window in its purest form: a new Finder window. To
display this window on your own Mac, choose Filew>
New Finder Window or press 38+N. From there, you
can reach any file on your Mac or even venture to
the Internet.

The Command key has on it both an apple (#) and
a rather strange-looking symbol (88) that I often call
the “spirograph.”
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Figure 3-11

Use Mission Control to Switch Windows

One of the neatest Lion features, aptly named Mission Control, is
shown in Figure 3-12. If you have a number of windows open,
Mission Control is a helpful way to find the one you want. Here's
how the feature works:

w= Press F9 (or F3, depending on your keyboard) to
show all open windows using Mission Control,
grouped by application; then click the one you
want.

through F12). These keys are generally used to per-
form specific actions within Lion and many applica-
tions. The function keys appear at the top of the
keyboard.

@ Your Mac keyboard includes function keys (marked F1
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Figure 3-12
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Figure 3-12 illustrates the tiled All Window display
on my Mac after I press F9. Move the cursor on top
of the window you want to activate — the window
turns blue when it's selected — and then click once
to switch to that window. You can specify which
keys you want to use within the Mission Control
pane in System Preferences.

Press F10 (or Control+F3, depending on your key-
board) to show all open, visible windows from the
application that you're currently using; then click
the one that you want to activate. This Mission
Control function is great for choosing from all the
images that you've opened in Photoshop or all the
Safari web pages littering your Desktop!
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An astute observer would notice, in addition to the
window switch, that the application menu bar
changes to match the now-active application.

w= Press 38+F3 (or F11 on older keyboards), and all
open windows scurry to the side of the screen
(much like a herd of zebras if you drop a lioness in
their midst). Now you can work with drives, files,
and aliases on the Desktop — and when you're ready
to confront those dozen application windows again,
just press the keyboard shortcut a second time.

Scroll Windows

Often, more stuff is in a document or more files are on your hard
drive than you can see in the space available for a window. I guess that
means it's time to delete stuff. No, no — just joking! You don’t have to
take such drastic measures to see more information in a window.

Just use the scroll bars that you see in Figure 3-13 to move through
the contents of the window. By default, Lion displays scroll bars only
if they're required. You move your pointer to the side or bottom of the
window, but you can control when scroll bars appear in the General
pane within System Preferences.

You can generally scroll in one of two ways:

w= Click the scroll bar and drag it. For the uninitiated,
that means clicking the bar and holding down the
mouse button while you move the mouse in the
direction you want.

w= Click in the empty area above or below the bar.
This maneuver scrolls pages one at a time.
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Figure 3-13

Depending on the type of application you're using,
you might be able to scroll a window with the arrow

|
1 of 160 sela*. 12.52 GB available

Scrol

| bars

keys on your keyboard as well — or perhaps press

the Page Up and Page Down keys to move in a win-

dow. Today’s Mac mice and trackpads also allow

scrolling by using gestures.
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Minimize and Restore Windows

The multitalented Figure 3-13, shown in the preceding section, dis-
plays another control that you can use with a window: the Minimize
button. When you minimize a window, you eliminate it from the
Desktop and store it safely on the Dock. After you minimize a win-
dow, you need to know how to restore it. Follow these steps to mini-
mize and restore a window:

1. To minimize a window, move the mouse pointer over
the yellow Minimize button in the upper-left corner of
the window (a minus sign appears on the button) and
then click. The minimized window appears as a minia-
ture icon on the Dock so that you can keep an eye on it,
so to speak.

2. When you're ready to restore the window (display it again
on the Desktop), simply click the thumbnail icon repre-
senting the window on the Dock, and Mac OS X
automagically returns it to its former size and location.

Zoom Windows

Zooming windows has kind of a Flash Gordon sound to it, don’t you
think? It’s nothing quite that exciting — no red tights or laser guns.
Still, when you're trying to view a larger portion of a document, zoom-
ing is a good thing because it expands the window to the maximum
practical size for the application you're using (and the content being
displayed). When you want to zoom, here’s what you need to know:

w= You can zoom with one click. To zoom a window,
move the mouse pointer over the green Zoom but-
ton in the upper-left corner of the window. Figure
3-13, shown earlier in this chapter, struts its stuff
(again) and illustrates the position. (That is one ver-
satile figure!) A plus sign appears on the Zoom but-
ton. Click to expand your horizons.

www.it-ebooks.info


http://www.it-ebooks.info/

Part lI: Getting Started with Your Mac

return it to its previous dimensions by clicking the
Zoom button again.

@ After you finish with a zoomed window, you can

w= Zooming produces mixed results. In some cases,
zooming a window fills the entire screen; at other
times, the extra space would be wasted, so the appli-
cation zooms the window to the maximum size that
shows as much content as possible (with no unnec-
essary white space).

w= You can’t zoom in on everything. The Zoom button
can even be disabled by an application that doesn’t
want you to muck about with the window; for
example, I own a game or two that doesn't allow
zooming.

Move and Resize Window's

Unlike the (rather) permanent windows in your home, you can pick a
window and cart it to another portion of the Desktop. Here are the
basics of moving windows:

=  Move windows when you want to see other stuff.
Typically, you move a window when you're using
more than one application at a time and you need to
see the contents of multiple windows.

w= Click and drag the window to move it. To grab a
window and make off with it, click the window's title
bar — the strip at the top of the window that usually
bears a document or application name — and drag
the window to the new location. Then release the
mouse button to plant it firmly in the new location.

80

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 3: Getting Around the Mac Desktop

w= Change the width or height of the window instead.
To change the dimensions of a window to your exact
specifications, move the pointer over any edge of the
window, click, and then drag until the window is the
size you prefer.

ple windows in a graceful swoop with a single click
on a menu. Click the Window menu and choose
Arrange All to perform this magic.

Close Windows

When you're finished with a document or you no longer need a win-
dow open, you can close it to free that space on the Desktop. As with
most tasks on the Mac, closing windows is simple:

@ By the way, some applications let you arrange multi-

m= Close a window with the Close button. Move the
mouse pointer over the Close button; it’s the red, cir-
cular button in the upper-left corner of the window
(refer to Figure 3-11). An X appears on the button
when you're in the zone. When the X appears, just
click the mouse. Most programs also have Close
commands on their File menus.

w= Save your information if you're asked to save
before closing. Most Mac applications don’t want
you closing a window willy-nilly if you change the
contents without saving them. For example, try to
close a document window in Microsoft Word or
Pages (in iWorks; see Chapter 8) without saving the
file first. The program asks for confirmation before it
closes the window containing your unsaved Great
American Novel. (Here’s another indicator: Some
programs display a black dot in the center of the
program’s Close button to indicate unsaved
changes.)
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s To close all windows displayed by a particular pro-

gram, hold down the Option key while you click the
Close button in one of the windows. Whoosh!
They're all gone.

Close Programs

If T had a twisted and warped sense of humor, I would tell you to close
applications by simply pulling the Mac power cord from the wall
socket. (Luckily, I don't.) You have, however, saner ways to close a
program — use one of these methods instead:

w= Press the 38+Q keyboard shortcut.

w= Choose the Application’s named menu and then
click Quit.

w= Right-click the application icon on the Dock and
choose Quit from the pop-up menu that appears.

You can also click the Close button in the application window. Note,
however, that this technique doesn’t always completely close the
application.

You might be able to close a program’s window with-

@ out closing the program itself. For example, you can
close a browser window in Safari, but the Safari pro-
gram continues to run. However, when you close a
program, you automatically close any windows that
the program opened.
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Customizing Lion

Lion is easy to customize in many ways: You
can adjust the appearance of the Desktop,
configure the behavior of your mouse (or
trackpad) and keyboard, and set up a screen
saver to keep your Mac happy while you're

away.

In this chapter, I show you how to

[T 2

2

2

[T 2

1

Select a background, an appearance, and
icon arrangement for the Desktop.

Tweak the behavior of your pointing
device and keyboard.

Enhance the readability of the Desktop.

Use the Lion visual cues rather than sys-
tem sounds.

Enable speech recognition.
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Fine-Tune Lion

Ep” i
AEF

Your Mac is truly easy to customize to your specific desires and needs.
Because each user on your Mac has individual Desktop settings, you
can quickly make changes to your Desktop configuration without upset-
ting the other members of the family (who may not want a hot pink
background with lime-green highlights).

Most changes you make to customize your Mac require you to open
the System Preferences window, which you can reach by clicking the
System Preferences icon on the Dock. (The icon bears a number of
gears for a label.)

Change the Desktop Background

84

I have yet to meet a computer owner who didn’t change the desktop
background when presented with the opportunity. Favorite back-
grounds usually include

w= Humorous cartoons and photos
w= Scenic beauty

w= Simple solid colors that help icons and windows
stand out

w= Photos of family and friends

If you decide to spruce up your background, you have three choices:
Select one of the default Mac OS X background images, choose a solid
color, or specify your own image. All three background types are avail-
able from the Desktop & Screen Saver pane, located within System
Preferences, as shown in Figure 4-1.
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The well
[-NsNa) Desktop & Screen Saver
| P> Show]All (Q
! Deskto Screen Saver |
f — |
Lion
)

¥ Apple sl

(] Desktop Pictures m

< Solid Colors m@m
¥ Folders e e S o

(&1 Pictures m‘f = 2 k|

[ wolfgang . e 2

— Select a
background image.
+ | - [-] Change picture: | Every 30 minutes
Random order
[EITransIucent menu bar 5
2.3
.
Figure 4-1

Mouse or trackpad yet — Apple calls it this a “sec-
ondary click” — I recommend doing so now. Open
System Preferences, click the Trackpad icon, and then
click the Point and Click tab. Select the Secondary
Click check box to enable it. Now you can right-click
by tapping the mouse or trackpad with two fingers.
For example, you can right-click any open spot on
the Desktop and choose Change Desktop
Background from the pop-up shortcut menu.

@ If you haven’t enabled right-clicking on your Magic

To choose a background from one of the collections provided by
Apple, click one of these groups from the list on the left:

w= Desktop Pictures: These backgrounds feature scenic
beauty, such as blades of grass, sand dunes, snowy
hills . . . that sort of thing. You also get close-up
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backgrounds of plant life — I especially recommend
the green grass — and a truly beautiful portrait of
a lion.

w= Solid Colors: This is for those who desire a soothing
solid shade.

w= iPhoto: Choose an image from your iPhoto Library.
(Note that the iPhoto group only appears if you've
installed the iPhoto application.)

w= Pictures: This displays the images saved in your
Pictures folder.

w= Choose Folder: You can open a folder containing
images and display them instead. (I discuss this in
more detail in a page or two.)

If you see something you like, click the thumbnail, and Mac OS X
automatically refreshes the background so that you can see what it
looks like. (There’s no OK, Accept, or Apply button to click.)

Mac OS X provides five orientations for your background image. First,
click the pop-up menu next to the “well”; refer to Figure 4-1. Then
you can choose to

w= Tile the background. The image is repeated to cover
the Desktop (usually done with pattern images to
produce a smooth look).

w= Fill the screen. The original aspect ratio of the image
is preserved, so it’s not stretched.

w= Fit to screen. Choose this option to resize the height
or width of the image to fit your screen, keeping the
original aspect ratio.

w= Stretch the background to fit the Desktop. If your
Desktop image is smaller than the Desktop acreage,
be forewarned — if you try to stretch too small of an
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image over too large of a Desktop, the pixilated
result can be frightening. (Think of enlarging an old
Kodak Instamatic negative to a 16 x 20 poster. Dots,
dots, dots.) Too, the original aspect ratio of the
image isn’t preserved, so you might end up with
stretched results that look like a funhouse mirror at a
carnival.

w= Center the image on the Desktop. This solution is
my favorite for Desktop images that are smaller than
the screen resolution.

This pop-up menu appears only if the Desktop picture you select isn’t

one of the standard Apple images. All pictures in the Desktop Pictures

and Solid Colors categories are scaled automatically to the size of your
screen.

To regularly change the Desktop background auto-
matically from the selected folder, select the Change

Picture check box and then choose the delay period
from the corresponding pop-up menu. (Refer to
Figure 4-1.) To display the images within the selected
folder in random order, also select the Random
Order check box; otherwise, Mac OS X displays the
images in the order that they appear in the folder.

As I mention earlier in this chapter, if you want your favorite color
without the distraction of an image, you can choose from a selection
of solid colors. You can choose from these colors the same way that
you pick a default Mac OS X background image (as I describe earlier in
this section).

Finally, you can drag your own image into the well from a Finder win-
dow to add your own work of art. To view the thumbnails from an
entire folder, click the Pictures folder (to display the contents of your
personal Pictures folder) or click the Add button (bearing the plus
sign) to specify any folder on your system. Click one of the thumb-
nails (the small images) to embellish the Desktop.
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You can also set a screen saver from this dialog. Flip ahead to the sec-
tion, “Select a Screen Saver,” for more information.

Change the Desktop Color Scheme

You can also select your own colors for buttons, menus, and windows
within Lion — and just like your background choice, the color scheme
you select is completely up to you. (Some color schemes supplied by
Apple may also help with any reduced vision you may have.) To
choose a scheme, follow these steps:

1. Open System Preferences and click the General icon to
display the settings shown in Figure 4-2.
Choose the main color for buttons and menus.

Choose the color that appears when
you select text or other items.

8 0 General
| «|» || Showall | Q
Appearance: | 7] Blue =
For the overall | of buttons, menus, and windows.
Highlight color: Blue H

For selected text

Show scroll bars: E.E_'Aulcmali(allv based on input device
(_)When scrolling
() Always
Click in the scroll bar to: (*)Jump to the next page
(_)Jump to the spot that's clicked
E‘]Use smooth scrolling
Double-click a window's title bar to minimize

Sidebar icon size: | Medium <

Number of recent items: | 10 + | Applications
10 + | Documents
10 + | Servers

E] Restore windows when quitting and re-opening apps

E] Use LCD font smoothing when available

Turn off text smoothing for font sizes | 4 + | and smaller (2)

Figure 4-2

88

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 4: Customizing Lion

2. Click the Appearance pop-up menu and choose the main
color choice for your buttons and menus.

3. Click the Highlight Color pop-up menu and pick the
highlight color that appears when you select text in an
application or select an item from a list.

4. Press 38+Q to close System Preferences and save your
changes.

Select a Screen Saver

Screen savers are another popular customizable display item. True,
today’s LED monitors don’t require animated graphics to avoid “burn-
in” like older CRT tube-based monitors did, but the moving colors
and images displayed by a screen saver can still provide security as
well as a bit of fun to your desktop. A screen saver runs after the speci-
fied amount of inactivity has passed.

To select a screen saver, open System Preferences and click the Desktop
& Screen Saver icon; then click the Screen Saver tab to display the set-
tings you see in Figure 4-3. Drag the Start Screen Saver slider to con-
trol the inactivity delay (or choose Never to disable the screen saver
feature entirely).

Click one of the entries in the Screen Savers column to display a
thumbnail showing the effect. Selecting the Use Random Screen Saver
check box, naturally, runs through them all. You can also test the
appearance of the saver module by clicking the Test button; the screen
saver runs until you move the mouse, move your finger across the
trackpad, or press a key.

Many screen savers let you monkey with their settings. If the Options
button is enabled (not grayed out), click it to see how you can change
the effects.
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8o Desktop & Screen Saver
| > || ShowAll | Q

i Desktop
Screen Savers Preview
¥ Apple
{_L Arabesque
{_L Computer Name
{_L Flurry
{_L iTunes Artwork

+ F) RSS Visualizer
= shell

{_L Spectrum

{_L Word of the Day
¥ Pictures

>4 Shuffle

+

Options Test

Use random screen saver
Show with clock Start screen saver:

3 5 15 30 1hr 2hr Newver

Hot Corners... (?)

Select a screen saver. Choose when your screen saver starts.
Figure 4-3

Corner sheet. From there, you can click any of the
four pop-up menus in the four corners of the screen
display to specify that corner as an activation hot cor-
ner (which immediately activates the screen saver) or
as a disabling hot corner (which prevents the screen
saver from being activated). As long as the mouse
pointer stays in the disabling hot corner, the screen
saver doesn't kick in no matter how long a period of
inactivity passes. Click OK to save your changes and
return to the System Preferences window.

@ Click the Hot Corners button to display the Hot

Customize the Keyboard

No, you can't rearrange that horrible QWERTY arrangement by pulling
off the keys — believe me, I've tried — but Lion lets you tweak the
behavior of your keyboard in a number of important ways.

9
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To customize your keyboard, click the System Preferences icon on the
Dock and then click the Keyboard icon. On the Keyboard pane, shown
in Figure 4-4, you can set these options:

w= Key Repeat: Move the Key Repeat slider to alter the
rate at which a keystroke repeats.

w= Delay Until Repeat: Move this slider to alter how
long a key must be held down before it repeats. For
those who take a little more time pressing each key,
moving this slider to the left helps reduce unwanted
repeats.

Alter the rate at which keys repeat.

Prevent unwanted repeats.

eon Keyboard
> || ShowAll | Q

SSGLEIGEY Keyboard Shortcuts |

Delay Until Repeat

= B

Key Repeat | ‘

Off Slow Fast Long Short

Show Keyboard & Character Viewers in menu bar | Input Sources...

Figure 4-4

Lion also provides the Sticky Keys and Slow Keys features, which can
help you if you have trouble pressing keyboard shortcuts, or you often
trigger keyboard repeats (repetition of the same character) accidentally.
To use these options, display the System Preferences window, click the
Universal Access icon, and then click the Keyboard button.

Sticky Keys work by allowing you to press the modifier keys in a key
sequence (like 8+A) one after another rather than all at the same
time. Slow Keys allows a pause between the moment a key is pressed
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and the moment that Lion acts on the keystroke. To turn on either fea-
ture (or both), just select the corresponding On radio button.

You can modify the way that Sticky Keys work:

w= Press the Shift Key Five Times: Select this check box,
and then you can toggle Sticky Keys on and off from
the keyboard by pressing the Shift key five times.

w=» Beep When a Modifier Key Is Set: Select this check
box to play a beep tone when Lion recognizes that
you've activated a modifier key.

w= Display Pressed Keys on Screen: Select this check
box, and Lion displays each key you press in a Sticky
Keys sequence to help you keep track of the charac-
ters you've entered.

You can modify the way that Slow Keys work by using these options:

w= Use Click Key Sounds: Select this check box to add
a key-click sound every time you press a key.

w= Acceptance Delay: Drag this slider to specify the
length of the delay before the key is accepted.

To turn off keyboard repeat entirely — which may be required,
depending on the settings you choose for Sticky Keys and Slow
Keys — click the Open Keyboard Preferences button, which displays
the Keyboard preference settings I discuss earlier in this chapter.

Organize Icons on the Desktop

92

You can set the options for your Desktop icons from the Finder's View
menu (click any open part of the Desktop and choose Viewr>Show View
Options) or by right-clicking any open part of the Desktop and choos-
ing Show View Options. (Heck, you can even press 3+].) Lion displays
the dialog that you see in Figure 4-5.
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lcon size: 48 x 458

A =() ~€—+—r— Change the size of your icons.

Crid spacing:

F O H

Textsize: [ 12 ¢ = Change the size of the icon labels.
Label position:

(*) Bottom () Right

E‘I Show item info
E‘I Show icon preview
Sort by: Mame

Figure 4-5
The changes you can make from this dialog include

w= Resize icons. Click and drag the Icon Size slider to
shrink or expand the icons on the Desktop. The icon
size is displayed in pixels, above the slider.

w= Specify grid spacing. Click and drag the Grid
Spacing slider to shrink or expand the size of the
grid used to align icons on the Desktop. The larger
the grid, the more space between icons.

w= Resize icon label text. Click the up and down
arrows to the right of the Text Size pop-up menu to
choose the font size (in points) for icon labels.

m= Move icon label text. Select either the Bottom
(default) or Right radio button to choose between
displaying the text under or to the right of your
Desktop icons.

w= Show item info. With the Show Item Info check box
selected, Mac OS X displays the number of items
within each folder on the Desktop as well as the size
and free space on your hard drives.
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w= Show icon preview. Select the Show Icon Preview
check box, and the Finder displays icons for image
files, using a miniature of the original picture. (It's a
cool feature for people with digital cameras, but it
takes extra processing time because Mac OS X has to
load each image file and shrink it to create the icon.)

w= Sort. From the Sort By pop-up menu, you can auto-
matically align icons to a grid on the Desktop. You
can also sort the display of icons in a window by
choosing one of the following criteria from its pop-
up menu: by name, date modified, date created, date
last opened, date added, size, or the kind of item.

After all your changes are made and you're ready to return to work,
click the Close button of the dialog to save your settings.

Customize Your Pointing Device

94

As with the keyboard, Mac owners are downright picky about how
their mice (or trackpads) work, and that includes folks who add third-
party pointing devices, such as trackballs. Once again, Lion doesn't let
you down, and you can customize your mouse to fit all your clicking
and double-clicking quirks — I mean, habits.

To get started, click the System Preferences icon on the Dock and then
click the Mouse icon. On the Mouse pane, shown in Figure 4-6, you
find these settings:

w= Tracking Speed: Drag this slider to determine how
fast the mouse tracks across the Desktop.

w= Double-Click Speed: Drag the Double-Click Speed
slider to determine how fast you must click your
mouse to cause a double-click.

w= Scrolling Speed: Drag this slider to specify the rate
at which the contents of windows will scroll.
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w= Primary Mouse Button: For those lefties who want
to change the primary mouse button, select the Right

radio button to switch to the

right button as your

Slow down or speed
up your double-click.

Change your primary
mouse button.

primary button.
w= Zoom Using Scroll Wheel: If your older mouse has
a scroll wheel or ball, you can zoom the display with
the scroll wheel or ball while holding down the key
you choose from the drop-down menu — a helpful
option for image editing.
80 Mouse
litulaballusbousig Q
QI Move content in the direction of finger movement when scrolling or navigating
Tracking Speed Double-Click Speed
Slow Fast Slow ' F a5 e
Scrolling Speed Primary mouse button:
—_— (@) Left
Slow Fast (_Right
™ Zoom using scroll wheel while holding |~ Control A Options...
Set Up Bluetooth Mouse... (?)
Figure 4-6

If you're using a MacBook laptop

— or a desktop Mac and a Magic

Trackpad — you'll find many of these same settings on the System
Preferences Trackpad pane. You can also choose which gestures your
Mac will recognize, such as tap-to-click, zooming, and swiping

between pages.

Set Vour Screen for Maximum

Visibility

Two features in Lion can help people with limited vision: First, you
can change the display resolution and brightness so that onscreen ele-
ments are easier to distinguish. Second, you can use the Universal
Access Display tools to enhance the clarity of your Desktop, Finder

windows, and program windows.
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Your monitor can display different resolutions, and the higher the res-
olution, the smaller that items appear onscreen. So, if you want items
on the Desktop to appear larger, you have to lower the screen resolu-
tion. You can also change the brightness level of your display to match
the ambient lighting in the room.

To change these settings, follow these steps:

1. Open System Preferences and click the Display icon to
display the settings, as shown in Figure 4-7.

8o iMac
| > || ShowAll | Q
Color |
Resolutions:
1680 x 1050 Brightness:
1344 x 840
1280 x 800
1024 x 768
1024 x 768 (stretched)
1024 x 640
800 x 600
800 x 600 (stretched)
@Shcw displays in menu bar Detect Displays ( ? )

If you have trouble seeing icons on the
Desktop, choose a lower screen resolution.

Figure 4-7

2. Click the resolution you want to use from the
Resolutions list on the left.

If you're having problems discerning items on the
Desktop, try a lower resolution.

3. (Optional) Select the Show Displays in Menu Bar check
box if you switch resolutions often.
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4. Press 8+Q to close System Preferences and save your
changes.

Use the Universal Access Tools

Lion offers a number of advanced features (grouped under the name
Universal Access) that can help with contrast and zooming for Mac
owners with limited vision.

To turn on Universal Access vision options, follow these steps:

1. Open System Preferences, click the Universal Access icon,
and then click the Seeing tab to display the Seeing set-
tings, as shown in Figure 4-8.

(- Ns] Universal Access

(][> ] [ showail | Q

When using this computer, | would like assistance with:

Hearing Keyboard Mouse |

VoiceOver: Turn VoiceOver on or off: 88F5
()On (s)Off Open VoiceOver Utility...
Zoom: Turn zoom on or off: X8
()on (=) Off Zoom in: X38=
1 Zoom out: 8-
Zoom in window Options...
Display: Switch to white on black: ~ 38
() Black on white Use grayscale
(") White on black
Enhance contrast: w;
Normal Maximum

Reduce contrast: “~™C3,
Increase contrast: ~\C&.

( ? ]
Enable access for assistive devices
Show Universal Access status in the menu bar
Turn on Zoom. Control how much magpnification is used.

Figure 4-8
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2.

To turn on Lion’s Zoom feature for your display —
which allows you to zoom in on a selected portion of
the screen — select the Zoom On radio button or press
38 +Option+8.

To specify how much magnification is used, click the
Options button. From the sheet that appears, you can set
the minimum and maximum Zoom magnification incre-
ments. From the keyboard, press 38+Option+= (equal
sign) to zoom in or press 8+Option+- (minus sign) to
zoom out. You can also display a preview rectangle of the
area that’s included when you zoom.

To have Mac OS X smooth images to make them look
better when zoomed, click the Options button in the
Zoom section of the pane and then select the Smooth
Images check box.

relation to the pointer from the Zoom Options sheet:

@ You can also determine how the screen moves in

4.

5.

By default, the zoomed screen moves with the
pointer, but you can set it to move only when the
pointer reaches the edge of the screen or maintain
the pointer near the center of the zoomed image
automatically.

(Optional) If you prefer white text on a black back-
ground, select the White on Black radio button (or press
the 88 +Option+Control+8 keyboard shortcut). Note that
depending on your display settings, it might be easier on
the eyes to use Grayscale Display mode by selecting the
Use Grayscale check box.

Press 38+Q to close System Preferences and save your
changes.
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Replace Sounds with Visual Cues

Lion can provide additional visual cues to supplement the spoken and
audio alerts used throughout your system.

Follow these steps to add visual cues:

1. Open System Preferences, click the Universal Access icon,
and then click the Hearing tab to display the options
shown in Figure 4-9.

800 Universal Access
(4> ][ showal | Q|

‘When using this computer, | would like assistance with:

| Seeing Hearing Keyboard Mouse |

>® Flash the screen when an alert sound occurs

Test the screen flash: Flash Screen
Play stereo audio as mono

To raise or lower the volume, use Sound preferences: | Adjust Volume -

IET Enable access for assistive devices

Show Universal Access status in the menu bar

Adjust the volume.

Make the screen flash when an audio alert sounds.
Figure 4-9

2. Select the Flash the Screen When an Alert Sound Occurs
check box. Click the Flash Screen button to test the
visual cues.
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3. To play stereo music as mono (with both channels com-

bined as one channel from both speakers), click the Play
Stereo Audio as Mono check box to select it.

the Adjust Volume button to display the Sound
System Preferences settings, where you can drag the
Volume slider to the right.

@ To raise the overall sound volume in Mac OS X, click

Set Up Speech Recognition

100

Since the early days of the Mac OS, Apple has included some form of
speech functionality in its computers. Lion continues to improve on
speech recognition by offering a host of tools that let you get more
work done in a shorter amount of time.

The speech recognition features of Mac OS X let you speak a word,
phrase, or sentence command. Then your Mac goes to work “translat-
ing” what you said. If it understands the command, it then performs
an action associated with that phrase. Cool! The great part about this
feature is that you can say any phrase in continuous speech and have
your Mac perform any sort of action that you can imagine, such as
closing a window or opening a document. In fact, you aren’t limited
to just one action: You can perform dozens of actions after speaking a
particular phrase, such as creating a new e-mail message and then
sending it.

You probably won't need to go buy any fancy extra equipment, either.
Most current Macintosh models have a built-in microphone; for exam-
ple, if you use an iMac, your microphone is built into the monitor,
and MacBooks have a similar microphone built into the screen. (Even
many Mac monitors include a camera and microphone.) If your Mac
doesn’t have a microphone, though, find yourself a simple one and
connect it to the computer by plugging it into the Line-In or
Microphone jack, which I discuss in Chapter 2.
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To get started with speech recognition in Mac OS X, open the System
Preferences window by clicking its icon on the Dock and clicking the
Speech icon. Then click the Speech Recognition tab to display the set-
tings you see in Figure 4-10.

800 Speech
[«]> ][ Showal | Q|

Text to Speech |

~peech kecognition

Speakable Items: (&) On () Off < TU rn on Speech
recognition.

Settings Commands |

Microphone: | Line In +|| calibrate... |

Listening Key: Esc | Change Key... |

Listening Method: (=) Listen only while key is pressed
() Listen continuously with keyword

Keyword is: | Required before each command

Keyword: Compute

Upon Recognition: |_| Speak command acknowledgement

Play this sound: | Whit & (7

4 Feedback window

The Speech Recognition tab consists of two subtabs:

Figure 4-10

w= Settings: The Settings tab provides a number of set-
tings that control how your Mac listens to Its
Master’s Voice. (That means you, friend reader.)
From there, you can set the sound input and adjust
the key on the keyboard that toggles Speech
Recognition on and off.

w= Commands: When Speech Recognition is active,
your Mac can understand any number of commands.
From the Commands tab, you tell the Mac what type
of commands it should expect you to give, and in
which applications.
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Crowning the Speech Recognition pane are the Speakable Items On
and Off radio buttons. You probably already guessed how to use them
to switch speech recognition features on and off.

When you select the On radio button, the small cir-

@ cular Speech Recognition Feedback window appears
on your screen, floating above all other windows.
Know this face well because the round Feedback win-
dow (refer to Figure 4-10) is your friend and partner.
If you use Speech Recognition often, it becomes a
constant companion on the Desktop.

Customize Speech Recognition Settings

At the bottom of the Settings pane is the Upon Recognition section.
When your Mac comprehends one of your commands, you can set it
to respond by playing a sound, speaking a confirmation, or both. This
option is helpful when you're not sure whether your Mac understands
you. One-hundred-percent recognition isn’t a reality on any computer
at this point, so sometimes it helps to have any feedback that you can
get. Otherwise, you might feel silly shouting at your machine while it
sits there doing nothing. Or worse: It's doing things you didn’t intend
for it to do.

You can choose between two styles of listening with the Listening
Method options:

w= Listen Only While Key Is Pressed: Speech
Recognition works only while the designated key is

held down.
w= Listen Continuously with Keyword: When

you speak the keyword, listening turns on and
remains on.

To change which key must be toggled or held down,
click the Change Key button.
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If your Mac is having problems recognizing your speech, click the
Calibrate button to adjust the sound volume for better recognition.

When Speech Recognition is active, your Mac listens for whichever
phrases appear in your Speakable Items folder (a directory on your
hard drive that holds a number of scripts). The Commands tab (see
the preceding section) lets you view the contents of this folder. When
you speak a phrase that matches one of these filenames, your Mac
automatically executes that script. The script can perform any number
of actions, which is what makes Speech Recognition so powerful.
Apple includes a large number of scripts with Mac OS X.

To view the contents of the Speakable Items folder, click the Open
Speakable Items Folder button on the Commands pane. The Finder
comes to the foreground and navigates to the folder that holds the
scripts. This option is handy because each item in the Speakable Items
folder is speakable.

After you activate Speech Recognition, you instantly see the Feedback
window. You can click and drag the edge of the window to position it
anywhere on the Desktop.

The Feedback window includes controls and displays of its own:

w= Microphone Level Meter: The Feedback window dis-
plays indicators to let you know how loud the input
to your microphone is.

w= Visual Indicator: The Feedback window displays
visual feedback to let you know which mode it’s in:
idle, listening, or hearing a command. When the
microphone isn’t grayed out but no arrows appear
on either side of the microphone, you're in Listening
mode. When animated arrows flank the microphone,
your computer is hearing a command spoken. When
Speech Recognition is idle, no arrows are present
and the microphone is grayed out.
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m= Quick-Access Menu: You can quickly access the
Speech preferences for the System or view the Speech
Commands window. Just click the down arrow at the
bottom of the Feedback window, and a menu
appears, giving you one-click access to both.

As soon as you disable speech recognition in System Preferences, the
Feedback window disappears.

Because the Speech Recognition feature might be listening for different
sets of commands from the Finder or many other applications, Mac
OS X provides you with a single listing of all commands that you
might speak at any given time: the Speech Commands window. To
open the Speech Commands window, click the triangle at the bottom
of the Feedback window and choose Open Speech Commands
Window from the menu that appears.

The Speech Commands window is a simple one, but it serves an
important purpose: to let you know which commands Mac OS X
understands. The Speech Commands pane organizes commands into
categories that match the settings in the Speech pane of the System
Preferences.

If you launch another application that supports Speech Recognition,
Mac OS X adds that application’s commands to the Speech Commands
window. Speak any of these commands to make your Mac execute that
function. For example, Mac OS X ships with speech commands for
Address Book, such as Mail To and Video Chat With.

yeah, right — but it isn't without a humorous side.
With Speech Recognition enabled, say the phrase
“Tell me a joke.” Your Mac replies with a random
joke. Say it again, and your Mac tells you another
joke. (Brace yourself: These jokes are really bad.) Oh,
and if you get a knock-knock joke, remember that
you have to ask, “Who's there?” Seriously!

@ Apple might be a big, serious, computer company —
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Working with
Files and Folders

Mac OS X is a highly visual operating sys-
tem, and using it without a pointing
device (like a mouse or trackpad) is like build-
ing Hoover Dam with a pocketknife (and

not a particularly sharp pocketknife, either).
Therefore, most of this chapter requires you to
firmly grasp the little rodent, or place your fin-
ger squarely on your trackpad. I introduce you
to items such as files and folders and lead you
through the basic training you need to run pro-
grams and open documents.

I also show you just how easy it is to manage
your files and folders as gracefully as Fred
Astaire on his best day. You'll also see how to
keep your Mac tidy and organized so that you
can find things more easily and work more
efficiently:

w= Create, select, and open files and folders.
m= Copy and move files and folders.

m= [Ise a CD or DVD to back up all your
precious stuff.
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Store Files on Your Mac

Although you may already be familiar with how your information is
stored in files, I want to cover the big concepts you need to know
about files — just in case:

w= The information you use and the stuff you create
are saved in files. A file is an individual item that
has its own name and properties, such as the date it
was created and which program runs it. For example,
a letter you write, a photo you take, and your genea-
logical data you catalogued are all stored in individ-
ual files.

w= You run programs to create and edit files. A pro-
gram is used to do work on a computer (such as
Pages, which you would use to type that letter). In
the Mac world, a program is often referred to as an
application (or “app”). So a program and an applica-
tion are exactly the same thing!

w= Files are linked to programs. Here’s one of the fea-
tures that makes the Mac so neat! Double-click a
Pages document you created (again, that same dog-
gone letter I keep mentioning), and Lion automati-
cally knows that the Pages program has to run for
you to work with that document: say, make changes
to the letter or print it. Then the needed program
automatically launches and loads the letter file,
ready for you to use. The file is marked as a Pages
document, and Lion maintains the link between
them. Snazzy!

to make it as easy as possible to visually identify
which program owns which file. Therefore, most pro-
grams use a special icon to indicate their data files.
For example, Figure 5-1 illustrates several documents

@ Although each file is individually named, Lion tries
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and data files created by a range of programs: iPhoto,
Pages, Automator, and Safari.

w= Word processing and desktop publishing files are
called documents. A document is just a special kind of
file. For example, a newsletter created in Pages and a

home budget spreadsheet created in Numbers are
both documents.

Documents and files

[ File Icons

ENCN Bl=om(=-] (@](e][|p][#:] (8] @

FAVORITES

P, = I =2
% Dropbox mwa ==
= All My Files

_ Apple's Web Site Dad and Erin.jpg Pages Newsletter
| Desktop

2] mark

% Applications

- R Tile Windows Script

2%, Utilities

| Games

SHARED

1»

| blackdragon
.| acerserver

lioness

4 items, 12.63 GB available -

Figure 5-1

Organize Files with Folders

“Mark, I thought this computer was going to get me away from all that
paper in my filing cabinets!” Don’t worry, dear reader: Your Mac can
indeed create a paper-free zone in your home office. Start off by think-
ing about your Mac as a big filing cabinet.

w=» A folder is simply a “container” that you can use to
hold one or more files on your Magc, just like an
actual manila folder that (hopefully) gets put away
neatly in a cabinet drawer. (The folks who designed
the first Mac operating system decades ago knew that
we're all comfortable with the idea of storing infor-
mation in folders, so they used the idea.)
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nmp

Every user account that you create on your Mac has a special folder,
called a Home folder, where you can store documents and data for
your use. No one else can see the contents of your Home folder, which
is named after your account. (Visiting your Home folder is easy —
open any Finder window, and you'll see it under the Favorites heading

You can organize your files on the Desktop and
within Finder windows by copying and moving files
in and out of folders (or, in brave moments, even
between folders). (Chapter 8 explains how to cut,
copy, and paste.) This is no different than moving a
piece of paper from a manila folder to another.

Folders can be named, renamed, and deleted, just
like files can. (Sections later in this chapter explain
how.) You can also create a folder within a folder to
further organize your stuff, and these “enclosed”
folders are subfolders.

As you can see from the assortment shown in
Figure 5-2, folders have a 3-D look in Mac OS X. In
fact, major system folders (including Applications,
Downloads, Library, System, Users, and Utilities)
sport folder icons in Lion that help identify their
contents.

at the left side of the window.)

Inside your Home folder are a number of subfolders that are automat-
ically created as well, and you can use these folders to store all sorts of
documents and help keep your Mac organized. The most important

Home subfolders include

nmp

Documents: This subfolder is provided so that you
can store all sorts of documents you've created, like
your Pages projects. Lion also places a link to your
Documents folder on the Dock.
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e 00 [LJ Folder Icons
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— All My Files 150N “I:

|==| Desktop

£} mark Library Movies

Wy Applications ) — Folders

[ Documents W —

S o “. ™ /;fF

t,:x Utilities ‘. .‘& ! .

] Games g ——
SHARED Growl Hewlett-Packard

[ blackdra... &

[ acerserver

1 lioness ,
DEVICES !

. Ludwig

. Google Chrome

|| Antonio

=) Time Ma... =

.| Johann

|- Windows XP

(s J——

Figure 5-2

w= Downloads: You'll also find this subfolder on the
Dock. By default, Safari stores all files you've down-
loaded from the web in this subfolder.

w= Movies, Music, and Pictures: These three subfolders
are self-explanatory. They store any movies, digital
music files (including your iTunes music library),
and photos that you upload from your camera or
snap with your FaceTime camera.

Open Files and Folders

To open a folder within Lion, just double-click it. (Alternatively, you
can click it once to select it and then press 38+0.) The contents of the
folder (documents, photo files, and so on) are displayed within a new
window, or within the current window (depending on how you set
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View mode, which you can read about in Chapter 3).
Here's the simple way to load a document:

1. If a Finder window isn't already open, double-click your
Mac’s hard drive icon on the Desktop. This opens a
Finder window.

See Chapter 3 if you need a little help finding this
icon on your Desktop.

2. Double-click the folder that contains the document. If
the document is stored in a subfolder, double-click that
subfolder to open it.

3. When the document is visible, double-click it. (This is
my preferred method because I'm an ALT — short for
Admittedly Lazy Technowizard — who would rather use

complex hand movements to pour myself another Diet
Coke.)

If the program that you created the document with is already open,
you can also open a document from inside the program. For example,
if I already have Pages open, I can open a document from there.

1. Choose Filec>Open or press the handy 38+0 key combi-
nation. Your Mac OS X application is likely to display the
attractive Open dialog that you see in Figure 5-3.

Note that you can switch the Open dialog between view
modes (see Chapter 3), just like a Finder window, so you
can browse in Icon mode, List mode, Column mode, or
Flow mode. (For this demonstration, I use Column
mode, which is my favorite view mode.)

2. Navigate to the location of the document you want to
open. In the Open dialog, you can navigate in one of
two ways:
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AL Open

P :: Bl R 4 Pop-up menu
FAVORITES

|| Dropbox

= All My Files

|] Desktop

Applications Applications (Parallels)

2 Applications

[ Documents

2% Utilities

N T

|| Games
SHARED Desktop Documents

|= blackdragon =

= acerserver

| lioness
DEVICES =

|& Ludwig Downloads Dropbox

.. Antonio

= Time Machine Backups =

|| Johann

=] Windows XP ===
MEDIA Library Local Settings

& Photos

Cancel [ Open |

Figure 5-3

e Use the pop-up menu or sidebar to jump
directly to common locations — such as the
Desktop and your Home folder — as well as
places you recently accessed (Recent Places).

e If the target folder isn’t on your pop-up menu,
move the slider at the bottom of the dialog to
the far left to display your hard drives, CD-ROM
and DVD drives, and network locations.

If you're having trouble locating the file or enclos-
ing folder, click in the Search box in the upper-
right corner of the Open dialog and type the first
few letters of the name to display files with match-
ing names on your Mac.
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3. Click the location where the file is stored (usually within

at least one folder).

Note that the right columns change to show you the con-
tents of the item you just clicked. In this way, you can
cruise through successive folders to find that elusive doc-
ument. (This somewhat time-consuming process is some-
what derisively called drilling — hence, the importance of
using Recent Items, as I discuss later in this chapter.)

4. When you spy the document you want to load, either

double-click it, or click once to highlight the filename
and then click Open.

@ “Hey, the Open dialog can be resized!” That's right,

good buddy. You can expand the Open dialog to
show more columns and find things more easily.
Like any window in Lion, you can click and drag any
edge of the Open dialog to resize it.

View Documents with Quick Look

112

The link that connects a program with a document is A Beautiful
Thing, but sometimes you just want to look at the contents of a file —
and if you double-click that document file, you end up waiting for the
entire application to load. (Depending on the size of the program, this
process can take as long as 10 or 15 seconds!) There has to be an eas-
ier way to just take a gander at what's inside a document.

Don’t think that I would have gone that far into a fancy introduction
if the answer were negative. I'm ushering in the Lion Quick Look fea-
ture, which can display the contents of many documents — but with-
out opening the corresponding program! This capability is one reason
that you bought a Mac.
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To use Quick Look from a Finder window, follow these steps:

1. Click to select a file.

2. Press the spacebar. Figure 5-4 illustrates Quick Look in
action, this time displaying the contents of a Pages
document.

As with other windows in Lion, you can click the lower-

@ right corner of the Quick Look window and drag it to
resize the window. To display the Quick Look window
full-screen, click the double-arrow button at the top
right corner of the window. Press Esc twice to banish
the window and return to your desktop.

PC Clinic flyer Open with Pages

Here o What You Wen:

* In-home visit! {| bring my own Diet Coke)

° Anti-virus check! (Don't have an anti-virus program yet? Mo problem, I'll install
Avast Anti-Virus)

° Spyware check! (If you don't have a spyware program yet, I'll install Spybot
‘Search & Destroy)

° Registry cleanup!
* Hard drive check!
 Wind, p and

Note that pre-existing or Internet probl are not included.

Figure 5-4
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3. Press Esc (or click the Close button in the upper-left cor-
ner of the Quick Look window) when you're done check-
ing out the document.

View Images and PDF Documents with Preview

Along with Quick Look, Lion offers a Swiss army knife application
for viewing image files and PDF documents: namely, Preview. You
can use Preview to display virtually all popular types of digital photos
produced by today’s cameras (and available for downloading on

the web).

printed document in electronic format. You can view
PDF documents on your screen, but typically you
can’t modify them. (Many publishers sell e-books in
PDF format, because PDF documents can be viewed
on just about any computer or tablet available these
days — even many smartphones can display them.)

@ If you haven’t heard of PDF documents, think of a

Lion automatically loads Preview when you double-click an image in a
format it recognizes or when you double-click a PDF file. Check out
the image displayed in Preview in Figure 5-5, which shows the tool-
bar. It also acts as a Print Preview window. However, if you want to
launch Preview manually, click the Launchpad icon on the Dock and
then click the Preview icon. (Read all about Launchpad in Chapter 3.)

I know — if that were the sum total of Preview’s features, it wouldn't
deserve coverage here. What else can it do? Here's a partial list (just
my favorites, mind you):

w= [Ise Preview to add a bookmark at the current page

within a PDF document by choosing Bookmarks=>
Add Bookmark.
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Preview toolbar

800 |# Leica 1.jpg =

N

(s a)5 BBz @ooE

Figure 5-5

w= Fill out a form in a PDF document by choosing
Tools=>Text Tool. Click an area that’s marked as an
input field, and you can type text into that field.
After you complete the form, you can fax or print it.

w= Take a screen snapshot (saving the contents of your
screen as a digital photo) by choosing Filew>Take
Screen Shot=>From Entire Screen.

Lion displays one of those pesky error messages —
rather than write down cryptic codes and messages,
you can show the snapshot to a technician or Mac-
savvy friend later!

@ Taking a snapshot of your screen is a great help when
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Create a Link to a File or Folder
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An alias acts as a link to another item elsewhere on your system. For
example, to load an Adobe Acrobat document (like a PDF), you can
click an alias file icon that you can create on the Desktop (or add to
your Dock) rather than click the actual file icon itself. The alias acts
essentially the same way as the original icon, but it doesn’t occupy the
same space — only a few bytes for the icon itself, compared with the
size of the actual file. Plus, you don't have to dig through folders
galore to find the original document.

@ You can always identify an alias by the small, curved

arrow at the base of the icon, and the icon might also
sport the tag alias at the end of its name.

You have two ways to create an alias. You can

1. Select the item.

2. Choose FilecoMake Alias or press 38+L. Figure 5-6 illus-

trates a number of aliases, arranged next to their linked
files.

Here’s another way to create an alias:

1. Press and hold the key combination $8+Option.

2. Drag the original icon to the location where you want the

alias.

@ Note that this method doesn’t add the alias tag to

the end of the alias icon name.
Why bother to use an alias? Here are two good reasons:

w= Open a document from anywhere on your drive.
For example, you can open a Pages document from
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the Desktop by using an alias that you created there,
no matter where the actual document file resides.
Speed, organization, and convenience — life is good.

w= Send an alias to the Trash without affecting the
original item. When that volunteer project is fin-
ished, you can safely delete the alias (sending it to
the Trash) without worry.

If you move or rename the original file, Lion is smart
enough to update the alias, too! However, if the orig-
inal file is deleted, the alias no longer works. Go
figure.

File icon File icon alias

eoo [_—IAiaslcons_ — —
[<l>] Bl=aomj=al] (E](06](g(®](E-]»
Y

FAVORITES Y
%# Dropbox G O
b

= All My Files :
— App Store App Store alias
|| Desktop

2t mark

.
A Applications P ;’3.,3}‘
[1 Documents Growl Growl alias

LN T
2, Utilities.

] Games =\ =\
SHARED ﬂﬂ_/ ,,ﬁ/

|_;| blackdragon = HP Photosmart Studio HP Photosmart Studio

[=) acerserver alias
DEVICES "}' "}'

& Ludwig & b &

=} Antonio Photo Booth Photo Booth alias

|2 Time Machine Bac... =

. Johann
. Windows XP

Figure 5-6
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Launch Recently Used Documents and Programs

Apple knows that most folks work on the same documents and use
the same programs during the course of a day. You might use iPhoto
several times to edit different images, for example, or use Pages to look
at the same report many times in the span of a day.

To make it easier to access these frequently used programs and docu-
ments, Lion includes the Recent Items list. Follow these steps to use it:

1. Click the Apple symbol (%) on the bar to display the menu.

2. Hover the pointer over the Recent Items menu item. The

Finder displays all applications and documents you used
over the past few computing sessions — of course, if you
open a lot of documents and applications, your Recent
Items list may only cover your current session.

3. Click an item to load that document or application.

Select Items
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Often, the menu commands or keyboard commands you perform in
the Finder need to be performed on something: Perhaps you're moving
an item from one window to another or creating an alias for that item.
To identify the target of your action to the Finder, you need to select
one or more items on your Desktop or in a Finder window. In this
section, I show you just how to do that.

Lion gives you a couple of options when selecting just one item for an
upcoming action:

w= Move the pointer over the item and click. A dark
border (or highlight) appears around the icon, indi-
cating that it’s selected.

w= [f an icon is already highlighted on the Desktop or
within a window, move the selection highlight to
another icon in the same location by using the
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arrow keys. To shift the selection highlight alphabet-
ically, press Tab (to move in order) or press
Shift+Tab (to move in reverse order).

them. You have to perform an action on the selected

@ Selecting items in the Finder doesn’t do anything to
items to make something happen.

You can also select multiple items with aplomb by using one of these
methods:

w= Adjacent (contiguous) items

Drag a box around them. If that statement sounds like
ancient Sumerian, here’s the explanation: Click a
spot above and to the left of the first item; then hold
down the mouse button (or hold your finger on the
trackpad) and drag down and to the right. (This pro-
cess is called dragging in Mac-speak.) A box outline
such as the one shown in Figure 5-7 appears, indi-
cating what you're selecting. Any icons that touch, or
appear within, the box outline are selected when you
release the button.

Click the first item to select it and then hold down the
Shift key while you click the last item. Lion selects both
items and everything between them.

w= Nonadjacent items

Select these items by holding down the 8 key while
you click each item.

window. It tells how many items are displayed in the
current Finder window. When you select items, it
shows you how many you highlighted.

@ Check out the status line at the bottom of a Finder
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Figure 5-7

Create Folders

Selected icons

Status bar

In the Mac world, you create new folders from a Finder window, by

using one of these methods:

w= With the mouse or trackpad: Right-click in a Finder
window or on any open space on the Desktop, and

then choose New Folder from the menu.

w= With the keyboard: Press 8+Shift+N.

w= From the Finder window toolbar: Click the Action
button (which bears a gear icon) and choose New

Folder from the menu that appears.

No matter how you create a folder, Lion highlights it automatically
and places a text cursor underneath so that you can immediately type
the name for your new folder. Press Return when you're done typing

the name.
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You'll create folders often to organize documents and
files that are related to each other, like all the images
and text you're using for a project.

You can also create subfolders inside of folders for easier organization.
(For example, my tax records are stored as subfolders named for the
tax year, and all of them are located within the Taxes folder on my
Desktop.)

Rename Items

You wouldn't go far in today’s spacious virtual world without being
able to change a moniker for a file or folder. To rename an item in
Mac OS X — file or folder — use one of these two methods:

w= The mouse or trackpad: Click an icon’s name just
once. Mac OS X highlights the text in an edit box.
Type the new name and then press Return when
you're done.

w= The Info dialog: Select the item and press 8+I to
display the Info dialog; then click the triangle next to
Name & Extension. Click in the name field, drag the
mouse to highlight the text you want to change, and
type the replacement text.

The first method is the easiest, and it's the one I use most often.

and don't rename any of the default subfolders Apple
provides in your Home folder. (I discuss these sub-
folders earlier in this chapter.) Renaming these items
may make it harder for you to locate your documents,
and may even damage your Mac OS X installation.

@ Never rename folders or files in your System directory,

Delete Items You No Longer Need

Even Leonardo da Vinci made the occasional design mistake. I'm
guessing that his trash can was likely full of bunched-up pieces of
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parchment. Luckily, no trees are wasted when you decide to toss your
unneeded files and folders; this section shows you how to delete items
from your system.

By the way, as you'll soon witness for yourself, mov-
ing items to the Trash doesn’t necessarily mean that
they're immediately history.

You have a few different ways to toss files into the Trash:

y = Drag unruly files against their will. In Mac OS X,
the familiar Macintosh Trash can appears at the right
edge of the Dock — it’s that spiffy-looking wire can.
You can click and drag the items you selected to the
Trash and drop them on top of the wire can icon to
delete them. When the Trash contains at least one
item, the wire can icon changes to look as though it
were full of trash.

w= Delete with the menus. Click the offending file or
folder, then choose File from the Finder menu bar
and choose the Move to Trash menu item. Or you
can right-click the item to display the shortcut menu
and then choose Move to Trash from the menu. You
can also click the file or folder, click the Action but-
ton on the Finder toolbar, and select Move to Trash
from the pop-up menu.

w= Delete with the keyboard. Click the file or folder to
select it, and then press 38+Delete.

absolutely sure that you want to delete its contents —
and remember, you can't retrieve files from the Trash
after you empty it. To check the contents of the
Trash, right-click the Trash icon on the Dock and
choose Open from the pop-up menu. If you find a
file or folder in the Trash that you want to restore,
drag the item out of the Trash and drop it within the
desired Finder window — if you're not sure where to

@ Always double-check the Trash contents and make
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put the restored item, you can always simply drop
the item on the Desktop and then move it later.

Copy Files and Folders

It's what life is all about, as George Carlin might have said — manag-
ing your stuff. On your Mac, that usually means copying and moving
files and folders from one drive to another or from your Mac’s internal
hard drive to an external drive. In this section, I show you how to
copy items from one Finder window to another, or from one location
(such as a CD-ROM) to another (such as your Desktop). It's trés easy.

®

[T 2

[T 2

When you open a Finder window, you can always see
where the files it contains are located. Just check out
the Devices list at the left side of the window, and
you'll see that one of the devices is highlighted.
You're copying stuff on the same drive if both loca-
tions are on the same device. If, however, one Finder
window is displaying items from your hard drive and
the other is displaying items from a USB flash drive
or DVD, then you're copying between drives.

To copy one item to another location on the same
drive: Hold down the Option key (you don’t have to
select the icon first) and then click and drag the item
from its current home to the new location.

To put a copy of an item within a folder, just drop
the item on top of the receiving folder. If you hold
the item you're dragging over the destination folder
for a second or two, Lion opens a new window so
that you can see the contents of the target. (This is a
spring-loaded folder. Really.)

To copy multiple items to another location on the
same drive: Select them all first, hold down the
Option key, and then drag and drop one of the
selected items where you want it. All the items you
selected follow the item you drag. (It's rather like
lemmings. Nice touch, don't you think?)
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®
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®

To help indicate your target when you're copying
files, Lion highlights the location to show you where
the items will end up. (This process works whether
the target location is a folder or a drive icon.) If the
target location is a window, Lion adds a highlight to
the window border.

To copy one or multiple items on a different drive:
Click and drag the icon (or the selected items if you
have more than one) from the original window to a
window you open on the target drive. (There’s no
need to hold down the Option key while copying to
a different drive.) You can also drag one item (or a
selected group of items) and simply drop the items
on top of the drive icon on the Desktop. (For exam-
ple, if you have a document on your hard drive that
you need to transfer to a USB flash drive, you would
drag the document icon from its current location to
the USB drive icon on your desktop. Note that Lion
doesn’t add anything to the copy’s filename.)

If you try to move or copy something to a location
that already has an item with the same name, a dia-
log prompts you to decide whether to replace the file
or to stop the copy or move procedure and leave the
existing file alone. Good insurance, indeed.

Move Things from Place to Place
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Moving items from one location to another location on the same drive
is the easiest action you can take. Just drag the item (or selected items)
to the new location. The item disappears from the original spot and

reappears in the new spot.

To move items from one drive to another drive, hold down the 8 key

while you drag them to the target location.

Why move a file instead of copying it? It's all about what software
developers call version control: If you've saved a document to the wrong
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folder, for example, and you simply copy that file to the location
where you actually wanted it, you now have two documents with the
same name. Which is the current copy? (You'll have to keep track of
that.) However, if you move the document instead, there’s still only
one version of the document. Plus, moving things helps keep your
hard drive neat and organized!

Back Up to CD or DUVD

Although more elegant and expensive solutions exist for backing up to
an external (or networked) hard drive, sometimes you want to copy
files and folders to a recordable CD or DVD, either as a simple backup
or perhaps to carry with you on a trip or give to another Mac owner.

Lion makes this process easy. Follow these steps:

1. Load a blank disc into your Mac’s optical drive. The dia-
log you see in Figure 5-8 appears.

You inserted a blank DVD. Choose an action
from the pop-up menu or click Ignore.

Action: | & Open Finder '3]

1 Make this action the default

”'_f\ _ Eject _lgnore ) [ OK
Figure 5-8

2. Click OK. A DVD icon labeled Untitled DVD appears on
the Desktop. (If you want to name the disc, rename it
just like you rename a file or folder.)

3. Double-click the Untitled DVD icon to open a Finder win-
dow with the contents of the disc, as shown in Figure 5-9.

4. Into the disc’s Finder window, drag the files and folders
you want to back up. (Note that until you burn the disc,

the file and folder icons that you add carry an alias arrow.)
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Don't forget that the total amount of data shouldn't

@ The items you add can be organized any way you like.

exceed 700 megabytes (MB) on a CD. You should also
stick within 4 gigabytes (GB) or so on a standard record-
able DVD or 8GB on a dual-layer recordable DVD. You
can see how much free space remains on the disc at the
bottom of the disc’s Finder window. (Just check the pack-
aging if you're not sure what kind of disc you have.)

5. When you finish adding files to the disc, click the Burn
button on the right side of the window.

6. Choose the fastest recording speed possible.

7. Click Burn.
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w= Add a USB Printer to
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No matter what you use your Mac for, it can . _
produce Outstanding documents With L 2 Pl’lnf a Flle ........................ ]28

today’s printers. w= Choose a Default Printer.... 131

You're not limited to just a printer, either: Use
a scanner or multifunction printer to send
faxes, or produce electronic documents in the w= Create a PDF Document..... 133
Adobe Acrobat PDF format.

w= |nstall a USB Scanner........ 134

w» Send a Fax ...................... 135

m= Remove a Prinfer............... 132

In this chapter, you find out how to
w= nstall a local USB printer.
w=  Print a file.
w= Remove a printer from your system.
ws Produce a PDF electronic document.
w= [nstall a USB scanner.

w= Send a fax document.
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Add a USB Printer to Your System

!I, Here’s the most common task that you'll probably want to tackle soon
after installing Mac OS X: printing documents. Most of us have a
Universal Serial Bus (USB) printer, so as long as your printer is sup-
ported by Mac OS X, setting it up is as easy as plugging it into one of
your Mac’s USB ports (shown in the margin). The Big X does the rest
of the work, selecting the proper printer software driver — a driver is a
program that allows Mac OS X Lion to recognize and use your printer.

printer manufacturer. If the installation of a driver is
required, you should find detailed instructions on
loading it as part of the manufacturer’s setup instruc-
tions. After you load the disc and the CD window
appears, double-click the Setup or Install application
to install the drivers. (Don’t forget to visit the manu-
facturer’s website, via your Safari web browser, to
download the latest driver software. Manufacturers
make improvements to their drivers to squash bugs
and stay current with updates to Lion.)

@ You may have to load a driver CD supplied by your

I know that this process sounds too good to be true, but I can tell you
from my experiences as a consultant and hardware technician that
installing a USB printer is really this simple! 'Nuff said.

Unfortunately, if you're adding a Bluetooth or wire-

@ less Ethernet printer to your system, setting things up
is more complicated than the convenience of USB
(and the installation process varies by manufacturer).
Therefore, it's important that you follow the manu-
facturer’s setup instructions carefully.

Print a File

You didn't read this far into this chapter without a burning desire to
print something, so in this task, I go over the printing process in
detail.
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To print from within any application by using the default page
characteristics — standard 8'4~" x 11" paper, portrait mode, no
scaling — follow these steps. For these steps, say you have a document
open in Pages (which you can read more about in Chapter 8):

1. Choose File from the toolbar and then Print from the

menu.

Mac OS X displays the simple version of the Print sheet.
To display all the fields you see in Figure 6-1, click the
Show Details button at the bottom of the dialog.

Some applications (such as Word 2011) use their own

custom Print dialogs, but you should see the same

general settings as the ones shown in Figure 6-1.

Click these buttons to preview before printing.

06 6 Untitled

(87 ] [ Helvetica s )(Requiar  :J12 |- | (MICE] (21 v EHI==

Presets: | Default Settings
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| TextEdit

lof2 [

Printer: | HP LaserJet M1522nf MFP

ar| |4

1

8.50 by 11.00 inches

Print header and footer

[ Rewrap contents to fit page

(?) | PDF ~ Hide Details
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quickly fill up this TextEdit document window.This is a large amount of text,
which | shall be repeating over and over so that | can quickly fill up this TextEdit
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pop-up menu and choose the desired printer. Note
that selecting a different printer may automatically
change the page characteristics, or you may have to
manually select a different page size.

@ If you want to use a different printer, click the Printer

2. Preview your document.

Would you jump from an airplane without a parachute?
Don't waste paper printing a document without double-
checking it first. Just click the Page Forward button (the
right-arrow icon) to check the appearance of each page in
your document in the Preview display at the left side of
the sheet. If something doesn’t look right in the Preview
display, click Cancel and return to your document to fix
the problem.

3. Click in the Copies field and enter the number of copies
you need.

4. Decide how much of the document you want to print:

e The whole shootin’ match: Leave the default Pages
radio button All setting.

e Anything less: To print just a range of selected
pages, select the From radio button and enter the
starting and ending pages.

Try a test print run of just the first page before you
print a big document. No need to waste ink or toner.

5. (Optional) Choose application-specific printing parameters.

Each Mac OS X application provides different panes so
that you can configure settings specific to that applica-
tion. You don't have to display any of these extra settings
to print a default document, but the power is there to

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 6: Working with Printers, Scanners, and Faxes

change the look dramatically when necessary. To display
these settings, click the pop-up menu in the center of the
Print dialog and choose one of these panes. For example,
if you're printing from the Address Book, you can choose
the Address Book entry from the Style pop-up menu and
elect to print mailing labels or a pocket address book.

6. When everything is go for launch, click the Print button.

Choose a Default Printer

Many Mac owners have more than one printer: perhaps a black-and-
white laser printer for plain letters and documents, and an inkjet
printer for projects where color is important. If you have such a setup,
most of your print jobs should be sent to the laser printer (because
printing a document with the laser is likely to be cheaper and faster
than using the inkjet). The default printer is the one you plan to use
for most, if not all, of your print jobs.

You can easily set the default printer within Lion! With your default
properly set, you don’t have to bother choosing a printer from the
Print sheet for every job — just click Print and go.

To set your default printer, follow these steps:
Eexd 1. Click the System Preferences icon on the Dock.
e o
2. Click the Print & Scan icon to open the Print & Scan pref-

erences pane, as shown in Figure 6-2.

3. Click the Default Printer pop-up menu to select one of
your installed printers.

If you choose Last Printer Used, Mac OS X uses the
printer that received the last print job.

4. Close the System Preferences window to save the change.
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Figure 6-2

Remove a Printer

If you replace one of your installed printers with a new model, Lion
can’t automatically delete the old printer entry. Lion is indeed a very
smart operating system, but not that smart. Luckily, removing a printer

selection from your system is easy.

E=aa 1. Click the System Preferences icon on the Dock.

[ ¥
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2. Click the Print & Scan icon to open the Print & Scan pref-

erences pane; refer to Figure 6-2.

3. Click the printer entry you want to delete.

4. Click the Delete button (carries a minus sign) below the

Printers list.

Depending on the printer manufacturer, you may be
prompted for confirmation before the printer entry is

removed from the list.

5. Close the System Preferences window to save the change.
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Create a PDF Document

The Adobe Acrobat application is used to create electronic documents
in the PDF format. PDFs are a bit like snapshots of a document, and
you typically can’t change them, like you can make changes to a Word
or Pages document. However, PDFs can be displayed on virtually all
computers and many portable devices (such as mobile phones and
tablets), and that’'s why they're so handy and prevalent on the Internet.
Many manufacturers and publishers offer manuals (and books like
this) online as PDF files! Reader, another program made by Adobe, is
what you use to read and print PDFs.

Although you certainly can install Adobe Acrobat under Lion, I'd be
remiss if I didn't mention that you don't have to because Mac OS X
provides built-in support for creating, printing, and reading PDFs.

To save a document as a file in PDF format from just about any Mac
application, follow these steps:

. Within your application, open the document you want to

save as a PDF and choose File>Print — or press 88+P.
Mac OS X displays the Print sheet, as shown in Figure 6-1.

Click the PDF button and then choose Save as PDF from
the menu that appears.

Lion displays the Save dialog, as shown in Figure 6-3.

From the Where pop-up menu, navigate to a folder; then
type a filename in the Save As box.

Click Save to create your PDF file.

You can double-click your new PDF file to open it within
Preview. Shazam!
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Figure 6-3

Install a USB Scanner
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A scanner is a hardware peripheral that you use to import (copy)
images to your computer and “read” text from a page into a Pages or
Word file. With a scanner connected to your Mac, you can use the
combination of your scanner and printer as a copy machine (with
software provided by the manufacturer) or as a fax machine (using a
USB modem and the fax support built in to Lion). If you have a multi-
function “all-in-one” printer that scans and faxes as well, you can also
perform copy machine and fax machine magic.

Here's just how easy it is to hook up a scanner. As long as your scanner
supports Mac OS X, plug the USB cable from your scanner into one of the
USB ports on your Mac (shown in the margin here). Then load the instal-
lation CD. Just about all scanners come with software and drivers from
the manufacturer. After you load the disc and the CD window appears,
double-click the Setup or Install application.

After you install your scanner, refer to the user guide for more infor-
mation on the applications included by the manufacturer. Often, the
manual (or a shortcut to it) will be saved to your Desktop.

Although the scanning program you run (and any buttons you press
on the scanner) are different for every scanner, the basic process for
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scanning a paper photo or document is the same: Load the original
into the machine, run the manufacturer’s scanning program, and spec-
ify where you want to save the final scanned file. Note that some scan-
ners act like copy machines (where you raise the lid to place the
original), and others are sheet-fed (like a traditional fax machine).

Send a Fax

Remember when the fax machine was king? Those days have passed —
folks send documents by e-mail more often these days — but faxing is
still important for a significant number of home businesses. Here's the
good news: As long as your Mac has a compatible external USB dial-up
modem connected to a phone line, you're a lean, mean faxing machine!

Here's how to enter the recipient information and send a document as
a fax:

1. Within your application, open the document you want to
send and choose Filer>Print — or press 38+P.

2. Click the PDF button at the bottom of the Print dialog to
display the pop-up menu, and then click Fax PDF.

Lion displays the Fax sheet.

3. Type a telephone number directly in the To field.

4. Type a dialing prefix (if necessary to reach an outside line).

5. (Optional) If you need a spiffy-looking cover page, select
the Cover Page check box and then click in the Comment
box directly below it and type whatever you like.

6. (Optional) Type a subject.

7. Click the Forward button under the Preview display to
view all the pages of your fax.

8. When all is ready, throw caution utterly to the wind and
click the Fax button.
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Can | receive faxes, t00?

Of course, your Mac can receive faxes! To enable this feature, open System
Preferences and click the Print & Scan icon. Click the fax entry in the list at the
left (for example, the following figure shows my HP multifunction printer as my
fax machine). Make sure that you type your fax number in the Fax Number
field. Next, click the Receive Options button to display the Receive settings, and
then select the Receive Faxes on This Computer check box. Set the number of
rings Lion should wait before answering the call. You can save your incoming
faxes as files within a folder you specify or e-mail the contents automatically to
any e-mail address you like. (Perfect for vacations!) If you like, you can even
take the mundane route and print them on your system printer. Click OK to
return to the Print & Scan pane, and then click the Close button to close the
System Preferences window.

80 Print & Scan
- Show All

HP Laser]et M1522nf MFP

- 5-
7] HP Laserjet M1522nf. (Fax)

-~ Idle, Last Used

Open Fax Queue

B Receive Options...

Fax Number: |555-555-4711
HP Laserjet MFP Series CUPS v1.1
Idle

Show fax status in menu bar

Share this fax on the network Sharing Preferences

Default printer: | Last Printer Used

Default paper size: | US Letter

i
i \ Click the lock to prevent further changes.

If you're going to use your Mac as a fax machine often, | definitely recommend
selecting the Show Fax Status in Menu Bar check box. That way, you can moni-
tor what's happening as your Mac sends and receives throughout the day.
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Getting Help

No matter how well written the application
or how well designed the operating sys-
tem, sooner or later, you need support. That
goes for everyone from the novice to the expe-
rienced Mac owner.

In this short but oh-so-important chapter, I
lead you through the various Help resources
available on your computer, through Apple,
and other suppliers of assistance from sources
on the Internet and in your local area.

In this chapter, you find out how to

w= [Ise the Help resources within Lion and
Mac applications.

w= Search the Lion Help system for specific
information.

w= Enable shared screens to allow people to
help you by accessing your Mac.

w= Access the Apple online forums and voice

support.

w= Get help from third parties.
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Explore the Help Window

Your first line of defense for Lion is the Mac OS X Help Center, as
shown in Figure 7-1. To display the Help Center, go to the Finder
menu at the top of your Desktop, click Help, and then choose Help
Center from the drop-down menu. This Help menu is context sensi-
tive, so it contains menu items that pertain to the application that
you're working in.

Action button Toolbar
8 00 ¢ Help fenter
— ———
[ a|> | [ B~ Q- Search Help
£} Help H
Welcome to
Browse the web, chat, Connect to a Wi-Fi network

and make video calls .
Connect to a wired network

Browse the web QUiCk I_inkS

Make video calls

Chat using your existing IM accounts

}

Help information for all your applications
Figure 7-1

You can also press 8+? on your keyboard to get to
the Help Center.
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As shown in Figure 7-1, the Help Center is divided into three sets of
controls:

m= Toolbar: The toolbar includes navigational controls
(Back, Forward, and Help Center buttons), an Action
button (where you can print a topic, or change the
text size), the Bookmark icon, and the Search Help
text box.

m= Quick Links: Clicking these links directly opens
some of the most frequently asked Help topics for
the Finder (or the application you're using), such as
Connect to a Wi-Fi Network and Make Video Calls. To
use a Quick Link, just click once on the question you
want to pursue.

w= Help for All Your Apps: Click this link to display
the Help information for the applications you've
installed on your Mag, all on one screen! The icons
are divided up into Recent Applications (those that
you've recently used), Apple Applications (software
from Apple), and Other Applications (from third-
party developers). Just click an icon to display the
Help information for that application.

The Help Center might look a little sparse at first glance, but when you
realize how much information has to be covered to help someone
with an operating system, you get an idea of why Mac OS X doesn't try
to cover everything on one screen. Instead, you get the one tool that
does it all: the Search Help box, which I cover in the next section.

Search Help

You have two options when searching for a specific Help topic:

w= From the Finder Help menu: Wowzers! In Lion, you
don’t even have to open the Help Center to search
for assistance on a specific topic. Just choose Help

www.it-ebooks.info
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from the Finder menu at the top of your Desktop,
click in the Search field right there on the menu,
and type a keyword or two. Topics that Lion thinks
answer your query start to appear automatically. You
don’t even need to press Return; just click the topic
that sounds the most helpful.

Although you can ask a full-sentence question, I find
that the shorter and more concise your search crite-
ria, the better the relevance of your return.

w= From the Help Center: Click in the Search text box
on the right side of the Help Center toolbar, type
one or two words that sum up your question, and
press Return. Figure 7-2 illustrates a typical set of
topics concerning USB printers.

Click a topic to read more.  Type your search term.

800 Help Center V
|;| | B~ | Q~ USB printers

Results from:

,"_’.“ All Help

L;Q If you can't add a printer to your list of printers

ﬂ; If you don't see your printer in the Print dialog
. Share a printer over the Ethernet WAN port
ﬂ; If you can't remove printers from your list of printers

.. If your USB printer isn't responding

0 Product Support Show

Figure 7-2
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No matter which method you use, the topics are sorted by approxi-
mate relevance first. (Note that you don't see help topics taken from
the Apple website — under the heading Product Support — unless
your Mac has an active Internet connection.)

You can click any topic to display the topic text, which looks like the
text you see in Figure 7-3.

Click the Back button to return to the topic list.

Help Center
'Q‘ USB printers

ﬁ If you can’t add a printer to your list of
printers

If you can't add a printer to your list of printers, it may not be connected
properly, it may be on the wrong network, or you may not have permission to
add it.

¢ The person who administers your computer may have prevented you from
adding printers. Ask that person for more information.

« |f you're adding a USB printer, make sure you connect the printer to your
computer with a USB cable. Although you may be able to print successfully
when using a USB-to-parallel cable or adapter, you should use a USB cable
whenever possible. Mac OS5 X includes print drivers designed to work with
many USB printers with a USE connection. However, Apple hasn't tested
these drivers with USB-to-parallel cables, converters, or adapters. Contact
the manufacturer of your printer, cable, or adapter for compatibility
information and further assistance.

¢ |f you're adding a printer that's shared by another user, check with the
printer's owner. Make sure both the printer and the computer are turned
on, the computer is running Mac O5 X v10.4 or later, and printer sharing
is enabled.

RELATED TOPICS
Set up a printer
If 2 document doesn’t print

Figure 7-3
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The Help Center works much like browsing online: To move back to
the previous topic you chose, click the Back button on the Help Center
toolbar. (If you're not familiar with the “backward’s” and “forward’s”
of web navigation, visit Chapter 14 for all the details.)

Find Help in the Apple Forums

142

Apple has online product support areas for every hardware and soft-
ware product it manufactures. Visit www . apple.com and click the
Support tab at the top of the web page, and then click the link for
your specific Mac model. If you're not sure how to get to www .
apple.com, head over to Chapters 13 and 14 to find out how.

The discussion forums hosted by Apple allow Mac owners to provide
help and suggestions to help you solve a problem. Apple technicians
don't directly answer questions on the forums because technical sup-
port isn't free. However, many of the users I've corresponded with over
the years seem as knowledgeable as The Paid McCoy!

Click the Support Communities link to display the posting list — for
example, the forum shown in Figure 7-4 covers the Mac Pro computer
model — and browse the categories.

To search for specific information in a forum, click in the Ask Your
Question box, type what you're searching for, and then press Return.
When you find something of interest, click it to read the question and
all the answers.

The forums are message based, so you may have to read the contents
of a complete discussion before you find the solution. Consider it
somewhat like panning for gold.

If you don't find an answer by searching, click the Submit My
Question to the Community button to post your own message in the
forum. You'll need to provide your Apple ID and password before you
can post.

www.it-ebooks.info


http://www.apple.com/
http://www.apple.com/
http://www.apple.com/
http://www.it-ebooks.info/

Chapter 7: Getting Help

Type your search term.

8eo0o Mgc Pro: Desktop Computers: Apple Suppert Communities &
[« | (48] [war] [+ [ nteps:/ fdiscussions.applefom /community/desktop_computers/mac_prorcategorylD- [=5] & | (Qr Google (O
1 Mac Pro: Desktop Computers: Ap... I -

Actions

S Natifications
Click on the tabq above to browse what the community is saying or

ask your questioh below View feeds

- Top Participants in
Ask your question. —=g— Community

.r'.!. Kappy
Recent Content E Ned Snowing
3 5 Malcolm Rayfield
Refine this list... A

D\ Grant Bennet-Alder
Mini Display Port Not Working, WHY?
3 minutes ago

Re: will there be a MacPro with thunderbolt? &

by chordboard | g
31 minutes ago ‘\"’

by Summerville

Trouble Upgrading to Lion
1 hour ago

Re: How do | upgrade a Dual Core Mac Tower without having fo rebuy the same
'shell’? by Siliconsam | ol
1 hour ago

Re: spinning beach ball

by Noble Seven
2 hours ago

Click to read a discussion.
Figure 7-4

Share Screens

If you've ever leaned on the Mac expert in your family to lead you
through the paces of a tricky task — say, adding a second monitor to
your system — that’s the idea behind the ultimate collaboration tool,
sharing screens. You can allow someone to remotely control your com-
puter, or you can watch the display on another person’s Mac, and all it
takes is a broadband Internet or local network connection!
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The Lion Screen Sharing feature, available from iChat, can be turned
on for individual users from the Sharing pane in System Preferences.
(iChat allows you to talk with another person online through your
computer; see Chapter 16.) You can allow access for all user accounts
on your Mac, or limit remote access to only selected users.

know and trust should set off alarm bells in your cra-
nium. Remember that anyone with shared-screen
access can perform most of the same actions as you
can do, just as though that person is sitting in front
of your Mac. Granted, most of the truly devastating
things would require you to type your admin pass-
word, but a malicious individual could still delete
files or wreak havoc in any number of ways on your
system. Be careful with whom you share your screen!

@ Sharing a screen with someone you don't absolutely

To set up screen sharing, follow these steps:
wz7g 1. Click the System Preferences icon on the Dock.
EE;?
L % |
2. Click the Sharing icon to open the Sharing Preferences
pane.

3. Select the Screen Sharing check box, as shown in Figure 7-5.

The name will show Screen Sharing: On when you have
it selected.

4. To limit remote access for specific accounts, select the
Allow Access for Only These Users radio button and then
click the Add button (which bears a plus sign) to select a
user.

5. Close the System Preferences window to save the change.
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Turn on Screen Sharing.

800 Sharing
(<> ][ showan | C———

Computer Name: |SilverDrago

Computers on four local network can access your computer at
SilverDragon.ldeal

Edit. .

On | Service @ Screen Sharing: On

DVD or CD Sharing Other users can access your computer's screen at vnc://192.168.0.106/ or
© Sueen Sharing by looking for *SilverDragon’ in the Finder sidebar.
™ File Sharing | Computer Settings... |
E] Printer Sharing

Scanner Sharing N
Web Sharing Allow access for: (#) All users

( ) Only these users:

Remote Login
Remote Management
Remaote Apple Events
Xgrid Sharing
Internet Sharing
Bluetooth Sharing

il
Jill Click the lock to prevent further changes.

Figure 7-5

Now, you need to turn on screen sharing in iChat for you to send or
receive sharing invites. (And you need to be online, too.) Click the
Launchpad icon on the Dock, and then click the iChat icon to run
iChat. Within iChat, click Video from the toolbar and then choose
Screen Sharing Enabled from the menu. A check mark now appears
next to the menu item, showing that the feature is enabled.

When you're ready to invite another person to share your screen, click
Buddies on the toolbar, and then click Share My Screen. Both you and
the other person can now use your keyboards and pointing devices,
just as if both were attached to your Mac.

If you want to view another person’s screen, click Buddies from the
toolbar and choose Share Remote Screen. If your buddy accepts the
sharing invitation, iChat automatically initiates an audio chat (so that
you can gab away to each other while events are happening onscreen).
Suddenly, you're seeing the Desktop and applications that your buddy
is running, and you can control the cursor and left- and right-click the
mouse.
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If you're viewing another person’s screen and you need to take care of
some business on your own Magc, click the thumbnail window to swap
between your Mac’s screen and the remote Mac’s screen. Neat!

At any time during the screen-sharing session, you can click the End
Screen Sharing button at the bottom of the iChat Buddies window to
end the session. You can also click the iChat icon in the Finder menu
bar and choose End Screen Sharing from the menu.

Search Other Mac Support Resources

Although the Help Center and the online forums can take care of just
about any question you might have about the basic controls and fea-
tures of Mac OS X, you might also want to turn to other forms of help
when the going gets a little rougher.

As of this writing, Apple provides voice technical support for Mac OS
X. You can find the number to call in your Mac’s printed manuals or
online in the Support section of the Apple website. However, exactly
when you qualify for voice support and exactly how long it lasts
depends on a number of different factors, such as whether you
received Mac OS X when you bought a new machine or whether

you purchased a support plan from Apple.

You can also refer to a number of helpful Mac-savvy publications and
resources, both printed and online, for help. My favorites include

w=  Macworld (www.macworld.com) and MacLife
(www.maclife.com) magazines, both in archaic
hard copy and oh-so-slick online versions

w= CNET (www.cnet.com), an online resource for the
latest updates on all sorts of Macintosh third-party
applications
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mmp  MacFixIt (www.macfixit.com), a well-respected
troubleshooting site devoted to the Mac that offers
downloads, news, and discussion areas (subscription
required for some of the more useful sections of
the site)

You can also find local resources in any medium-sized or large town
or city: A shop that’s authorized by Apple to sell and repair Macintosh
computers can usually be counted on to answer a quick question over
the phone or provide more substantial support for a fee. For example,
my local Mac outlet sponsors inexpensive classes for new Mac owners,
and if you can reach an Apple Store, the Genius Bar is a useful
resource.

You might also be lucky enough to have a local Macintosh user group
that you can join. Its members can be counted on for free answers to
your support questions at meetings and demonstrations. To find a
group near you, visit the Apple User Group Support site at www .
apple.com/usergroups and use the locator.
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Creating
Documents
with Pages

Ithough you're likely familiar with
Microsoft Office, you do have another
choice when it comes to productivity software

on the Mac: Apple’s iWork productivity suite
can handle similar chores as Word, Excel, and
PowerPoint. Pages, the page processing pro-
gram included with iWork, handles word pro-
cessing and desktop publishing, and is
available from the Apple App Store.

In this chapter, I show you how to use Pages,
including how to

w= Create, open, and save Pages documents.

m= [Ise ready-made templates (sample docu-
ments) for many different publications.

w= Enter and format new text and edit exist-
ing text.

w= Manipulate text and graphics by using
Cut, Copy, and Paste.

w= [nsert tables, shapes, and photos into
your document.

w= Spell check and then print your
documents.
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Create a New Pages Document

Time to get creative! To start a new Pages document from scratch, fol-
low these steps. And if you want to create your document from a tem-
plate, I cover that, too. For example, why create a resume or lesson

plan from the ground up, when a template offers predesigned layout
and formatting?

@ Pages is part of iWorks. You can download it from the
Apple App Store.

\ f / 1.Click the Launchpad icon on the Dock.

g o 2. Click the Pages icon. Pages displays the template sheet
% you see in Figure 8-1.

Select a document type. Select a template.

800 Template Chooser

All

Word Processing
Blank

Envelopes
Forms
Resumes
Reports
Qutlines
Miscellaneous
el Page Layout
Blank
Newsletters

Brochures
Flyers
Posters Green Grocery Letter Personal Phote Letter Modern Letter
Cards & Invitations
Business Cards
Certificates
Miscellaneous

Traditional Letter Typewriter Letter Milano Letter

[ Open Recent YI [ Open an Existing File... ] ] o) (3] ( Cancel ] [ Choose ]

Figure 8-1
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3. Click to select the type of document you want to create
from the list on the left.

The document thumbnails on the right are updated with
templates that match your choice.

To expand or shrink the document template thumb-
nails, drag the slider bar at the bottom center of the
dialog.

4. Click the template that most closely matches your needs.

5. Click Choose to open a new document, using the tem-
plate you selected. You can now begin editing, typing
new text, and adding graphics (or updating the place-
holder graphics in the template) as I illustrate later in
the chapter.

To see the document in outline mode, click the

@ Outline icon in the Pages toolbar. Outline mode
makes it easy to discern the main headings and sub-
headings, just like a paper outline. Plus, you can click
any heading or subheading to edit it, so you can
quickly turn the example headings in a template into
your text. Click the Outline button again to return to
the normal display.

Open an Existing Pages Document

Maybe you have a document started, and you want to open it again.
You can double-click the document icon in the Finder. (Chapter 5
explains how to navigate to a file by using the Finder.) You can also
open a Pages document from within the Pages program. Follow these
steps:

1. Click the Launchpad icon on the Dock, and then click
the Pages icon to run the program.

2. Press 38+0 to display the Open dialog, as shown in

Figure 8-2.
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The Open dialog operates much like the Finder window —
you can even choose the View mode.

Double-click the filename.

Select a drive.

) B Open
< |p ||38 il 1wl || == v || [ Pages Documents | fq
FAVORITES esis.docx I IWE

=L All My Files

— _..nt faith

e .- EXTREME
. n = u

5] mark [

# Applications dvdpro % i

= ion IV L

_H Documents _arlords = i b ,.‘J

A E——
P Utilities LORES! PSAM [ILOA LIGULA EROS SET.. :

£ Games _ss.docxk
Software
SHARED es
=] black Ajlicans > g .
— uments = 8 | EEEEEESEESE Semae
= acer
DEVICES dvdproj
= Ludwig forary
. ser Data Name Trip Newsletter
- | Antonio es 3 Kind Pages Publication
| Johann dvdpraoj Size 355 KB
Created Today 1:18 AM
=) Time Machine Backups = A . Modified Today 1:18 AM
e Last opened Today 1:18 AM
anections |
Cancel [ Open
p
.
Figure 8-2

3. Click to select a hard drive from the Devices list on the
left side of the dialog, and then click (or double-click,
depending on the View mode) folders and subfolders
until you locate the Pages document.

By default, Pages saves its document files in your
Documents folder (that makes sense)! You can
always easily reach the Documents folder from any
Finder window — just click the Documents entry in
the Favorites section at the left side of the window.

4. Double-click the filename to open it.
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Type and Edit Text within Pages

Typing on a word processor is similar to typing on a typewriter, but
you need to know a few ways in which word processors are unique. If
you're a newcomer to the world of word processing, you find the
basics in this section. Here’s what you need to know to get started:

2

2

2

2

The bar-shaped text cursor, which looks like a capital
letter I, indicates where the text you enter will appear
within a Pages document. You control the placement
of the cursor by using the arrow keys on your key-
board. Or just click with the mouse where you want
the cursor.

Then, to enter text, simply begin typing where the
cursor is.

Unlike with a typewriter, you don’t need to press
Return at the edge of the page. The software wraps
the text to a new line for you. The only time to press
Return is when you want to start a new paragraph.

To edit text in your Pages document, click the inser-
tion cursor at any point in the text and drag the
insertion cursor across the characters to highlight
them. Type the replacement text, and Pages automat-
ically replaces the existing characters with the ones
you type. You can see selected text in Figure 8-3.

To delete text, highlight the characters and then press
Delete.

Simple character-by-character editing works well with
smaller blocks of text. If you have a bigger editing
job, you can certainly move a larger block of text
from one part of your Pages document to another.
Or, perhaps you want to copy a block to a second
location. That's when you can call on the power of
the Cut, Copy, and Paste features within Pages. The
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next few sections explain how to perform these

actions.
800 Untitled s
i = o o =
. = = B, B all. [] =] @ = Q A
View Qutline Sections TextBox Shapes Table Charts Comment Share Inspector Media Colors Fonts
Q@ o] | (o &f(neguar | [ «]|[slr(u]| EBEEE|TL @] =]
LA | N =T A P O A AR 7
— —

Chambers |
logy Authar

12%-466-7880 |

. 456-7891
| & 1 R raee I December 12, 2011
oo Benjamin Franklin

|

|
t:

| £

Founding Father
Philadelphia, PA

Dear Mr. Franklin,
= - I'm writing to express my admiration - as well as my gratitude for everything you've done for
this country and the scientific community!
—] & L
incerely yours,

Mark Chambers

125% 3 | 22 of 54 Words Page 1of 1 Y e

This text is selected.
Figure 8-3

Cut Text

You can easily cut selected text or graphics to remove them from your
document. If you simply want to remove the selected material from
your Pages document (and you don't plan to paste it somewhere else),
just select the text and press the Delete key.

Or, if you want, you can save what you cut, and place it on your
Clipboard so that you can use that text or graphics in something else.
Think of the Clipboard as a temporary holding area.
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To cut text or graphics and place that material on the Clipboard, first
make your selection. Then, do one of the following:

ws  Choose Edit=>Cut.

mmp  Press 8+X.

Don't forget: Your Clipboard can hold only one cut’s worth of data at
a time, so if you cut another selection of text or another graphic, you'll
lose what you originally had on the Clipboard.

Copy Text

When you copy text or graphics, the original selection remains
untouched, but a copy of the selection is automatically placed in the
Clipboard. Select some text or graphics and do one of the following:

w= Choose Edit>Copy.

mmp  Press 38+C.

Clipboard erases what was there. In other words,
the Clipboard holds only the latest material you cut
or copied.

@ Cutting or copying a new selection into the

Paste from the Clipboard

After you have something copied to your Clipboard — no matter
whether you made a Cut or a Copy — you can now paste it where you
want. You can repeat a paste operation as often as you like because the
contents of the Clipboard aren’t cleared as soon as you paste some-
thing. Having said that, though, remember that because the Clipboard
holds the contents of only your last Copy or Cut operation, you must
paste that content before you cut or copy again or you will lose that
content from the Clipboard.
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To paste the Clipboard contents, click the insertion cursor at the loca-
tion you want and then do one of the following:

w= Choose Edit>Paste.

wmmp  Press 38+V.

Format Text with Panache

If you feel that some (or all) of the text in your Pages document needs
a facelift, you can format that text any way you like. Formatting lets
you change the color, font family, character size, and attributes as nec-
essary. And unlike using a typewriter, where you have to decide ahead
of time what you want to bold or italicize, you can format your text
after you write it.

and drag the cursor over the text you want to select
and then release the mouse when you're done. To
select all text in a document — say, you want to
change the font from something boring to something
jazzy for an invitation — press 3#8+A.

@ First, of course, you must select some text. Just click

You can apply basic formatting in two ways:

w= [Ise the Format bar. The Format bar appears directly
underneath the Pages toolbar, as shown in Figure
8-4. Click one of the rectangular buttons to display a
pop-up menu, and then click your choice. For exam-
ple, click the Font Family button, and you can
change the font family from Arial to a more daring
font. You can also select characteristics, such as the
font’s background color (perfect for “highlighting”
items) or choose italicizing or bolding. The Format
bar also provides buttons for font alignment (Align
Left, Center, Align Right, and Justify).
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Format bar Format menu
® Pages File Edit InsertArrange View WindowY Share Help [ 4) Fri 2:25 AM Mark Chambers Q
80 O_ Font > _"“Show Fonts ®T =
E. = | Text > Bold %E @ = 0 A
View Outline 8 Table » Italic ®l Inspector Media Colors Fonts
Q] | E; Chart »  Underline #U “
™ L., . . ©. .= Shape > Str\klethrough
Text Box »  Outline
Image > Bigger #®+
Smaller =
Copy Paragraph Style #C Tracking >
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Sinceraly yours,

Mark Chambers

125% 5 | 283 of 315 Words Page 1 of 1 v

Figure 8-4

w= [Ise the Format menu. Most controls on the Format
bar are also available from the Format menu. Click
Format and hover the mouse cursor over the Font
menu item, and you can then apply bolding, italiciz-
ing, and underlining to the selected text. You can
also make the text bigger (great for headlines) or
smaller (for a caption). To change the alignment
from the Format menu, click Format and hover the
mouse cursor over the Text menu item.

Insert Tables

In the world of word processing, a table is a grid that holds text or
graphics for easy comparison — for example, comparing features and
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prices between similar products in a brochure, or creating a simple
travel itinerary with dates, times, and events. You can create a spiffy-
looking table layout within Pages with a few simple mouse clicks.

Follow these steps:

1. Click the insertion cursor at the location where you want
the table to appear.

= 2. Click the Table button on the Pages toolbar. Pages inserts

Table

160

a simple table and displays the Table Inspector dialog off
to the side. (Both are visible in Figure 8-5.)
Click to create a table. Table Inspector
eo0o Untitled s
B. B @, [0 E. B ual, [ ] @ = Q A
View Qutline Sections TextBox Shapes Table Charts Comment Share Inspector Media Colors Fonts
Q-] | [am ] (Reguar_ :J[s|-] | el
T P T I LA L, B
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- DEE TP mdee
T ‘
:MusChdmluEIE II - Format |
| Teannology Author
ekt | Body Rows Body Columns
s T |
oo | B
;g:‘lgggl‘g;;“;i' Headers & Footer |
Desr M. Frankiin, Edit Rows & Columns | & -
Here's the pricing table you requested for transcription of your historic document Column Width  Row Height
Price per Word Automatically resize to fit content
Cell Borders
Cell Background
Sincerely yours,
Mark Chambers
ternating Row Color
Table Options
Return key moves to next cell
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Figure 8-5

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 8: Creating Documents with Pages

By default, Pages creates a table with four rows and
three columns, but you can easily change this. In the
Table Inspector dialog, just click in the Body Rows or
Body Columns box and type the number you want
instead.

3. Click within a cell on the table to enter its text. The table
cell automatically resizes and “wraps” the text you enter
to fit.

You can paste material from the Clipboard into a
table. See the earlier section for details on pasting.

4. To change the borders of a cell, click the cell to select it
and then click one of the Cell Border buttons in the
Table Inspector dialog to change the border.

Select multiple cells in a table by holding down Shift
while you click.

5. To add a background color (or even fill cells with an
image for a background), click the Cell Background pop-
up menu in the Table Inspector dialog and choose a type
of background.

6. To return to editing text, simply click within the docu-
ment anywhere outside the table.

Add Photos

5e

Media

When you want to add a picture to your document, you can choose
from two methods: as a floating object, where you can place the image
in a particular spot and it doesn’t move, even if you make changes to
the text; or as an inline object, which flows with the surrounding text
as you make layout changes.

w= Add a floating object. Drag an image file from a
Finder window and place it at the spot you want
within your document. Alternatively, you can click

www.it-ebooks.info
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the Media button on the toolbar and click Photos,
which takes you to the Media Browser, which displays
images from iPhoto, as well as other locations on
your Mac. There, navigate to where the file is saved,
and then drag the image thumbnail to the spot you
want in the document. Figure 8-6 illustrates the
Media Browser in action.

Drag a photo from the Media Browser...

..to your document.
a0 0 Untitled 800 Media L
== = e f W
E‘v ‘_él niv H E nmﬂ - D | Audio Photos Movies | A
View Outline ections TextBox Shapes Tahle] Charts Comment Share lonts.
Faces
OEI- [Anal i] [Regutar 3] [0 [o JI:I[:I Th j[m :
» DPlaces
L] | = T A | LA ‘7 L B |[E|rocky Forever!
€ Last Import
- _ [JLast 12 Months
\I PIFlagged
ers
| FWKG"M:D nor | [ Cats and More Cats
l t: 125-466-7890 | ark Chambers.
| £ 125-466-7851 -
| December 12, 2011
' o 125-456-7802 * Buman‘un Franklin
Founding Father
Philadelphia, PA
Dear Mr. Franklin,

Duplessis, Banja
Here's the ||rst w:rswon of the portrait, sat for last month! you requested for transcription of

| think you'll agree that the results are splendid!

Sinceraly yours,

Mark Chambers

125% ¢ | 61Words Page 1 of 1 v &~ a

Figure 8-6

1 item

You can send a floating object (such as a shape or an
image) to the background, where text doesn’t wrap
around it. To bring back a background object as a
regular floating object, click the object to select it and
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choose Arrange=>Bring Background Objects to Front.
(I tell you more about background objects later in
this chapter.)

w= Add an inline object. Hold down the Command
(38) key while you drag an image file from a Finder
window and place it where you want within your
document. You can also click the Media button and
click Photos to display the Media Browser. Navigate
to the location where the file is saved, hold down
the 3 key, and drag the image thumbnail to the spot
you want in the document.

To move an image, click it to select it, and then drag it to the new
location within your document.

Resize an Image

Okay, you add an image to your Pages document, but it's way too
small or too big. Easily fixed, though, because you can resize it at any
time to correct the problem. To resize an image object, follow these
steps:

Click the image to select it.

Drag one of the selection handles (the tiny blue squares)
that appear along the border of the image. There are two
kinds of these handles. The side-selection handles drag only
that edge of the frame, and the corner-selection handles
resize both adjoining edges of the selection frame. Figure
8-7 shows an image that I'm resizing in a document.

Hold down the Shift key while you drag, and Pages
preserves the aspect ratio of the image so that the ver-
tical and horizontal proportions remain fixed.

@ You can also flip images. Click Arrange on the Pages

menu bar to flip the image horizontally or vertically.
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Add a Shape to the Document Background
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| o 125-456-7882 *
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J U=
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» [ Mark Chambers
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=

o — -] | omenio0: ] Ostadem ) atacton | s s
[

Ml L .

o
De-
cembgi 2 2011
Page 1 o |

Corner selection handle
Figure 8-7

Side selection handles

Need to add a shape as a visual border to your newsletter page? Or
perhaps as a background for a customer’s quote in your brochure? To
add a shape, such as a rectangle or circle, to your document, follow

these steps:

1. Click the insertion cursor in the location for the shape.

2. Click the Shapes button on the Pages toolbar and choose
& a shape. The shape appears in your document. If you add
a shape to an area with text (or drag it into a text area),
the text automatically “flows” around the shape. (More

Shapes
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about how to change this in just a sentence or two.) With
the shape selected — the handles appear around it —
you can click in the Format Bar and choose the fill color.

If needed, you can resize or move the shape:

w= Move: Click the center of the shape and drag it to a
new spot.

w= Resize: See the steps earlier for resizing an image.

With your shape in place, you can now add text atop it (rather than
allow the text to flow around it). Just select it, choose Arrange=>Send
Object to Background, and start typing.

Check Vour Spelling

Pages can check spelling while you type (the default setting) or check
it after you complete your document. If you find automatic spell
checking distracting, you should definitely pick the latter method.

To check spelling as you type, follow these steps:

1. Click Edit in the Pages menu bar and hover the mouse
cursor over the Spelling menu item.

2. Click Check Spelling as You Type.

3. If a possible misspelling is found, Pages underlines the
word with a red dashed line. You can right-click the word
to choose a possible correct spelling from the list, or you
can ignore the word if it's spelled correctly.

Spelling as You Type menu item again to disable it.

@ To turn off automatic spell checking, click the Check
The check mark next to the menu item disappears.
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166

To check spelling manually, follow these steps:

1. Click within the document to place the text insertion cur-
sor where the spell check should begin.

2. Click Edit and hover the mouse cursor over the Spelling
menu item, and then choose Check Spelling.

3. Right-click any possible misspellings and choose the cor-
rect spelling, or choose Ignore Spelling if the word is
spelled correctly (see Figure 8-8).

: 123
+ 135-4567802 | December 12, 2011
j o 184S " * Benjamin Franklin

\/i o »—"E Founding Father
g Philadelphia, PA
-4
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Never Hyphenate

Mark (hambers

Cut

Copy

Paste
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Font
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Figure 8-8
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Find and Replace Text

If you're working with an existing document, why scan through several
pages looking for a specific word or phrase when you can use the Find
command? Pages can locate a word or phrase and show you every
occurrence within your document.

To find (and optionally replace) a target word or phrase, follow these
steps:

1. Click Edit in the Pages menu bar and hover the mouse
cursor over the Find menu item.

2. Click Find.

3. When the Find & Replace dialog appears, type the word
or phrase you want to locate in the Find text box.

Pages will search for an exact match, so type only the
exact word or phrase you want.

4. Click Next to search your document.

5. (Optional) If you want to replace the word or phrase
with another word or phrase, click in the Replace box
and type the replacement word or phrase. Then click
Replace (to replace only the first occurrence) or Replace
All (to replace every occurrence of the word or phrase).

Print Documents

Ready to start the presses? You can print your Pages document on real
paper, of course, but don't forget that you can also save a tree by creat-
ing an electronic PDF-format document rather than a printout.

you how to create a PDF in Chapter 6. PDF docu-

@ A PDF file is sort of an electronic printout. I show
ments can be easily displayed within Lion, or your
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readers can use the free Acrobat Reader from Adobe
(http://get.adobe.com/reader) to view your
work.

To print your Pages document on old-fashioned paper, follow these
steps:

1. Within Pages, click File and choose Print. Pages displays
the Print sheet you see in Figure 8-9.

Change the page range and number of copies you want to print.

Printer: | HP LaserJet M1522nf MFP

Presets: | Default Settings

Copies: |1
Pages: (=) All

(From: |1 to: |1

[ Layout )

Pages per Sheet: \_1_ =

Layout Direction: 5

Border: | None
Two-Sided: | Off

lofl [N Reverse page orientation
Flip horizontally

(2) [ POF ~ Hide Details Cancel | Print |

Click Print.

Figure 8-9

2. Click in the Copies field and enter the number of copies
you need.

3. Select the pages to print.
e To print the entire document, select All.

e To print a range of selected pages, select the From radio
button and then enter the starting and ending pages.
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4. Click the Print button to send the document to your
printer.

Save Vour Work

To save a Pages document after you finish it (or to take a break while
designing), follow these steps within Pages:

1. If you're saving a document that hasn’t yet been saved,
press 88+S, or choose Filer>Save from the Pages menu
bar. The Save sheet you see in Figure 8-10 appears.

Type a filename.

Save As: A Letter to!en Franklin v
Where: | [ ] Pages Documents < < ChOOSG qa |OCGHOI’].
Cancel | | Save |
Figure 8-10

2. Type a filename for your new document.

3. Choose a location to save the document. By default,
Pages saves your document to the Documents folder.

4. Click Save.

Mac remembers your document'’s filename and loca-
tion. If you make additional changes to a document
after you save it, simply press 88+S again to save an
updated version of the document with your changes.
You're done!

@ After you fill out the Save sheet and click Save, your
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Close a Document

When you're done with a document, there are a number of ways to
close that document (and either open another document or quit the
application entirely). Simply do one of the following:

w= Choose Filec>Close. Pages stays running, and the
Pages menu bar is still visible.

w= Press 88+W, which is the same as using the Close
menu command.

w= Click the red Close button on the Pages toolbar.
Again, Pages stays running, so you can open another
document.

w= Choose Files>Quit. Pages closes the current docu-
ment and quits.

w= Press 38+Q, which is the same as the Quit menu
command.
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Working with
Numbers and
Finances

Oh, heavens, it’s a spreadsheet! That imme-
diately means that it's complex, right?
Actually, Numbers is the easiest spreadsheet
program I've ever used for such tasks as arrang-
ing numbers, forecasting important numeric
trends, and taking care of a household budget.
And, unlike the Microsoft Office spreadsheet
application (Excel) — which many folks find
just too doggone powerful and confusing —
Numbers is specifically designed with the
home Mac owner in mind.

In this chapter, I provide you with the explana-
tions and procedures you need in order to
begin using Numbers. You see how to

w= Create, open, and save new Numbers
spreadsheets.

w= FEnter and edit data in a cell.

w= Format cells.

w= Add and remove rows and columns.
m= Create simple calculations.

w= [nsert charts into your document.

w= Safely bank and invest online.
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Understand Spreadsheets

A spreadsheet simply organizes and calculates numbers by using a grid
system of rows and columns. The intersection of each row and column
is a cell, and cells can hold either text or numeric values (along with
calculations that are usually linked to the contents of other, surround-
ing cells).

Spreadsheets are wonderful tools for making decisions and compari-
sons because they let you “plug in” different numbers — like interest
rates or your monthly insurance premium — and instantly see the

results. Some of my favorite spreadsheets that I use regularly include

w= Car and mortgage loan comparisons
m= A college planner

w= My household budget (not that we pay any attention
to it, but it makes me feel better)

Numbers is part of iWorks, which you have to buy
separately from the Apple App Store.

Create a New Spreadsheet

To create a new spreadsheet within Numbers, follow these steps:

i 1. Click the Launchpad icon on the Dock.

2. Click the Numbers icon. Numbers displays the template
T/ dialog you see in Figure 9-1.

NNNNNNN

3. Click the type of document you want to create from the
list to the left. The document thumbnails on the right are
updated with templates that match your choice.
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Select a document type. Select a template.

800 Template Chooser

Education

Savings Calculator

School Savings Retirement Savings Mortgage Loan Comparison

[ Open Recent VJ [ Open an Existing File... ] @ e ] Cancel J [ Choose

Figure 9-1

first time: A glance at the supplied templates proves
that Apple has targeted the home Mac owner. For
example, after making a few modifications, you can
easily use the Budget, Loan Comparison, and
Mortgage templates to create your own spreadsheets.

@ I was pleasantly surprised when I ran Numbers the

4. Click the template that most closely matches your needs.
(You can also choose the Blank thumbnail to start a
Numbers spreadsheet from scratch.)

5. Click the Choose button to open a new document, using
the template you selected.
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Open an Existing Spreadsheet

If a Numbers document appears in a Finder window, double-click the
document icon, and Numbers automatically loads and displays the
spreadsheet.

To open a Numbers document from within the program, follow
these steps:

' 1. From within Launchpad, click the Numbers icon to run
T‘/ the program.

NNNNNNN

2. Press 38+0 to display the Open dialog, as shown in
Figure 9-2.

like in a Finder window. (Chapter 3 discusses each of
the Finder View modes.) In Figure 9-2, I'm using
Icon view mode.

@ You can toggle View mode in the Open dialog, just

3. Click to select a drive from the Devices list on the left
side of the dialog, and then click (or double-click,
depending on the View mode you're using) folders and
subfolders until you locate a Numbers document.
Double-click the spreadsheet to load it.

past few days, choose File>Open Recent to display

@ To open a spreadsheet you've been working on the
Numbers documents that you worked on recently.

the left side of the Open dialog. For example, click
All My Files to view all the documents you've created
on your Mac, or click the Documents icon in the list
to jump directly to your Documents folder.

@ You can also select other locations from the list on
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Find the folder where your spreadsheet is stored.

Double-lick the file you want to open.

800 [ Examples

(<> ] = m | mi |:—v|¢ (B]le ][ e][#r]

Y

FAVORITES

= All My Files

|| Deskto

T P My So-Called Budget for
{2 mark 2012

i Applications

| Documents
¥ Utilities.

|| Games

— SHARED

| acerserver
= blackdragon
DEVICES
o Ludwig

. Antonio

»

= Time Machine...
. Johann

. Windows XP

Figure 9-2

Navigate and Select Cells in a Spreadsheet

Before you can enter data into a cell, you need to know how to reach
the cell where you want to enter the data. You can use the scroll bars
to move around in your spreadsheet, but when you enter data into
cells, moving your fingers from the keyboard is a hassle. For this rea-
son, Numbers has a number of movement shortcut keys that you can
use to navigate, and I list them in Table 9-1. After you commit these
keys to memory, your productivity shoots straight to the top.
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Table 9-1 Movement Shortcut Keys in Numbers

Key or Key Combination Where the Cursor Moves

Left arrow (<) One cell to the left

Right arrow (—) One cell to the right

Up arrow (T) One cell up

Down arrow ({) One cell down

Option+Fn+« To the beginning of the active worksheet

Option+Fn+— To the end of the active worksheet

Page Down Down one screen

Page Up Up one screen

Return One cell down (also works within a selection)

Tab One cell to the right (also works within a
selection)

Shift+Enter One cell up (also works within a selection)

Shift+Tab One cell to the left (also works within a
selection)

You can use your mouse or trackpad to select cells in a spreadsheet:
w= To select a single cell, click it.

w= To select a range of multiple adjacent cells, click a
cell at any corner of the range you want and then
drag the mouse in the direction you want (see
Figure 9-3).

w= To select a number of nonadjacent cells, hold down
the Command (38) key while you click each cell.

w= To select a column of cells, click the alphabetic head-
ing button at the top of the column.

w= To select a row of cells, click the numeric heading
button on the far left side of the row.
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1
2
3
4
5
B Jan 1, 2009 Feb 1, 2009
l Total for 200.15 346.21
Month
8 My Share 459 65.87
g

A
|

A selected range of cells

Figure 9-3

Enter and Edit Data in a Spreadsheet

After you navigate to the cell in which you want to enter data, you're
ready to enter data. The following steps walk you through the key
tasks:

1. Either click the cell or press the spacebar. A cursor
appears, indicating that the cell is ready to hold any data

you type.

2. Type your data. Spreadsheets can use both numbers and
text within a cell — either type of information is consid-
ered data in the Spreadsheet World. You can see data
being entered in Figure 9-4.

document (using 38+C) and paste that data into the

@ Don’t forget that you can copy data from another
cell (using 38+V).

Feb 1, 2009
346.21| 274.03

65.87

Figure 9-4
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3. To correct or edit data, click within the cell that contains
the data to select it, and then click the cell again to dis-
play the insertion cursor. Drag the insertion cursor across
the characters to highlight them and then type the
replacement data.

Numbers automatically replaces the existing charac-
ters with those you type.

4. To simply delete text, highlight the characters and then
press Delete.

5. When you're ready to move on, press Return (to save the
data and move one cell down) or press Tab (to save
the data and move one cell to the right).

Choose a Number Format

After your data has been entered into a cell, row, or column, you
might need to format it. Number formatting determines how a cell dis-
plays a number, such as a dollar amount, a percentage, or a date.
Characters and formatting rules, such as decimal places, commas, and
dollar and percentage notation, are included in number formatting.
So, if your spreadsheet contains units of currency, such as dollars, for-
mat it that way. Then all you need to do is type the numbers, and the
currency formatting is applied automatically.

Numbers gives you a healthy selection of formatting possibilities. To
specify a number format, follow these steps:

1. Select the cells, rows, or columns you want to format.
(See “Navigate and Select Cells in a Spreadsheet,” earlier
in this chapter, for tips.)

() | 2. Click the Inspector toolbar button at the right end of the
W Numbers toolbar.

3. Click the Cell Inspector button in the Inspector window
to display the settings you see in Figure 9-5.
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Change the Cell Text Alignment

@& 2. Click the Inspector toolbar button.

Inspector

4. Click the Cell Format pop-up menu and click the type of
formatting you want to apply.

5. Click the Close button in the Inspector window to return

to your spreadsheet.

Cell Format pop-up menu

Cell Inspector button

Chapter 9: Working with Numbers and Finances

B aR&]

Cells

Cell Format

E‘ Thousands Separator
[ Accounting Style

["] Conditional Format

0 rules applied f Show rules...

ET Wrap Text in Cell

| Currency T‘{(—
Symbol [ US Dollar (5} =+
Decimals 0 |2 [ -100 B

Figure 9-5

You can also change the alignment of text in the selected cells. (The
default alignment for text is flush left.) Follow these steps:

1. Select the cells, rows, or columns you want to format.
(See the task “Navigate and Select Cells in a Spreadsheet,”
earlier in this chapter, for tips.)
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3. Click the Text Inspector button in the Inspector window
to display the settings you see in Figure 9-6.

Color and alignment buttons
Text Inspector button

=y

O 8 )l B 0 1 @1 B

[ Text Columns Bullets |

Color & Alignment

(| (EE==%) MLl
Spacing
Character )
¢/ 38
Line -
al
Ly 1)l
Before Paragraph w )
al
Q 0pt -
After Paragraph -
Q 0 pt r?
Inset Margin -
© 2 pt r;
Figure 9-6

4. Click the corresponding alignment button to choose the
type of formatting you want to apply. (You can choose
from left, right, center, justified, and text left and num-
bers right.) Text can also be aligned at the top, center, or
bottom of a cell.

5. Click the Close button in the Inspector window to return
to your spreadsheet.
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Change Character Formatting

You might need to set apart the contents of some cells. For example,
you might need to create text headings for some columns and rows or
to highlight the totals in a spreadsheet. Follow these steps to change
the formatting of the data displayed within selected cells:

1. Select the cells, rows, or columns you want to format.
(See “Navigate and Select Cells in a Spreadsheet,” earlier
in this chapter, for tips.)

2. Click the Font Family, Font Size, or Font Color buttons
on the Format bar, as shown in Figure 9-7.

800 | My So-Called Budget for 2012 el

R s e e T al, M B, [ 5] @ Q@ A

v
View Sheet Tables Reorganize Function Formula List Charts TextBox Shapes Commen Share Inspector Media Colors Fonts

(ebetica heve 2] Regur2][10 -] (B | (=== = Il (gl = =) O weap | (za [ [l v Lo ] [sona ]| (] Cin 2] _--iI:IIHH:E\..ﬂ(—l

Format bar

Figure 9-7

Format with Shading

Shading the contents of a cell, row, or column is helpful when your
spreadsheet contains subtotals or logical divisions. Follow these steps
to shade cells, rows, or columns:

1. Select the cells, rows, or columns you want to format.
(See the task “Navigate and Select Cells in a Spreadsheet,”
earlier in this chapter, for tips.)

@ 2. Click the Inspector toolbar button.

Inspectar

3. Click the Graphic Inspector button within the Inspector
window to display the settings you see in Figure 9-8.
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Select a shading option.
Graphic Inspector button

06060 Graphic

OB E T e
Select a color. Fill

[ Gradient Fill 4+

8006 Colors EIEI —
el | = ~O =
Q

Stroke

J

| Line +]
=

(—F) — 1o

Endpoints:
7] shadow
Angle:
Offset Blur Opacity
Reflection >
Opacity p—
: 100 | %
é‘ - . Opacity .
© | 100% ;)
Figure 9-8

4. Click the Fill pop-up menu to select a shading option.

5. Click the color box to select a color for your shading.
Numbers displays a color picker dialog.

6. Click to select a color.

7. After you achieve the right effect, click the Close button
in the color picker dialog.

8. Click the Close button in the Inspector window to return
to your spreadsheet.
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Insert and Delete Rows and Columns

What's that? You forgot to add a row and now you're three pages into
your data entry? No problem. You can easily add or delete rows and
columns. Really — you can! First select the row or column that you
want to delete or that you want to insert a row or column next to, and
then do one of the following:

w= For a row: Right-click and choose Add Row Above,
Add Row Below, or Delete Row from the pop-up
menu that appears.

m= For a column: Right-click and choose Add Columns
Before, Add Columns After, or Delete Column from
the pop-up menu that appears.

menu. After you select the row or column, then click
Table and choose any one of the menu items: Add
Rows, Add Columns, Delete Rows, or Delete Columns.
(Personally, I like to right-click.)

@ You can also take care of this business from the Table

Add Simple Calculations

It’s time to talk about formulas. These equations calculate values based
on the contents of cells you specify in your spreadsheet. For example,
if you designate cell A1 (the cell in column A at row 1) to hold your
yearly salary and cell B1 to hold the number 12, you can divide the
contents of cell A1 by cell B1 (to calculate your monthly salary) by
typing this formula into any other cell:

=A1/B1
By the way, formulas in Numbers always start with an equal sign (=).

So why not just use a calculator? Sure, but maybe you want to calcu-
late your weekly salary. Rather than grab a pencil and paper, you can
simply change the contents of cell B1 to 52, and — boom! — the
spreadsheet is updated to display your weekly salary.
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That's a simple example, of course, but it demonstrates the basis of
using formulas (and the reason that spreadsheets are often used to
predict trends and forecast budgets).

To add a simple formula within your spreadsheet, follow these steps:

1. Select the cell that will hold the result of your
calculation.

2. Click inside the Formula bar and type = (an equal sign).
The Formula bar appears to the right of the Sheets head-
ing, directly under the Button bar.

3. Click the Function Browser button, which bears the fx
label. (It appears next to the Cancel button on the
Formula bar.) See Figure 9-9.

Function Browser button
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Figure 9-9

4. In the Functions dialog that appears, as shown in
Figure 9-10, select a function. This list makes it easier to
choose from the wide range of functions available within
Numbers.

5. Click the Insert Function button to add the function to
the Formula bar.
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Functions
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The ABS function returns the absolute value
of a number or duration.

| Insert Function

Figure 9-10

6. After you finish inserting functions, click the Accept but-
ton on the Formula bar to add the formula to the cell.
It's now ready to work behind the scenes, doing math for
you so that the correct numbers appear in the cell.

Insert Charts

Sometimes you just have to see something to believe it — hence
the ability to use the data you add to a spreadsheet to generate a
professional-looking chart! Follow these steps to create a chart:

1. Select the adjacent cells you want to chart by dragging
the mouse.

To choose individual cells that aren’t adjacent, you
can hold down the 3 key as you click.

2. Click the Charts button on the Numbers toolbar, which
looks like a bar graph. Numbers displays the thumbnail
menu you see in Figure 9-11.
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Click the Charts button to see your choices.
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Figure 9-11

3. Click the thumbnail for the chart type you want.
Numbers inserts the chart as an object within your
spreadsheet so that you can move the chart or resize it

just like an object in Pages.

Numbers also displays the Chart Inspector dialog, where
you can change the colors and add (or remove) the chart
title and legend. Figure 9-12 illustrates a simple chart I
added to a spreadsheet that compares monthly income
amounts, complete with the Chart Inspector. The chart
appears in the bottom-left corner of the figure (sur-
rounded by resizing handles), and the values on which
the chart is based appear selected under the Cost

heading.
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Selected cells
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Save Vour Work

Although Lion’s Auto Save feature prevents you from losing a signifi-
cant chunk of work to power failures, and such, you can always save
a Numbers document manually after you finish it (or to save it for
later). Follow these steps within the program:

1. Press 38+S. If you're saving a document that hasn’t yet
been saved, the Save sheet appears.

2. Type a filename for the new document.
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3. Choose a location to save the document from the Where
pop-up menu. (This step lets you select common loca-
tions, like your Desktop, Documents folder, or Home
folder.)

pop-up menu, you can also click the down-arrow
button next to the Save text box to display the full
Save dialog. Click to select a drive from the Devices
list on the left side of the dialog, and then click fold-
ers and subfolders until you reach the location you
want.

@ If the location you want isn't listed on the Where

4. Click Save. Your Mac remembers your settings for that
spreadsheet. If you make additional changes to the
spreadsheet, simply press 38+S and your changes are
saved as a new version of the document.
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Play Movies with DUD Player

With the arrival of the DVD movie, an honest-to-goodness theater in
the home is now within the grasp of mere mortals (who have, coinci-
dentally, merely average budgets). Mac OS X has everything you need
to enjoy a night at the movies without ever leaving home. In fact, 1
highly recommend the 27" Intel iMac or the 17" MacBook Pro for
those wide-screen classics.

To watch Frodo Baggins, Don Corleone, or James Bond,
\ f you'll use Apple’s DVD Player application, which you
launch by clicking the Launchpad icon on the Dock
(shown in the margin) and then clicking the DVD Player
icon. Or, even easier, simply insert a DVD into the disc
drive. As soon as you do, your Mac recognizes the disc and
launches DVD Player by default for you. (Time for another
round of well-deserved gloating about your choice of per-
sonal computer.)

Depending on the viewing mode you choose, DVD Player offers one
or two windows, or it occupies the entire screen:

w= Controller: The small, silver-colored gadget that
looks like a remote control and holds all the controls
for the Player. Arranged much like they are on a VCR
or tape deck, all the familiar controls are present. For
example, if you watch a lot of movies, you'll imme-
diately appreciate the ability to jump to the next or
previous chapter — DVD movies use chapters to
allow you to move immediately to certain scenes.
Check it out in Figure 10-1.

w= Viewer: View your DVD movies in this large window.

Table 10-1 details the fundamental commands present in the DVD
Player Controller. Apple software usually has some goodies hidden
beneath the surface, and DVD Player is no exception. The controls in
DVD Player have a few functions that might not be obvious to the
casual user, as listed in Column 3 of Table 10-1.
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Navigate menu items

Figure 10-1

Table 10-1

Basic DVD Controls

Control Name

What It Does

Other Functions

Play Plays the DVD Toggles to a Pause button
when a movie is playing.
Stop Stops playback of the DVD None.

Previous Chapter

Skips to the previous
chapter

Click and hold the button
to quickly skim the movie in
reverse.

Next Chapter Skips to the next chapter Click and hold the button
to quickly skim the movie
forward.

Playback Volume Adjusts the volume of the None.

DVD audio
Arrow Buttons Navigates through the menu None.
items of the DVD

Enter Selects the highlighted menu None.

item

Eject Ejects the DVD from the None.

drive

Title Jumps immediately to the None.

DVD's title menu
Menu Displays the menu of the None.

current DVYD
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Exercising your Viewer

You can think of the Viewer window as a television inside your Macintosh if it
helps, but DVD Player goes one step further. Unlike a felevision screen, the
Viewer has some nice fricks up its sleeve: For example, you can resize the
Viewer window by choosing one of the five sizes listed on the View menu (half,
actual size, double size, Fit to Screen, and full-screen). Choose a size to watch
a movie in a small window on your desktop while you work with other applico-
tions. You can toggle the Viewer size from the keyboard; for example, press
88+0 (zero) to select half-size, press 8+1 (one) to select actual size, and press
8+2 (two) to select double size.

If you're in it only for the entertainment factor, resize the Viewer to fill the
screen. | like to watch movies in Full Screen mode, which you can toggle by
pressing $8+F. To take full advantage of all your screen space yet leave the
Viewer window onscreen for occasional resizing, press 8+3 (three) to choose
Fit fo Screen mode.

Upload Photos from Your Digital Camera

192

iPhoto makes it easy to download images directly from your digital
camera — as long as your specific camera model is supported in
iPhoto, that is. Most cameras are supported, though, and more are
added to the supported crowd during every update.
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Follow these steps to import images:

1. Connect your digital camera to your Mac, and then turn
on the camera.

Plug one end of a USB cable into your camera and the
other end into your Mac’s USB port and prepare your
camera to download images.

2. Launch iPhoto.

Your Mac will probably launch iPhoto automatically
™ when your camera is detected, but you can always launch
L O ,

iPhoto manually by clicking its icon on the Dock (or by
clicking the iPhoto icon in Launchpad). iPhoto displays
the Import sheet.

3. Type an event name for the imported photos into the
Add Event Name box, such as Troy’s Birthday Party 2012
or Godzilla Ravages Tokyo. (A general descriptive name
that fits all the photos in the event is best.)

4. To allow iPhoto to automatically separate images into
separate events based on the date they were taken, select
the Split Events check box.

5. Click the Import All button to import your photographs
from the camera.

and click each photo you want, and then click

@ To select specific images to import, hold down 38
Import Selected rather than Import All.

The images are added to your Photo Library, where you
can organize them into individual albums or events.
(More on albums and events later.) Depending on the
camera, iPhoto may also import video clips.
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Importing images from your hard drive

If you have a folder of images that you collected already on your hard drive,
a CD, a DVD, an external drive, or a USB Flash drive, adding them to your
library is easy. Just drag the folder from a Finder window and drop it into the
source list in the iPhoto window. iPhoto automatically creates a new album
using the folder name, and you can sit back while the images are imported into
that new album. iPhoto recognizes images in several formats: GIF, JPEG, PSD,

PICT, PNG, RAW, and TIFF.

If you have individual images, you can drag them as well. Select the images in
a Finder window and drag them into an album in the source list. To add them
to the album that's displayed in the Viewer, drag the selected photos and drop
them in the Viewer instead.

If you'd rather import images by using a standard Mac Open dialog, choose
Filecolmport to Library. Simplicity strikes again!

6. Specify whether the images you're importing should be
deleted from the camera afterward.

If you don't expect to download these images again to
another computer or another device, you can choose to
delete the photos from your camera automatically. This
way, you save a step and help eliminate the guilt that can
crop up when you nix your pix. (Sorry, I couldn't resist.)
However, if you'd rather be absolutely certain that every-
thing has been imported safely, just delete the images
from your camera manually.

You're probably familiar with albums, which you may recognize from
older versions of iPhoto. An album is simply a container you create in
iPhoto that contains specific photos — it’s straightforward. Typical
albums might include family pets or photos of your hometown.
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Events, on the other hand, help you organize photos by date. After you
download the contents of your digital camera, those contents count as
a virtual event in iPhoto, based on either the date you imported them
or the dates they were taken. For example, you can always display the
last images you imported by clicking Last Import. If you want to see
photos from your son’s graduation, they appear as a separate event.
(Both these organizational tools appear in the source list). Think
about that: Arranging old-fashioned film prints by the moments they
document is tough, but iPhoto makes it easy for you to see just which
photos are part of the same group!

Display a Digital Image in iPhoto

Say goodbye to the old shoebox full of slides and prints! Browsing
your iPhoto library is as simple as clicking these items:

w= A specific event or album in the source list, as
shown in Figure 10-2: You can also click the Events
item to see a thumbnail display of all events in your
library.

w= The Photos item in the source list: This method
displays all photos as a single scrolling collection.

Drag the scroll button in the scroll bar to move up or down, or click a
specific photo and use the arrow keys to navigate your collection. After
you locate the image you want to see, you can double-click it to dis-
play the photo within the iPhoto window.

To view the photo full-screen, click it to select it and then click the
Full-Screen button at the top-right corner of the window (which bears
two arrows pointing outward) or press 8+Control+F. You can leave
Full Screen mode at any time by pressing Esc.
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Figure 10-2

While in Full Screen mode, move the mouse cursor
to the top edge of the screen to display the iPhoto
menu bar (see Figure 10-3), allowing you to choose
menu commands without exiting.
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iPhoto menu bar To exit Full Screen mode, click this button.
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Figure 10-3

Tag Your Photos with Keywords

“Okay, Mark, iPhoto albums and events are great ideas, but do you
really expect me to look through 20 albums just to locate pictures with
specific people or places?” Never fear, good Mac owner. You can also
assign descriptive keywords to images to help you organize your collec-
tion and locate certain pictures fast. iPhoto comes with a number of
standard keywords, and you can create your own as well.

To illustrate, suppose that you want to identify your images according
to special events in your family. Birthday photos should have their
own keywords, and anniversaries deserve another. By assigning key-
words, you can search for Elsie’s sixth birthday or your silver wedding
anniversary (no matter which event or album they’re in), and all
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related photos with those keywords appear like magic! (Well, almost
like magic. You need to choose Viewr>Keywords, which toggles the
Keyword display on and off in the Viewer.)

iPhoto includes a number of keywords that are already available:
w= Birthday

w=  Checkmark

w=  Family

w= Favorite

= Movie

wep  Kids

w= Photo Booth

w= Photo Stream

m= Vacation

I RAW

mark icon in the lower-right corner of the image. The
Checkmark keyword comes in handy for temporarily

identifying specific images because you can search for
just the check-marked photos. Say that you're search-

ing for 12 great shots for a custom calendar. You can

Checkmark those temporarily to mark them, and

then you can remove the checkmark after the calen-
dar is finished.

@ Adding the Checkmark keyword displays a tiny check

To assign keywords to images (or remove keywords that have already
been assigned), select one or more photos in the Viewer. Choose
Window=>Manage My Keywords or press 3+K to display the Keywords
window, as shown in Figure 10-4.
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You’re gonna need your own keywords

| would bet that you take photos of subjects other than just kids and vacations,
and that's why iPhoto lets you create your own keywords. Display the iPhoto
Keywords window by pressing 8+K, click the Edit Keywords button, and then
click Add (the button with the plus sign). iPhoto adds a new, unnamed keyword
to the list as an edit box, ready for you to type its name.

You can rename an existing keyword from the same window, too. Click a key-
word to select it and then click Rename. Remember, however, that renaming a
keyword affects all images tagged with that keyword, even if the new keyword
no longer applies to the photos. That might be confusing when, for example,
photos originally tagged as Family suddenly appear with the keyword
Foodstuffs because you renamed the keyword. (I recommend applying a new
keyword and deleting the old one if this problem crops up.)

To change the keyboard shortcut assigned to a keyword, click the Shortcut but-
ton. To remove an existing keyword from the list, click the keyword to select it
and then click the Delete button, which bears a minus sign.

Click a button to assign a keyword.

Keyyords

ILR LU

Drag Keywords here to place fhem in your guick-pick list
and automatically assign theg a keyboard shortcut.

(] Birthday Family Favorite
Kids Movie Photo Booth RAW

Vacation

(" Edit Keywords )

Figure 10-4
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Click the keyword buttons that you want to attach to the selected
images to mark them. Or, click the highlighted keyword buttons that
you want to remove from the selected images to disable them. You can
assign as many keywords to a photo as you like.

To sift through your entire collection of images by using keywords,
click the Search button in the toolbar, and then click the magnifying
glass button next to the Search box and choose Keyword from the
pop-up menu. iPhoto displays a pop-up Keywords panel, and you can
click one or more keyword buttons to display just the photos that
carry those keywords.

must have all the keywords you specified. If an image
is identified, for example, by only three of four key-
words you chose, it isn't a match, and it doesn’t
appear in the Viewer.

@ The images that remain in the Viewer after a search

Organize Photos in Albums

200

The basic organizational tool in iPhoto is the album. Each album can
represent any division you like, whether it’s a year, a vacation, your
daughter, or your daughter’s ex-boyfriends. Follow these steps:

1. Create a new album by choosing FilecoNew Album (as

shown in Figure 10-5) or pressing 8+N.

The New Album sheet appears.

2. Type the name for your new photo album.

3. Press Return. The new album appears under the Albums

heading in the source pane. You can drag images from
the Viewer into any album you choose. For example, you
can copy an image to another album by dragging it from
the Viewer to an album in the source list.
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Figure 10-5

To remove a photo that has fallen out of favor, follow these steps:
1. In the source list, select an album.

2. In the Viewer, click to select the photo you want to
remove.

3. Press Delete.

When you remove a photo from an album, you don’t remove the
photo from your collection (represented by the Photos entry under the
Library heading in the source list). That's because an album is just a
group of links to the images in your collection. To completely remove
the offending photo, click the Photos entry under the Library heading
to display your entire collection of images and delete the picture there.
(Naturally, this also removes the photo from any albums that might

have contained it as well.) 201
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To remove an entire album from the source list, just click to select it in
the source list — in the Viewer, you can see the images it contains —
and then press Delete.

To rename an album, click to select the entry under the Albums head-
ing in the source list, and then click again to display a text box. Type
the new album name and then press Return.

Put Events to Work

As I mention earlier in this chapter, an event is essentially a group of
images that you shot or downloaded at the same time. iPhoto figures
that those images belong together (which is usually a safe assumption).

different procedure. Click the Events entry under the
Library heading in the source list to display your
Events in the Viewer, and then click the existing event
name in the caption underneath the thumbnail. A
text box appears, where you can type a new name;
click Return to update the event.

@ Like an album, an event can be renamed, just using a

Try moving the mouse cursor over an event thumbnail in the Viewer,
and you see that iPhoto displays the date range when the images were
taken as well as the total number of images in the event. Ah, but
things get really cool when you move the mouse cursor back and forth
over an event with many images: The thumbnail animates and dis-
plays all images in the event. (Why can’t I think of this stuff? This is
the future, dear readers.)

To display the contents of an event in the Viewer, just double-click the
event thumbnail. To return to the Events thumbnails, click the All
Events button at the top of the Viewer.

While you're organizing, you can create a brand-new,
empty event by choosing Events>Create Event. Feel
free to drag photos from albums, other events, or
your Photo library into your new event. Note, how-
ever, that a photo can appear in only one event, so if
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you drag a photo from one event to another, it’s
automatically removed from the original event.

Create a Slide Show

You can use iPhoto to create slide shows! Click the album or event

you want to display in the source list, click the Create button, and then
choose Slideshow. Notice that iPhoto adds a Slideshows item in the
Source list. A scrolling thumbnail strip appears at the top of the Viewer,
displaying the images in the album or event. Click and drag the thumb-
nails so that they appear in the desired order (see Figure 10-6).

Arrange your images in the slide show.

800 iPhoto e
LIBRARY -
. Events (180)
[= Photos (1,662)
l Faces
@ Places

RECENT

# Cardinal Game 2011
(%) Last Import (1)

= Last 12 Months

E Photo Stream
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B Printing (3)

l Trash 23
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[=] Cats and Mare Cats (12}

WEB
3 Mark Chambers
!ﬂ Mark Chambers

PROJECTS
Meadows Thanksgiving Book (0)
Western Vistas (34)
Western Vistas - Slideshow Version (34)
Neely Family Album (1)

SLIDESHOWS
.!_‘ Meadows Thanksgiving Book Slideshow (D)
|§‘ Rocky Forever! {58)
| The White Elephant 2009 (25}
2 Cardinal Game 2012 (18)

] (C— X

g

Slide show toolbar
Figure 10-6

203

www.it-ebooks.info


http://www.it-ebooks.info/

Part lll: Having Fun and Getting Things Done with Software

To choose background music for your slide show, click the Music but-
ton in the Slideshow toolbar to display Apple’s theme music, as well
as the tracks from your iTunes library. To choose a standard theme,
click the Source pop-up menu and choose Theme Music; select that
perfect song and then click Choose. To choose an iTunes playlist or
song, click the Source pop-up menu and choose a playlist, then drag
the individual songs you want to the song list at the bottom of the
sheet. (You can drag them to rearrange their order in the list as well.)
Click Choose to accept your song list.

To configure your slide show, click the Settings but-

@ ton on the Slideshow toolbar and click the All Slides
tab. You can specify the amount of time that each
slide remains on the screen as well as an optional
title. Widescreen Mac owners appreciate the
Slideshow Format pop-up menu, which lets you
choose a 16:9 widescreen display (like newer LCD
TVs) for your slide show.

When you're ready to play your slide show, click the Play button, and
iPhoto switches to Full Screen mode. You can share your completed
slide show as a movie by clicking Export in the Slideshow toolbar.

Edit Photos with Panache

The first step in any editing job is to select the image you want to fix
in the Viewer, which is the default pane in iPhoto. Then click the Edit
button on the iPhoto toolbar (as shown at the left of the toolbar in
Figure 10-2) to display the Edit pane controls at the right side of the
window, as shown in Figure 10-7. Now you're ready to fix problems,
using the tools that I discuss in the rest of this section. (If you're edit-
ing a photo that’s part of an event or album, note the spiffy scrolling
photo strip at the bottom, which lets you switch to another image in
the same grouping just by clicking.)
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Edit your photos with these buttons.
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Figur 0-7

Change orientation. If an image is in the wrong orientation and
needs to be turned to display correctly, click the Rotate button to turn
it once in a counterclockwise direction. Hold down the Option key
while you click the Rotate button to rotate in a clockwise direction.

Crop photos. Does that photo have an intruder hovering around the
edges of the subject? You can remove some of the border by cropping
an image, just as folks once did with film prints and a pair of scissors.
(We've come a long way.) With iPhoto, you can remove unwanted
portions from the edges of an image — it’s a helpful way to remove
Uncle Milton's stray head (complete with toupee) from an otherwise
perfect holiday snapshot.
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Is that Facebook and Flickr | spy?

Indeed, it is! iPhoto ‘11 provides a direct connection to both your Facebook
social networking account (at www . facebook . com) and your Flickr online
gallery account (at www . £1ickr . com), allowing you to simply select one or
more photos and send them automatically to either service! Click the Share but-
ton on the toolbar to select either type of account. (Refer to Figure 10-2.)

The first time you select photos in the Viewer (or an album or event in the source
list) and choose either option, iPhoto prompts you for permission to set up your
connection. (Of course, this will require you to enter your Facebook and Flickr
account information — hence the confirmation request.) Click Set Up and pro-
vide the data that each site requires.

After you set up your accounts, simply select your photos, albums, or events and
click the Share toolbar button, and then choose the menu item for the desired
service.

Follow these steps to crop an image:
1. Click the Crop button on the Edit toolbar.
2. Select the portion of the image that you want to keep.

In the Viewer, click and drag the handles on the square
to outline the part of the image you want. Remember
that whatever is outside this rectangle disappears after the
crop is completed.

When you drag a corner or edge of the outline, a
semi-opaque grid (familiar to amateur and profes-
sional photographers as the nine rectangles from the
Rule of Thirds) appears to help you visualize what
you're claiming. If you haven't heard of the Rule of
Thirds, don’t worry: Just try to keep the subject of
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your photos aligned at one of the grid intersections,
or running along one of the lines.

3. (Optional) Choose a preset aspect ratio.

If you want to force your cropped selection to a specific
size — such as 4 x 3 or 16 x 9 for an iDVD project —
select the Constrain check box and choose that size from
the Constrain pop-up menu.

4. Click the Done button.

Oh, and don't forget that you can use the iPhoto Undo
feature (just press 8+2) if you mess up and need to try
again.

press 38+Z several times to travel back through your
last several changes. Alternatively, you can always
return the image to its original form (before you did
any editing at all) by clicking the Revert to Original
button. To be really, really safe though, make a copy
of the original before you start cropping.

@ iPhoto features multiple Undo levels, so you can

Improve the image. If a photo looks washed out, click the Enhance
button to increase (or decrease) the color saturation and improve the
contrast. Enhance is automatic, so you don’t have to set anything, but
rest assured that you can use Undo if you're not satisfied with the
changes.

Fix red-eye. Unfortunately, today’s digital cameras can still produce
the same “zombies with red eyeballs” as traditional film cameras. Red-
eye is caused by a camera’s flash reflecting off the retinas of a subject’s
eyes, and it can occur with both humans and pets. However, iPhoto
can remove that red-eye and turn frightening zombies back into your
family and friends! Just click the Red-Eye button and then select a
demonized eyeball by clicking in the center of it. (If the Red-Eye circu-
lar cursor is too small or too large, drag the Size slider to adjust the
dimensions.) To complete the process, click the Done button.
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Add Photos to Vour E-Mail

208

If you need to send a photo or two of your new car to your relatives,
iPhoto can help you send your images by e-mail by automating the

process. The application can prepare your image and embed it auto-
matically in a new message.

To send an image through e-mail, select the image, click the Share but-
ton on the toolbar, and then click the Email menu item. The layout
shown in Figure 10-8 appears, allowing you to choose a theme for
your message that is compatible with many e-mail applications (com-
plete with a background image and matching font selection). You can
also specify the size of the images from the Photo Size pop-up menu,
which can save considerable downloading time for those recipients
who are still using a dial-up connection. To add the images as attach-
ments to the message, click the Attach Photos to Message check box to
enable it.

vider) e-mail servers don’t accept an e-mail message
larger than 1MB or 2MB, so watch that Size display at
the bottom of the window. (In fact, the encoding
necessary to send images as attachments can double
the size of each image!) If you're trying to send a
number of images and the size exceeds 5SMB, you
might have to click the Photo Size pop-up menu and
choose a smaller size (reducing the image resolution
and size of the file) to embed them all in a single
message.

@ Keep in mind that most ISP (Internet service pro-

When you're satisfied with the total file size and you're ready to create
your message, type the recipient’s e-mail address in the To field. Click
the Insert Title placeholder to enter a title for your photo message, and
click the Insert Your Message Here placeholder to type the body of
your message. When all is ready, click the Send button, and iPhoto
automatically sends the message on its way.
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Choose a theme.

iPhoto

Tn:[|

Subject: Photo from Cardinal Game 2011

From: l Mark Chambers

Journal
Insert Title

Insart your mesange horm

Cardstock

v Attach photos to message

Message Size: 2.72 MB for 1 p... Cancel Photo Size: = Optimized

Check this box to attach your photos to your e-mail.

Size your photos from this menu.

Figure 10-8
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Enjoying Music,
Video, and

Podcasts

Wnether you like classical, jazz, rock,
rhythm and blues, folk — maybe talk
programs — I can guarantee you that you won't
find a better application than iTunes to fill your
life with your music, spoken audio, and video.
iTunes — the versatile audio and video player
application comes with your Mac — helps you
manage music and other media so it’s easy to
play, easy to search, and easy to organize.

You can use iTunes on your Mac to

w= Play all sorts of digital media, including
music, audiobooks, video, TV shows,
podcasts (audio journals), and Internet
radio.

w= Record (“burn”) music to your own cus-
tom audio CDs that you can play in your
car and home stereo.

w= Transfer (“rip”) music from an audio CD
to your iTunes library.

w= Buy music and video from the iTunes
Store — everything from classic jazz to
the latest music videos.

w= Organize your music into playlists.
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Set Up Speakers

If you want to listen to music or other audio files from your Mac, you
need speakers. A typical set of computer stereo speakers will set you
back anywhere from $20 to $80, depending on their output. (I prefer
speakers that run on AC power rather than battery-operated speakers.)
If you're using a MacBook laptop or an iMac, you probably already
know that your computer has built-in speakers. However, you can add
external speakers to any Macintosh in a flash. Just make sure that you
have AC power handy — another good reason to invest in a surge sup-
pressor strip that provides more outlets.

1. Connect the speakers to the computer.

,\P e [USB: Easy. Just plug the USB cable into any open USB
port on your Mac. For more information on connect-
ing USB cables, check out Chapter 2.

ﬂ e Traditional audio jack plug: Just as easy. Connect the

digital audio cable from the speakers (shown in Figure 11-1)
to the Headphone or Line Out audio jack on your
computer.

Figure 11-1
212
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2. Plug the speakers into a wall outlet or power strip (if nec-
essary) and turn them on.

o 3. Click the System Preferences icon on the Dock. The
EE_}E System Preferences window appears.

4. Click the Sound icon in the System Preferences window,
and then click the Output tab, as shown in Figure 11-2.

Sound output list

8 0o Sound
[« » | Showal | Q

| Sound Effects

Select a device for sound output:
Name Type
Internal Speakers Built-in

Line Out Audio line-out port
Digital Qut Optical digital-out port

Soundflower (2ch)

Settings for the selected device:

Balance: L/

left right

Output volume: * { ) *))) || Mute

@Show volume in menu bar

Figure 11-2

5. Click the Line Out or the USB item in the Sound Output
list (depending on the type of speakers you have).

your speakers from the Sound pane? If one of your
speakers is significantly farther away from the com-
puter than the other, use the Balance slider to bring
that stereo separation back to normal.

@ Did you notice that you can adjust the balance of

6. Click the Close button in the upper-left corner of the

System Preferences window to close the window and save
your changes.
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Control the Volume

In iTunes, you can control the volume by clicking and dragging the

Volume slider, as shown in Figure 11-3:

w= To lower the volume, drag to the left.

w= To raise the volume, drag to the right.

Previous

Play button

Next Volume slider
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Does your speaker volume still sound low even after you raise the vol-
ume all the way? Don't forget that your Mac has a master volume con-
trol that affects all your applications. To change the master volume for
your system as a whole, click the Volume icon (looks like a speaker)
on the Finder menu bar and drag the slider up or down. Because this
setting affects all applications, if you change the volume on your sys-
tem, the volume of the selections you hear in iTunes changes as well.

and Volume Down keys, as well as a Mute key, so

@ Your Mac keyboard also has dedicated Volume Up

check whether you accidentally pressed the Mute key.
Don't forget to check the volume control on your
speakers as well!

Add Music from a CD to iTunes

3.

If your Mac has a built-in DVD drive, you can easily rip (copy) music
from an audio CD to iTunes. When you rip a song, you create a copy
of the song as a digital music file on your Mac, and songs you save in
iTunes reside in its Music Library.

. Launch iTunes by clicking its icon on the Dock.

Load an audio CD into your Mac’s DVD drive. If you
have an active Internet connection, the CD title shows up
in the iTunes source list, which is on the left side of the
iTunes window. The CD track listing appears on the right
side of the window, as shown in Figure 11-4.

Decide whether to import all the songs (tracks) on the
CD, or just pick the ones you want.

® The whole enchilada: If iTunes asks whether you want
to import the contents of the CD into the Music
Library, click Yes and skip the rest of these steps.

e Bits and pieces: However, if you disabled this
prompt by selecting the Don’t Show This Again
check box, continue with the remaining steps.
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800 iTunes ]
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Figure 11-4

4. Clear the check box of any song that you don’t want to
import from the CD. All songs on the CD have a check
box next to their titles by default. Unmarked songs aren’t
imported.

5. Click the Import CD button. iTunes displays a progress
bar showing you how many songs remain to import.
How long importing takes depends on the length of the
song and the bit rate you're using, but it shouldn’t take
any longer than two minutes per track. The songs you've
imported appear in your Music Library, and you can click
the Music item in the source list to see all your songs.
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iTunes can display your Music Library in four ways, and you select the
view from the row of four buttons at the top of the iTunes window.

From left to right (see Figure 11-5), they are

w= List view: List view displays each song as one entry.

m=  Album view: Click the second View button to dis-
play cover thumbnails grouped by album, artist,
genre, or composer.

Cover Flow shows you cover albums.

Grid
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Figure 11-5
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m=  Grid view: Click the third View button to view a grid
of thumbnails (again grouped by album, artist,
genre, and composer).

w= Cover Flow view: Click the last View button to
browse by album cover, complete with reflective
surface.

Play an Audio CD in iTunes
To play a CD, follow these steps:

1. Load the CD into your Mac. By default, iTunes launches
automatically, but you can also click the iTunes icon on
the Dock to launch it manually.

2. Click the Play button (refer to Figure 11-3).

CD player. Click the Next button to advance to the
next song, and click Previous to return to the begin-
ning of a song. To pause the music, click the Play
button, and click it again to restart the music.

@ The buttons in iTunes are just like those on a regular

Play Digital Music, Uideo, and Podcasts in iTunes

To play digital files that you added to iTunes from a CD or bought at
the iTunes Store (as explained later in this chapter), follow these steps.
Start with iTunes open.

1. In the source list on the left, click the media category you
want to play. Your choices are Music, Movies, TV Shows,
Audiobooks, and Podcasts. (If you've downloaded other
types of media from the iTunes Store — like lectures
from iTunes U, or apps for an iPhone or iPad — they’ll
appear in the source list as well. See what [ mean in
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Figure 11-4.) Clicking a category displays media that you
downloaded from the iTunes Store or otherwise added to
iTunes. Then the selections appear in the “track list” on
the right.

with photos and video, ranging over all sorts of top-
ics. Apple offers a wealth of podcasts through the
iTunes Store, and virtually all are free of charge.

@ Think of a podcast as a “spoken magazine,” complete

2. Double-click a specific item to play it, or to display indi-
vidual episodes, if you're working with TV shows or
podcasts.

You can also play an entire group of songs, which is called a playlist in
iTunes-speak. Speaking of playlists . . . .

Create and Use an iTunes Playlist

A playlist is a specific collection of grouped songs or other media,

and you can create them in iTunes. Say you love the song “White
Christmas” and have 20 different artists singing it — and you want a
comprehensive playlist of all those songs. You can make a playlist just
for that. Playlists are also useful for listening to an entire album or cre-
ating the musical background for your next party or road trip. And
when you're ready to burn your own CDs (more on that in a bit),
starting with an existing playlist is very helpful.

The best way to familiarize yourself with playlists is to create one.
Here's how, with iTunes open:

1. Choose Filec>New Playlist to begin a new, empty playlist,
cleverly named untitled playlist (for now) in the source list
on the left.

sign icon) at the bottom-left corner of the iTunes
window.

@ You can also click the Create a Playlist button (a plus
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2. Give the playlist a name. The new playlist is already high-
lighted, so go right ahead and type a new name. Then
press Return to save the name.

3. Add a track (another term for a song) from the Music
Library to your new playlist:

a. Click the Music entry in the source list (on the left).

b. Find the song you want to include from the track list on
the right, and then drag it to a playlist entry in the source
list on the left, as shown in Figure 11-6. That'’s it! The
playlist now contains your song.

4. Repeat Step 3b to add as many tracks as you like to the
playlist. You can select multiple tracks to drag by holding
down the Command (88) key while you click.

When your playlist is complete, you're ready to play your songs in
iTunes. Simply click a playlist in the source list (if it isn't already
selected) to display the songs, and then double-click the first song in
the playlist.

After you're familiar with a basic playlist, check out these playlist tips:

w= Pick tracks first. You may find it easier to first select
the songs you want for a playlist and then create a
new playlist for them automatically. Select the
desired tracks from the track list by holding down
the Command (38) key while you click, and then
choose FileroNew Playlist from Selection. This action
creates a new playlist and automatically adds any
tracks selected in the Music Library. iTunes also
attempts to name the playlist automatically for you.
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Create a Playlist button

Figure 11-6

w= Let iTunes create a playlist. Click the iTunes DJ item
at the top of the Playlist section in the source list,
and you encounter a random selection of 20 songs
taken from your iTunes Music Library — perfect for
your next party! You can change the order of the
songs in the iTunes DJ playlist, add songs from your
library, or delete songs that don't fit the scintillating
ambience of your gathering. Enjoy!

2

Rename a playlist. Click once on the playlist name

in the source list to select it, wait a second, and then
click the name again. A text box opens, allowing you
to type the new playlist name.
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m= Reorder tracks. Display the playlist and then drag
any track (click it first) to the desired order within
the track list.

w= Reuse tracks. You can add the same song to any
number of playlists because the songs in a playlist
are simply pointers to songs in your Music Library —
not to the songs themselves. Add them to, and
remove them from, any playlist at will, secure in the
knowledge that the songs remain safe in the library.

w= Delete tracks. To delete a track from a playlist, select
the playlist to display the tracks, click once on the
offending track to select it, and then press Delete.

w= Delete playlists. As for removing playlists them-
selves, that’s simple, too. Just select the playlist in the
source list and press Delete.

Burn an Audio CD in iTunes

222

Besides being a fantastic audio player, iTunes is adept at creating
CDs. iTunes makes copying songs to a CD as simple as a few clicks.
However, your Mac needs either a built-in DVD drive or an external
USB DVD recorder to work this magic. (Remember that the Mac mini
and MacBook Air do not have built-in DVD drives.)

It's easy to prepare for audio CD burning! Pick up a
pack of standard, blank audio CDs (sometimes called

“music CDs"), which are rated at 700MB and 80
minutes (that’s the storage capacity). Don't forget a
permanent marker to label your new discs (write on
the top side), or if you're feeling fancy, consider
using printed labels. Finally, don't forget to buy a
pack of empty CD sleeves or plastic, hinged “jewel
cases” if you need them.
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Follow these steps, with iTunes open. It’s easier to burn a CD from an
existing playlist, so see the earlier section on how to do that and build
your burn playlist first:

1. Click an existing playlist that you want to copy.
Remember that your audio CD can store only about 80
minutes of audio, which is about 20 songs of 4 minutes
each.

you're trying to record exceeds the capacity of

@ iTunes will also warn you if the amount of audio
the disc.

2. Choose FilecvBurn Playlist to Disc.

3. In the Burn Settings dialog that appears, choose
Maximum Possible from the Preferred Speed menu. Then
select the Audio CD disc format radio button, as shown
in Figure 11-7.

Burn Settings

Disc Burner: PIONEER DVD-RW DVR-112D

Preferred Speed: | Maximum Possible ¢

Disc Format: () Audio CD
Gap Between Songs: | 2 seconds =

IET Use Sound Check
Iglnclude CD Text
MP3 CD

Data CD or DVD
Data discs include all files in the playlist. These
discs may not play in some players.

7 Cancel | Burn

Figure 11-7

4. Click the Burn button to commence the disc burning
process.
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5. Put the blank CD in the drive when iTunes prompts you
to load it. iTunes starts the process, which will probably
take about 10 minutes, and then iTunes lets you know
when the recording is complete — and it ejects your
new disc.

Watch Uisualizations

iTunes is indeed a feast for the ears, but it can also provide you with
eye candy as well. With just a click or two, you can view mind-bending
graphics that stretch, move, and pulse with your music.

1. With your favorite music playing in iTunes, choose Viewr>
Show Visualizer (or press 38+T).

2. To switch to full-screen graphics, choose Viewt>Enter Full
Screen or press 38+Control+F. To escape from Full Screen
mode, click the mouse/trackpad button or press Esc.

3. To stop the visual display, choose Views>Hide Visualizer
(or press 38+T again).

Find and Buy Music, Video, Audiobooks,
and Podcasts at the iTunes Store

The hottest spot on the Internet for downloading music, video, audio-
books, and podcasts is the iTunes Store, which you can reach from the
cozy confines of iTunes (that is, as long as you have an Internet con-
nection). Figure 11-8 illustrates the lobby of this online audio-video
store.

stuff from the iTunes Store and listen to Internet
radio. If you're not connected yet, visit Chapter 13 to
find more about joining the Internet crowd.

@ Naturally, you'll need an Internet connection to buy
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Figure 11-8

You can search for a specific item (or browse to your heart’s content)
within the iTunes Store:

1. Click the iTunes Store item in the source list. After a few
moments, you see the home screen, which features the
latest offerings.

2. Browse the items at the store or search for an item:

m= Click a link in the Store list to browse according to
media type.

w= Click a featured artist or album thumbnail to jump
directly to that artist or album.
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m=  Click the Power Search link (in the Quick Links sec-
tion at the right side of the iTunes Store window) to
search by song title, artist, album, or composer.

audiobook, just click it. iTunes allows you to preview
a 30-second or 90-second sample of any audio or
video for free — just double-click the entry or click
the Preview button for movies and music videos.

@ To display the details of a specific album, song or

3. Add an item you want to your iTunes Store shopping cart
by clicking the Buy Song/Movie/Album/Video button.
(The name of the button changes depending on the type
of media you want to buy.)

e Individual tracks: If you're interested in buying just
certain tracks (for that perfect road warrior mix),
you would add just that (or those) song(s).

e A whole album or book: Click Buy Album; or to buy
an audiobook, click the Buy Book button.

4. iTunes prompts you for your Apple ID and password.
(More on your Apple ID in the sidebar “Set up an
Apple ID”.)

but you can also subscribe to a podcast. When you
subscribe, iTunes automatically downloads future
episodes and adds them to the Podcasts item in your
source list.

@ You can download individual episodes of a podcast,

Some songs (and most podcasts) are free to download. Apple always

clearly indicates whether a download is free, and you get a receipt in

an e-mail for every purchase . . . yet another reason for your Apple ID
account!
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Time to back up a sec. You need an Apple ID to buy something from the iTunes
Store. This ID is how Apple securely stores your payment method, e-mail
address, and contact information so that you can purchase things easily, with-
out having fo reenter all that stuff every time you buy an album or a movie.
Also, Apple can use the Apple ID you created while using the Setup Assistant
in Chapter 2 — less hassle, less confusion. However, if you set up your Mac
without creating an Apple ID thus far, just click the Create Apple ID button
when prompted.

Depending on what you've already set up, just click the Buy button, and iTunes
leads you step by step through the account setup process (or whisks you right
to the payment selection process). Remember, all the information you send is
over an encrypted connection — way to go, Apple.

After you buy an item, it automatically begins downloading. The items
you download are then saved to the separate Purchased playlist (under
the Store heading in the Source list). From there, you can play them or

move them to other playlists just like any other item in your iTunes
library.

Although the stuff you buy remains in the Purchased category in the
source list, each item is also automatically moved to the proper cate-
gory as well. For example, any songs you buy are added automatically
to the Music category in the source list, while any movies you buy are

added to the Movies category, and TV shows to the TV category.

The Back and Forward buttons at the top-left corner of

@ the iTunes Store window (on the black strip) operate
much like those in the Safari web browser, moving you
backward or forward in sequence through pages you've
already seen. Clicking the Home button (which,
through no great coincidence, looks like a miniature
house) returns you to the Store’s main page.
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Play Online Radio Stations

Although it’s not a radio tuner in the strictest sense, iTunes Radio can
locate virtual radio stations all over the world that send audio over the
Internet — a process usually dubbed streaming among the “in” Internet
crowd. iTunes can track down hundreds of Internet radio stations in a
variety of styles with only a few clicks. Whether you like Elvis (or those
passing fads, like rock, new wave, classical, or alternative), something's
here for everyone. The Radio also offers news, sports, and talk radio.

1. To begin listening to Internet radio with iTunes, click the
Radio icon, located beneath the Library section in the
source list. The result is a list of more than 20 types of radio
stations, organized by genre, as shown in Figure 11-9.

iTunes Match
Ping
Purchased
' Purchased on iPhone

Purchased on Speedy

iTunes D)
Allman Brothers
B-52s

Batte Midler
Bill Cosby
Bing Croshy
Boston
Chieftains
Count Basie
DEVO

Ella Fitzgerald
Frank Sinatra
Frank Zappa

Cenrae Thornaond

8eo0o0 iTunes
i ) o .v—"—-—'[_) o) .’ E |

Stream - Bit Rate Comments

Music » Adult Cantempaorary

Movies P Alternative Rock

TV Shows » Ambient

> Podcasts » Blues (26 streams)

iTunes U P Classic Rock

Books » Classical

Apps P College / University

e » Comedy
» Country
P Eclectic
P Electronica

iTunes Store > Colden Oldies

»Hard Rock [ Metal

P Hip Hop / Rap

» International / World
»Jazz

> News | Talk Radio

> Reggae / Island

> Religious

¥ RnB / Soul

»Sports Radio

»Top 40 { Pop

P'70s Retro (78 streams)
#'80s Flashback
P'90s Hits

+

104 streams

O]
Figure 11-9

228

www.it-ebooks.info



http://www.it-ebooks.info/

Chapter 11: Enjoying Music, Video, and Podcasts

2. When you expand a Radio category by clicking its trian-

gle, iTunes displays the name of several radio stations for
that category.

3. After iTunes fetches the names and descriptions of radio
stations, double-click one that you want to hear. iTunes
immediately jumps into action, loads the station, and
begins to play it.

229

www.it-ebooks.info


http://www.it-ebooks.info/

Part lll: Having Fun and Getting Things Done with Software

230

www.it-ebooks.info


http://www.it-ebooks.info/

Playing Games
in Lion

A

Ithough Mac OS X comes with at least one
game — a good version of chess — the

Macintosh has never been considered a true
gaming platform by most computer owners.
Until recently, many popular Windows games
were never released in versions for the Mac,
and only the most expensive Mac models had
a first-rate 3-D video card.

However, all of today’s Mac models feature mus-
cle car-quality video cards that can handle most
complex 3-D graphics with ease. Match that
capability with the renewed popularity of the
Macintosh as a home computer and the perfor-
mance of the current crop of Intel-based proces-
sors, and your Mac is quite the game machine.

In this chapter, you

2

[T 2

[T 2

2

2

Play 3-D chess with your Mac.

Burn a little time with an old-fashioned
sliding tile puzzle.

Download new games for your dash-
board widget collection.

Download new games (and other soft-
ware) for your Mac from the App Store.

Find out more about online gaming.
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Play Chess

Chess has no flashy weapons and no cities to raze, but it’s still the
world’s most popular game, and Mac OS X even includes a little 3-D
pizzazz. Figure 12-1 illustrates the Chess application at play; you can
find it in your Applications folder.

As you might expect, moving pieces on this board is as simple as click-
ing a piece and dragging it to its (legal) ending position.

The game features take-back (or undo) for your last move; just press
3#+Z if you need a second chance. You can also list your games in text
form and save games in progress from the Game menu. Maybe it’s not
a complete set of bells and whistles like commercial chess games have,
but the price is right, and the play can be quite challenging (and the
moves much longer to calculate) when you set it at the higher skill
levels.

e Mark Chambers - Computer (White to Move)

lJ[

Ll [l ]
T

:l:l;l:ll-jl
LI°flof] o

Click and drag a piece to move it.

Figure 12-1
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To configure Chess to your liking, choose Chesst>Preferences. Then
you can

w= Change the appearance of your board and pieces.
Try a set of fur pieces on a grass board — jungle
chess at its best!

w= Turn on spoken moves and voice recognition.
Click to select the Speak Computer Moves check box,
and then click the Computer Voice pop-up menu to
select the voice your Mac uses. If you select the Allow
Player to Speak Moves check box, the round Speech
Recognition window appears. Press the Esc key and
speak your move (in standard chess notation).

w= Set the computer’s skill level. The Computer Plays
slider determines whether your Mac plays a faster or
smarter game.

cheating — especially when I'm behind by several
pieces! When it’s your turn, choose Moves=>Show
Hint and watch Chess suggest the best move.

Play the Tile Game Widget

Apple also provides a digital version of that old standby, the sliding
tile game. The Tile Game is a dashboard widget, so you can display it
at any time by

@ If you're like me, a hint at midgame isn’t really

w= Clicking the dashboard icon to the left of the Dock.
(It looks like a speedometer.)

w= Clicking the scroll button on your mouse or pressing
the correct function key (either F4 or F12, depending
on the keyboard your Mac uses).
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w= f you're using a trackpad, display Mission Control
(by swiping upward with three fingers) and click the
Dashboard thumbnail.

Figure 12-2 illustrates my dashboard showing the Tile Game widget.

If the Tile Game widget doesn’t appear on your dash-

@ board, click the Add button (bearing the plus sign
icon) at the lower left to display your available wid-
gets. Click the Tile Game icon, and Lion adds it to
your dashboard. To hide the collection again, click
the X icon at the lower-left corner.

Tile Game widget

4 January 2012 3

12 3 45 6 7
THIS DAY IN HISTORY 8 9 10 11 12 13 14
Janl.lary 13 15 16 17 18 19 20 21
22 23 24 25 26 27 28
Salmon P. Chase,
antislavery leader and 29 30 3

chief justice of the United
States, born 1808.

Q110

Figure 12-2

Click the Tile Game window once to randomize the tiles, and then
click again to start playing. To move a tile to the free space, click the
tile. Of course, the object of the game is to restore the image to its
original pristine condition!
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You can return to your applications and your Lion Desktop at any
time by clicking the scroll button on your mouse a second time or by
pressing the dashboard function key again.

most of them save the current game (or position)
when you close the dashboard. That way, you can
easily resume the game after you, well, get real work
done.

@ One nice thing about dashboard game widgets is that

Find more information about displaying and configuring widgets in
Chapter 3.

Install New Widget Games from Apple

Looking for a new gaming challenge for your dashboard? No problem.
Apple offers additional game widgets that you can download on the
Mac OS X download site (www . apple.com/downloads) by using
Safari. Third-party software developers also provide both freeware and
shareware games. When Safari completes the download, Lion auto-
matically prompts you for confirmation before installing the new
widget.

After you download a new game, you can easily add it to your
dashboard:

1. Display your dashboard by pressing the dashboard func-
tion key or clicking the scroll button on your mouse.

2. Click the Add button (which bears a plus sign, naturally)
in the lower-left corner of the dashboard screen. A scroll-
ing menu strip appears at the bottom of the dashboard
display (including any game widgets you downloaded
and installed). Figure 12-3 illustrates this. Click the left
and right arrows at the sides of the menu strip to display
more installed widgets.

235

www.it-ebooks.info


http://www.apple.com/downloads/
http://www.it-ebooks.info/

Part lll: Having Fun and Getting Things Done with Software

4 January 2012 >

12 3 45 67
8 9 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25 26 27 28
29 30 AN

THIS DAY IN HISTORY

January 13

Salmon P. Chase,
antislavery leader and
chief justice of the United

States, born 1808.

01010

©)

Doppler Radar 600-Mile

w 4 » 4 2012 January 11+ @ Dilbert e

GOOD NEWS I SIGNED
UP TO RECEIVE A FREE
LEADERSHIP NEWS—
LETTER BY EMAIL.

BECAUSE 178 Lo TTen || STOP MAKING
BY SOME GUY WHO USED || EVERYTHING I SAY
TO HAVE A JOB. ! SOUND STUPID!

DibenCanoorat@gmal com

Dilbent com

® Manage Widgets...

Hula Girl 3.0 iCal iStat Pro Mighty Marvel.... Movies i Say Cheese 2 Ski R‘E’l‘ln-rt Starry Night Wi.... Stickies Stocks

Drag new widgets onto your dashboard.

Figure 12-3

3. Drag new widgets directly onto your dashboard from this
menu. You can also click on a widget that’s already on
your dashboard and drag it to a new location while the
menu strip is visible.

To delete one or more widgets from the menu strip,
click the Manage Widgets button and click the red
minus sign next to each of the offending parties.

4. Click the Add button again (now it looks like an X) to
return to your dashboard.
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Don't forget to set any options that your new game
offers; look for a tiny circle with a lowercase letter i.
Click this information icon, and you can set the
options that are available for the game.

Download New Games from Apple

&

Of course, widget games are somewhat limited. Maybe you’d like to

try a cutting-edge first-person shooting game or a sophisticated adven-
ture game, or perhaps build and conquer civilizations. Apple makes it
easy to download the latest in game applications, using the App Store.

if you're familiar with the iTunes Store within iTunes),
you've sailed into familiar waters. You can download
both commercial games (those that you buy) and free
games for your Mac, and the App Store makes it easy to
keep all your downloaded applications updated. Of
course, there are many other types of applications avail-
able from the App Store, including productivity, utility,
and financial programs. Feel free to browse!

@ If you've used the App Store on your iPhone or iPad (or

To download a new game from the App Store, follow these steps:

1. Click the App Store button on the Dock (it’s a blue circle

with an A, fourth from the left side).

2. Click the All Categories drop-down menu at the right side

of the screen (under Quick Links) and click Games. You
should see selections like those shown in Figure 12-4.

. Click a game to display information on the game, like

the age rating, the size of the game, and representative
screen shots.

4. To download the game, click the price button at the

upper left of the App Store window. Remember that
many games are free, and they’ll display a button marked
Free. The button will change to read either Buy App (for a
purchase) or Install App; just click it again to continue.
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5. The App Store will prompt you for your Apple ID and
password, and after you enter them, click the Sign In but-
ton, and the game will begin to download. (If you didn’t
create an Apple ID during the setup of Lion — or if you
don’t already have one for use with your iPhone, iPod
touch, or iPad — click the Create Apple ID button, and
the App Store will lead you through the process.)

6. After the download is complete, the game appears in
Launchpad, ready for you to play.

Play Games Online

Some of today’s hottest games aren’t limited to your Mac. Online
games use your Internet connection to match you against thousands of
other players, in real time, across the world!
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if you have a broadband connection to the Internet
(DSL, cable, or satellite). Playing today’s 3-D online
games (or even web-based games) by using a dial-up
modem connection is a lesson in frustration. Turn to
Chapter 13 if you still need to choose an Internet
connection.

@ In my opinion, online gaming is truly enjoyable only

Some games are free and display advertisements, and others are
subscription-based.

Probably the most popular online game for the Mac is the online
megahit World of Warcraft (and the latest expansion to the original

game, Cataclysm). This massive multiplayer online role-playing game, or
MMORPG, is another wrinkle in the popular Warcraft game series. World
of Warcraft puts the character you create in the boots of human princes,
Orc battle generals, undead champions, trolls, gnomes, and elfin lords. In
fact, you can create multiple characters and play them as you choose. For
all the details, check the official site at www.blizzard.com.

If more traditional games — bridge and sudoku — are your prefer-
ence, I heartily recommend the CNN Games page (games . cnn. com).
You can choose from a wide range of free online games, including
arcade, strategy, word, and card games. (Most even include snappy
music while you play!) Leaderboards keep track of your high scores,
naturally, and you can play solo or against your friends online.

One word of caution while playing games online: Never provide any
private information other than your name and your e-mail address
while signing up for a free game. (This includes, of course, your credit
card or PayPal account information, unless you're signing up for a
commercial online game that requires a subscription.) Games pro-
vided by high-quality websites like CNN certainly aren’t scams, of
course, but it pays to be careful.
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Exploring the
Internet

The 5th Wave By Rich Tennant

“Tve used several spreadsheet programs, but
this is the best one for designing quilt patterns.’
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Understanding
Internet Basics

Fne Internet is a terribly complex monster of
a network. If you tried to fathom all the
data that's exchanged on the Internet and
everything that takes place when you check
your e-mail for your cousin Joan'’s fruitcake
recipe, your brain would probably melt like a
chocolate bar in the Sahara Desert.

Luckily for regular folks like you and me, Mac OS
X Lion closes the trapdoor on all these details,
keeping them hidden (as they should be). You
don't have to worry about them, and the obscure
information you need to establish an Internet
connection is kept to a minimum. You need to
know only the basics about the Internet, and
that’s what I provide in this chapter!

I discuss how to

w= Ise different types of Internet
connections.

w= Connect to the Internet.
w= Join Apple’s iCloud service.
w=  Add an antivirus program.

w= Follow common-sense rules to stay safe
on the Internet.
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Understand How the Internet Works
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Many computer owners I talk to are convinced that the Internet is a
real object. They're not quite sure whether it's animal, vegetable, or
mineral, but they’re sure that they either have it or want it inside their
computers. (It's probably a tiny, glowing ball: a cross between Tinker
Bell and St. Elmo’s fire.)

Seriously, though, you don’t need to know what the Internet is in
order to use it. From a Mac owner’s standpoint, you would be correct
(in a way) if you said that the Internet begins at the phone connection
or the cable modem. Therefore, if you want to skip to the next section
and avoid a glance underneath the hood, be my guest.

Still here? Good. Here's a brief description of what happens when you
connect to the Internet and visit a website:

You open your Safari web browser (a browser is a pro-
gram used to display pages from the World Wide Web),
and your Mac connects to an Internet service provider
(ISP) or a public Internet access point. From the moment
your Mac connects, you're officially online, and a part of
the Internet. (Note, however, that you're not on the web
yet, just connected to the Internet.)

An ISP is simply the company you pay to connect to the
Internet. You might contract with a cable company, such
as Comcast, Bright House, or RoadRunner, or you might
use a service such as AOL, Juno, or EarthLink. All these
are ISPs. Your ISP account usually includes reserved space
on its computers for you to create a personal website, as
well as giving you one, two, or more e-mail addresses.

Your ISP locates the website across the Internet.

When you ask to open a specific website, your ISP uses
that website’s name to locate the computer it resides on.
In the Internet world, the website name is its web address,
or URL (which stands for Universal Resource Locator, but
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you don't need to remember that). When the website is
located, your ISP opens a sort of pathway between your
Mac and the server that website resides on. For example,
if you request the URL www . m1cbooks . com, my busi-

ness website is displayed.

3. After you connect to a website, a web page is displayed.
On this page, you can click links, which generally consist
of text shown in a different color, and the text is often
underlined. Sometimes, however, the link is an image
rather than text. Clicking the text or image link opens
another page on the same website, or it might even open
a completely different website.

This is the essence of everything you do on the Internet: Computers
connect with other computers (no matter where on the planet they
might be) and exchange information of various types, such as e-mail
messages, photos, web pages, videos, and music.

See? It's beautifully organized chaos, and you can visit any of the bil-
lions of websites on the planet!

Explove Internet Connections

Consider the types of connections that are available under Lion to link
your Mac to your ISP (see the preceding section). You can choose from
four pathways to digital freedom:

w= A broadband connection: Whether it's by way of
DSL (which uses a standard telephone line) or cable
(which uses your cable TV wiring), broadband
Internet access is many times faster than the old-
fashioned dial-up connections. Plus, DSL and cable
technologies are always-on: that is, your computer is
automatically connected to the Internet when you
turn it on, and the connection stays active. With DSL
or cable, no squeaky-squawky cacophony accompa-
nies your modem making a connection each time
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you want to check your movie listings website. Both
DSL and cable require a special piece of hardware,
commonly called a modem. This box is usually
thrown in as part of your ISP charge. A broadband
connection usually requires professional installation.

Not every Internet connection requires an ISP. For
example, some mobile phone providers can equip
your laptop with a cellular modem that delivers the
Internet wherever you have mobile service. And now-
adays, many larger cities now offer free city-wide
public wireless (Wi-Fi) access (not to mention the
free wireless access you can often find provided by
coffee shops and restaurants and hotels).

A satellite connection: If you're really out there —
miles and miles away from any cable or DSL phone
service — you can still have high-speed Internet
access. The price for a satellite connection is usually
much steeper than a standard DSL or cable connec-
tion, but it's available anywhere you can plant your
antenna dish with a clear view of the sky. Plus, a sat-
ellite connection is faster than other types of broad-
band access. Older satellite technologies required
you to also use a dial-up connection — and the
antenna could only receive, not send — but most
ISPs that can handle satellite connections now offer
satellite systems that send and receive through the
dish.

A dial-up connection: Old-fashioned, yes. Slow as
an arthritic burro, indeed. However, an analog (or
telephone modem) connection is still a viable
method for computer owners to reach the Internet.
It's the least-expensive method available (as long as
your call to the access number is a local call, and not
a long-distance, toll charge), and all you need for
this type of connection is a standard telephone jack
and an analog modem (and a contract with a service
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provider, such as AOL, Juno, or EarthLink). Apple
used to include a modem with every computer, but
no longer. These days, you have to buy an external
USB modem to make the dial-up connection. (Any
USB modem that’s compatible with Mac OS X Lion
works fine.)

w= A network connection: This type of connection con-
cerns Mac models that are part of a local area net-
work (LAN) either at the office or in your home. (A
network simply means a community of computers
that can talk to each other and share files and
devices, like a printer.) If your Mac is connected to a
LAN that already has Internet access, you don’t even
need an ISP, and no other hardware is required:
Simply contact your network administrator, buy that
important person a steak dinner, and ask to be con-
nected to the Internet. On the other hand, if your
network has no Internet access, you're back to Square
One: You need one of the three types of connections
noted in the preceding bullets.

Set Up a Broadband Internet Connection

Ep” e
e ¥op

Okay, so you sign up for Internet access, and your ISP sends you a
sheet of paper covered with indecipherable settings that look like
Egyptian hieroglyphics. Don’t worry: Those settings are the ones you
need to connect to your ISP. After you transfer this information to
Lion, you should be surfing the web like an old pro. (First, of course,
you'll need to connect your Mac to the DSL or cable modem, as
instructed by your ISP.)

Follow these steps to set up your Internet connection if you're using a
cable modem, DSL connection, or network:

1. Click the System Preferences icon on the Dock and
choose Network.
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2. Select Ethernet from the list on the left side of the pane
to display the settings you see in Figure 13-1.

8o Network

| - [ | Show All |

Location Automatic

5] e Status

@ FireWire

@ Bluetooth PAN g Configure IPv4
IP Address
Subnet Mask
Router

DNS Server

Search Domains

+ ] = |ar
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i * Click the lock to prevent further changes.

Connected

Ethernet is currently active and has the IP

address 192.168.0.106.

Using DHCP
192.168.0.106
255.255.255.0

192.168.0.1

Assist me...

Advanced...

?

Figure 13-1

3. Refer to the paperwork or e-mail you received from your
ISP and then enter the settings for the type of connection

your ISP offers:

e [f your ISP tells you to use Dynamic Host
Configuration Protocol (DHCP): Choose Using
DHCP from the Configure IPv4 pop-up menu, and
your ISP can automatically set up virtually all the
connection settings for you! (No wonder DHCP is

so popular these

days.)

e [f your ISP tells you that you won’t use DHCP:
Choose Manually from the Configure IPv4 pop-up
menu. Then enter the settings provided by your
ISP in the IP Address, Subnet Mask, Router, and
DNS Servers fields.
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4. 1f your ISP uses PPPoE (Point-to-Point Protocol over
Ethernet), click the Configure IPv4 pop-up menu and
choose Create PPPoE Service. (If your ISP doesn't use
PPPoE, skip to Step 8.)

5. Type an indentifying name for the PPPoE service into the
Service Name text box, like the name of your ISP.

6. Click Done to display the PPPoE connection settings.

7. Enter the password for your PPPoE connection, as pro-
vided by your ISP, and then click Apply. (Yet another
good reason to store all the connection setup data from
your ISP in a safe place.)

8. Press 38+Q to close System Preferences and save your
changes.

trenches! To launch an assistant to help with the con-
figuration process, click the Assist Me button at the

bottom of the System Preferences Network pane, and
then click Assistant on the assistant’s welcome screen.

@ Lion can get down and dirty in the configuration

Set Up a Wireless Internet Connection

If you're within range of a wireless Ethernet network, you can use your
Mac’s built-in wireless hardware to connect. (Ethernet is the network-
ing type used by most homes and businesses, and it can be either a
wired or wireless connection.) Most public networks offer Internet
access, so this option is an advantage for MacBook owners on the go
(those who visit coffee shops, libraries, and schools, for example).

Likewise, if you're using a broadband connection at home with an
AirPort Extreme wireless router or Time Capsule wireless backup
device, your desktop Mac can connect to that wireless network and
reach the Internet that way.
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Follow these steps to connect to a wireless network:

E*ad 1. Click the System Preferences icon on the Dock.
e 2o

2. Click the Network icon.

3. From the Connection list on the left, click WiFi.

4. Select the Show WiFi Status in Menu Bar check box.
5. Click the Apply button.

6. Press 38+Q to close System Preferences and save your
settings.

7. Click the WiFi status icon on the Finder menu bar. (It
looks like a fan shape composed of bars that indicate sig-
nal strength.)

8. From the WiFi listing, choose an existing network con-
nection that you want to join.

The network name is usually posted for public networks.
For a private network, ask the person who set up the net-
work for the name.

9. If you're joining a secure network, Lion will prompt you
for a password, so just enter the password and click Join.
(If the network is “open” and unsecured, Lion won't
prompt you for a password, and the connection is
made.)

password, preventing outsiders from connecting to

@ A secure network is closed to those without the
your Mac.

If the public network you're joining has a password
(most don't), it should be posted. For a private network,
ask the person who set up the network for the password.
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Set Up a Dial-up Connection

Follow these steps to set up your Internet connection if you're using a
standard phone line and your Mac’s external USB modem:

Bl 1. Click the System Preferences icon on the Dock and
Aes,  choose Network.

2. Choose External Modem from the list at the left.

3. Click the TCP/IP tab and enter the settings for the type of
connection your ISP provides:

e [f your ISP tells you to use PPP (Point-to-Point
Protocol): Click the Configure IPv4 pop-up menu
and choose Using PPP. If your ISP provided you
with DNS Server or Search Domain addresses, type
them now in the corresponding boxes.

e If you're using AOL: Click the Configure IPv4 pop-
up menu and choose AOL Dialup. If AOL pro-
vided you with DNS Server or Search Domain
addresses, click in the corresponding box and type
them now.

e [f your ISP instructs you to set up the connection man-
ually: Click the Configure IPv4 pop-up menu and
choose Manually. Then click in the IP Address,
DNS Servers, and Search Domains fields and enter
the respective settings provided by your ISP.

4. Click the PPP tab.

5. In their respective fields, enter the account name, pass-
word, telephone number, and (optional) the service pro-
vider name and an alternative telephone number
provided by your ISP.

6. Press 88+Q to close System Preferences and save your
changes.
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In ancient times — I'm talking a year ago here — when you took a
photo with your iPhone or created a new document with your iPad,
your new additions just sat there (in their original location) until you
had a chance to sync your device with your Mac. Music that you
bought from the iTunes Store on your Mac remained on your com-
puter until you synchronized your iPhone, iPad, or iPod touch over
your trusty USB cable connection.

Ah, what a difference a year makes! Now you can share data between
your Mac and your iOS 5 devices — your iPhone, iPad, and iPod
touch — automatically across a wireless connection! If you buy an
album on your Mac these days, it can just show up on your iPhone or
iPad automatically.

That's Apple’s iCloud online service. In this section, I save you the
trouble of researching all the benefits of iCloud. Heck, that’s one of
the reasons you bought this book, right?

Today’s Apple iOS 5 devices can all display or play the same media:
photos, music, books, TV shows, and such. Some iOS devices can even
share applications that you install, such as your iPhone and iPod
touch. Therefore, it makes sense to effortlessly share all your digital
media across these devices, and that’s what iCloud is all about. Apple
calls this synchronization pushing.

Take a look at how the pushing process works. Imagine that you just
completed a Pages document on your MacBook (an invitation for your
grandson’s birthday party), but you're traveling on the road, and you
need to get the document to your family so that they can edit and
print it using your son'’s iPad.

Before iCloud, you'd have to attach the document to an e-mail mes-
sage or upload it to some type of online storage, and then a family
member would have to download and save the document to the iPad
before working with it. With iCloud, you simply save the document,
and your MacBook automatically pushes the document to the iPad!
Your document appears on the iPad, ready to be opened, edited, and
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printed (and on any other iOS 5 devices that you've authorized as
well). iCloud sets up this push system only between computers and
devices that use the same Apple ID, so your data remains private.

iCloud isn't limited to just digital media, either. Your Mac can also
automatically synchronize your e-mail, iCal calendars, and Address
Book contacts with other iOS 5 devices across the Internet, making it
much easier to stay in touch, no matter which device you happen to
be using at the moment.

Apple also throws in 5GB (a lot!) of free online storage that you can
use for all sorts of things: not only digital media files but also docu-
ments and anything else that you'd like to place online for safekeep-
ing. Even better, anything you buy through the iTunes Store — such as
music, video, and applications — does not count against your 5GB
limit.

Need more elbow room than 5GB? Apple is happy to provide 10, 20,
or even 50GB of additional storage for an annual subscription fee of
$20, $40, or $100 per year, respectively. Click the Manage button on
the iCloud pane in System Preferences, and then click Buy More
Storage. Remember that to join the iCloud revolution, you'll need an
Apple ID. You can create one during the Lion setup process I describe
in Chapter 2, but you're also prompted to create one whenever an
Apple ID is necessary. And after you create your Apple ID, you can use
it on all your Apple computers and devices.

I should also mention that you get a free iCloud e-mail account,
which ends in the rather catchy @me. com. You can also send and
receive iCloud e-mail seamlessly from Lion’s Mail program, which is
the preferred method of checking messages. In fact, Lion automatically
creates a matching Mail account for your iCloud e-mail account.
Unadulterated cool!

You control all iCloud settings from the iCloud pane in System
Preferences, as shown in Figure 13-2. Click the System Preferences
icon on the Dock and then click the iCloud icon. If you're not an
iCloud member already, you'll enter your Apple ID account and your
password, and System Preferences will guide you through basic iCloud
configuration with a number of questions.
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Figure 13-2
@ To display the particulars about your iCloud storage,

click the Manage button at the bottom-right corner of
the iCloud Preferences pane. From the sheet that
appears, you can see how much space you're using
for specific types of documents and applications.

Like the convenient operating system it is, Lion handles all your
iCloud chores automatically from this point on.

Keep in mind that iCloud is many things, but it isn't an ISP. You need
an existing Internet connection to use the features included in iCloud
membership. This requirement makes a lot of sense, considering that

most of us already have Internet access.

iCloud works with the ISP you already have, so you don’t have to
worry about AOL or EarthLink conflicting with iCloud. However, 1
can’t guarantee that your system administrator at work allows iCloud
traffic across his or her pristine network. Perhaps a steak dinner would
help your argument.

Keep Your Mac Secure Online
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I know that you've heard horror stories about hacking: Big corpora-
tions and big government installations seem to be as open to hackers
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as a public library. Often, you read that even entire identities are being
stolen online. When you consider that your Mac can contain extremely
sensitive and private information from your life — such as your Social
Security number and financial information — it's enough to make you
nervous about turning on your computer long enough to check your
eBay auctions.

How much of this is Hollywood-style drama? How truly real is the
danger, especially to Mac owners? In this section, I continue a quest
that I've pursued for more than 15 years — to make my readers feel
comfortable and secure in the online world by explaining the truth
about what can happen and telling you how you can protect your sys-
tem from intrusions.

home and small-business Mac owner in mind. Macs
that access the Internet over a larger corporate net-
work are likely already protected by that knight in
shining armor, the network system administrator.
(Insert applause here.) Check with your system
administrator before you attempt to implement any
of the recommendations I make here.

@ One quick note: This section is written with the

As a consultant, I run websites and squash virus attacks for a number
of companies and organizations, so I've seen the gamut of Internet
dangers. With that understood, here’s what can happen to you online
without the right safeguards, on any computer:

w= Hackers can access shared information on your net-
work. If you're running an unguarded network, it’s
possible for others to gain access to your documents
and applications or wreak havoc on your system.

m= Your system could become infected with a virus or
dangerous macro. Left to their own devices, these
misbehaving programs and macro commands can
delete files or turn your entire hard drive into an
empty paperweight. (Although Mac viruses are few
and far between as I write this, I don’t think we'll
enjoy such luxury for long.)
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w= Unsavory individuals can attempt to contact mem-
bers of your family. This type of attack can take place
over iChat (the Apple instant messaging and confer-
encing program, which I describe in Chapter 16),
e-mail, or web discussion boards, putting your fami-
ly’s safety at risk.

w= Hackers can use your system to attack others. Your
computer can be tricked into helping hackers when
they attempt to knock out websites on the Internet.

w= Criminals can attempt to con you out of your
credit card or personal information. The Internet is
a prime tool used by people trying to steal identities.

To be absolutely honest, just like every time you drive a car, some dan-
ger is indeed present every time you or any user of your Macintosh
connects to the Internet. However, here’s the good news: If you use the
proper safeguards, it’s literally impossible for most of those worst-case
scenarios to happen on your Mac; and what remains would be so diffi-
cult that even the most diehard hacker would throw in the towel long
before reaching your computer or network.

[ want to point out that virtually everyone reading this book — as well
as the guy writing it — really doesn’t have anything that's worth a
malicious hacking campaign. Information in the form of Quicken data
files, saved games of Sims 3, and genealogical data might be priceless
to us, of course, but most dedicated hackers are after bigger game.
Unfortunately, the coverage that the media and Hollywood give to
corporate and government attacks can make even Batman’s Aunt
Harriet more than a little paranoid. It's not really necessary to consider
the FBI or Interpol every time you poke your Mac’s power button. A
few simple precautions are all that’s required.

@ Because this book focuses on Mac OS X Lion, I don't

spend much time covering Windows. For a compre-
hensive guide to Windows 7 and the PC world, how-
ever, | can heartily recommend PCs All-in-One For
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Dummies. Why the strong recommendation? Well, |
wrote that book, too!

Interested in the technical side of computer security?
Then visit a favorite site of mine on the web: www .
grc.com, the home of Gibson Research Corporation.
There you'll find the free online utility ShieldsUP!,
which automatically tests how susceptible your Mac is
to hacker attacks.

Know the Antivirus Basics

It’s time to consider your antivirus protection under both Lion and
Windows. Viruses are malicious computer programs that originate at
an outside source and can infect your computer without your knowing
it. The virus, which is generally activated when you run an infected
program on your computer, can then take control of your system and
cause lots of trouble. You need to closely monitor what I call the Big
Three:

[T 2

1

[T 2

Web downloads: Consider every file you receive
from websites on the Internet as a possible viral

threat, including things like application files and
Word documents.

Removable media: Viruses can be stored on every-
thing from CD-ROMs and DVD-ROMs to USB flash
drives.

E-mail file attachments: An application sent to you
as an e-mail attachment is an easy doorway to your
system. (Yet another reason to follow proper
“Netiquette” and avoid sending spurious e-mail
attachments. If you forward an e-mail file attach-
ment you received from another person without
scanning it, you run the risk of sending an unwel-
come stowaway as well!)
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Horrors! Mac OS X has no built-in antivirus support. (Then again, nei-
ther does Windows 7.) However, a good antivirus program takes care
of any application that’s carrying a virus. Make sure that the antivirus
program you choose offers real-time scanning, which operates when
you download or open a file. Periodic scanning of your entire system
is important, too, but only a real-time scanning application such as
VirusBarrier X6 can immediately ensure that the file or the application
you just received in your e-mail Inbox is truly free from viruses. Keep
in mind that Apple periodically releases software updates for Lion that
are intended to plug security holes as the holes are discovered. So if
you get into the habit of grabbing these updates whenever they're
available, you can help keep your Mac safe. (Chapter 17 covers how
to set up automatic updates to Lion.)

Virus technology continues to evolve over time, just like more benefi-
cial application development. For example, a recently discovered virus
was contained in a JPEG image file! With a good antivirus application
that offers regular updates, you can continue to keep your system safe
from viral attack.

I heartily recommend both the freeware ClamXav 2 (www.clamxav.
com) and the commercial application VirusBarrier X6 from Intego (at
www . intego . com).Both are available only for Lion. Both programs
include automatic updates delivered while you're online to make sure
that you're covered against the latest viruses.

Follow Common Sense: Things Not to Do Online
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Practicing common sense on the Internet is just as important as add-
ing an antivirus application to your Mac.

With this statement in mind, here’s a checklist of things you should
never do while you're online:

w= Never download a file from a site you don’t trust.
Make sure that your antivirus software is configured
to check downloaded files before you open them.
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Never open an e-mail attachment before it's
checked. Don't give in to temptation, even if the per-
son who sent the message is someone you trust.
(Many macro viruses now replicate themselves by
sending copies to the addresses found in the victim’s
e-mail program. Of course, this problem crops up reg-
ularly in the Windows world, but it has been known
to happen in the Macintosh community as well.)

If you're ever in doubt about a file that someone has
sent you, write the sender an e-mail and ask whether
he sent it! Sometimes the wording in the Subject line
is misspelled or uses wording your friend wouldn't
choose. Things like that should raise your eyebrow.

Never enter personal information in an e-mail
message when you don’t know the recipient. Sure,
I send my mailing address to friends and family, but
no one else. In fact, even e-mail can be intercepted
by a determined hacker, so if you're sending some-
thing truly important, use an encryption application,
such as PGP Personal Desktop (www . pgp . com).

Never enter personal information on a website
provided as a link in an e-mail message. Don't fall
prey to phishing expeditions. Phishing is a recently
coined Internet term that refers to the attempt that
con artists and hackers make to lure you in by creat-
ing websites that look just like the sites used by
major online stores — including big names such as
eBay, PayPal, and Amazon. These turkeys then send
junk e-mail messages telling you that you must log
on to the website to “refresh” or “correct” your per-
sonal information. As you no doubt already guessed,
that information is siphoned off and sold to the
highest bidder — your credit card, your password,
and your address. (In fact, if you hover your pointer
over the links on a phishing website, you'll notice
that they go to completely different Internet
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addresses, rather than where they claim to go.)
Luckily, if you follow the tips I give you in this sec-
tion, you can avoid these phishing expeditions.

Some of these e-mail message and website combina-
tions look authentic enough to fool anyone! It's
important to remember that no reputable online
company or store will demand or solicit your per-
sonal information by using e-mail or a linked web-
site. In fact, feel free to contact the company at its
real website and report the phishing attempt!

Never include personal information in an Internet
newsgroup post. (A newsgroup is a public Internet
message base, often called a Usenet group. Most ISPs
offer a selection of newsgroups that you can down-
load.) Newsgroup posts can be viewed by anyone
with a newsgroup account (or through sites like
Google Groups), so there’s no such thing as privacy
in a newsgroup.

Never buy from an online store that doesn't offer a
secure, encrypted connection when you're prompted
for your personal information and credit card num-
ber. If you're using the Apple Safari browser, the pad-
lock icon appears in the upper-right corner of the Safari
window. When the padlock icon appears in the win-
dow and the web address begins with the https pre-
fix, the connection is encrypted and secure.

Never divulge personal information to others over
an iChat connection. I tell you more about iChat in
Chapter 16.

Never use the same password for all your elec-
tronic business. Use different passwords that
include both letters and numbers and change them
often, and never divulge them to anyone else.
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Browsing the
Web with Safari

Navigating the web is easy, but you need a
browser to visit your favorite sites. On

your Mac, that browser is Safari, of course, and
it just keeps getting better with each new ver-
sion. It doesn’t matter whether you're working
wirelessly from a hotel room or the comfort of
your home: Safari delivers the web the right
way. You can

w= Search for information, display sites you
visited, and navigate to your favorite
sites.

w= Download files and print documents.
w= Mark articles for later perusal.
m=  Block irritating pop-up windows.

w= Customize the program to match your
preferences.

In this chapter, I assume that you're using
Safari as your browser. However, most of what
you'll find here is similar to other popular
browsers, like Google Chrome and Mozilla
Firefox.
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Uisit a Website

To begin your travels around the Internet, follow these steps:

7 1. Launch Safari by clicking the Safari compass icon on the
&2 Dock. The Safari window opens and displays your home

page.
@ Your home page is the initial website you see every

Y

o+

time you launch Safari, so most folks change their
home page to a favorite location on the web. (Mine,
for example, is set to CNN because I'm a news-
hound.) I show you how to change your home page
later in the chapter, in the section “Set Up a Home
Page.”

2. Click in the Address text box, shown in Figure 14-1, type
the address for the website you want to visit, and then
press Return. The page appears in the Content window,
which occupies most of the Safari window.

fix and end with the . com suffix, but you may
encounter addresses that begin or end differently.
Make sure to enter the web address exactly as it
appears in advertisements, e-mail messages, or news
reports — and yes, capitalization does matter!

@ Most website addresses still begin with the www . pre-

3. On the resulting web page, click an underlined (or high-
lighted) link to continue web surfing. Many pictures are
also links as well. Whenever your pointer turns into a
gloved hand, your pointer is hovering over a link. Often,
links are underlined, typically in blue (if you haven't
clicked it) or purple (if you have). You can also jump
directly to another page by returning to Step 2.
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Our Online Store
About The Author
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Welcome to MLC Books Online!

The Home of Books Written by Mark L. Chambers

This online library is dedicated to the books I've written and those who read them...
thanks for dropping by! Pull up a virtual chair and browse the titles - and, if you like
what you see, you're welcome to buy copies of my books right from this site. Drop
me an email with your comments and questions, and download the bonus chapters
mentioned in my books.

My heartfelt thanks to a longtime personal hero of mine,
Steve Jobs, who passed away on Wednesday, October 5,
2011. Steve, you were the inspiration behind much of the
technology that we take for granted today, and our world
at large is a far better place because of what you did and
who you were.

What's New?

MacBook All-in-One For Dummies Second Edition Under Construction! The
Second Edition will focus on Apple’s laptop line, including all the latest features, the
newest gestures and Mac OS X Lion's Mission Control, Launchpad and full-screen
mode... and I won't forget that Thunderbolt port, either! You can pre-order the book
on Amazon.com.

Mac OS X Lion All-in-One For Dummies Released! My Big Book on the Big Cat is
on the shelves - look no further for an overview of all the new features in Lion, as
well as a complete update for iLife ‘11 and a brand-new chapter on using Boot Camp
tn run Windows 7 an vour Mac

Figure 14-1

Safari also launches automatically when you

[T 2

application.

2

Click a page link in Apple Mail or another Internet

Click a Safari web page icon on the Dock, on the

Desktop, or in a Finder window.

2

Navigate the Web

Click a website within the Address Book.

A typical web surfing session is a linear experience — you move from
one page to the next.
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glasses as I type this — you’ll appreciate Safari’s
Zoom feature, which increases the size of text and
graphics displayed by web pages. Choose
View=>Zoom In to zoom in on the contents or press
38 ++ (the plus sign). To zoom back out, choose
Viewr>Zoom Out or press 38+- (the minus sign). If
you've zoomed in or out quite a bit, choose
Viewr>Actual Size to return things to normal quickly.

@ If your eyesight isn't perfect — and I'm wearing

After you visit a few sites, you might want to return to a site you just
visited or head to your home page. Safari offers these navigational
controls on the toolbar, as shown in Figure 14-2:

w= Back: Click the Back button (the left-facing arrow)
on the toolbar to return to the last page you visited.
Additional clicks open previous pages, in reverse
order. The Back button is disabled (ghostly and
grayed out) if you haven't visited at least two sites.

w= Forward: If you clicked the Back button at least once,
clicking the Forward button (the right-facing arrow)
opens the next page (or pages) where you were, in
forward order. The Forward button is disabled (again,
ghostly) if you haven't used the Back button.

w= Stop/Reload: Click the Reload button (a circular
arrow) in the Address box to refresh, or reload, the
contents of the current page. Although most pages
remain static, some pages change their content at
regular intervals or after you fill out a form or click a
button. By clicking Reload, you can see what's
changed on these pages. While a page is loading, the
Reload button turns into the Stop button — with a
little X mark on it — and you can dlick it to stop
loading the content from the current page.
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Figure 14-2

®

You can choose which icons appear on your Safari
toolbar. Choose Viewr>Customize Toolbar, drag the
icon you want, and then drop it in the desired spot
on the toolbar. (Remember to click and hold while
moving the icon to drag it.) To remove an icon from
your Safari toolbar, drag the offending icon off the
toolbar and release the mouse button.

I discuss four other Safari toolbar icons in more detail later in this
chapter. Note: Not all of them appear on the default toolbar, so you
may need to add an icon or two, as I describe in the preceding Tip.

2

[T 2

[T 2

2

Home: Click this button (look for the little house)
to return to your home page.

Add Bookmark: Click this toolbar button (carries a
plus sign) to add a page to your Bookmarks bar or
Bookmarks menu. Read more about bookmarks later
in this chapter.

Print: Click this button (which bears a printer icon)
to print the contents of the Safari window.

Search: Type text in this box to search Google,
Yahoo!, or Bing (all popular search engines) for a
subject or site available on the web. (People use
these search engines to find everything from used
auto parts to former spouses.)
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A tiny padlock icon appears in the upper-right corner
of the Safari window when you're connected to a
secure website. You'll also notice that the http in
the Address field changes to https to indicate the
connection is secure. This is A Good Thing! A secure
site encrypts the information you send and receive,
making it much harder for other people to steal
credit card numbers and personal information, for
example. Never — I mean never — enter any valuable
personal or financial information on a web page
unless you see the secure-connection padlock
symbol.

Search the Web

Looking for something in particular on the web? We all need specific
information from time to time, and Safari makes it easy to use Google
to dig through the entire web:

266

1. Launch Safari.

2. Click in the Search box and type the text that you want to

find on the web.

®

3. Press Return to display the results, as shown in Figure 14-3.

You can search for a specific name or phrase by
enclosing it within quotes, such as “Louis Armstrong”
or “combustion engine.” Otherwise, you'd get hits
(possible sources) on Louis, and Armstrong, and
Louis Armstrong. Too many.

4. Click any of the underlined links on the Search results

page to jump to that website.

®

To repeat a recent search, click the down arrow in the
Search box and select your search term from the pop-
up menu.
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Click any link to go to that web page. Search box
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Search \bout results (0.39 seconds
| i MLC Books Online
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Images (o] 2011 — Jam to MLC RADIO ONLINE! Ready for a heady mixture of classic 70's
Maps music? If you're using a broadband DSL or cable modem connection ...
Videos MLC Radio Online - A 70s Time Machine - Radio Flood
www.radioflood. com/detail/33217 html
News MLC Radio Online - A 70s Time Machine. Free Internet Radio - Shoutcast Radio -
Thousands Of Free Online Radio Stations. http:/fwww.shoutcast.com. 70 8 Mix ...
Shopping|
More Online Radio: MLC Radio Online - A 70's Time Machine - Radio Pervii
www.radio.pervii.com/en/70s/16714 htm - United Kingdom
23 November 2011 Live now: James Taylor - How Sweet It Is (To Be Loved By You)
Columbik, MO Genres: 70s Mixed Bitrate:128 kbps.
Change I§catio . ) . i ) . ) .
4 Online Radio: MLC Radio Online - A 70's Time Machine - Radio Pervi

www._radio.pervii.com/en/70s/131144 htm - United Kingdom
Show search tools mic radio online - a 70's time mach ... 44100 Hz, 128.0 kbit ... If you want add new url
radio address, please leave a comment in contacts. Your name : 8+9= ...

MLC Radio Online - A 70s Time Machine Listen internet Other radio ...
play.internet-radio-guide.net/...radio-online/.../mic-radio-online-a-70
MLC Radio Online - A 70s Time Machine internet radio web live stream.

Homepage - RMLC - Radio Music License Committee

radiomlc.org/
3. 2010 — The Radio Music License Committee (RMLC") represents the
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www.stationportal.com/stationhistory.aspx ?StationlD=27410
\What's rarantly nlauad on MLEC Radia Onlina - A 70z Tima Maching \Want to ha ahla t

Figure 14-3

Find Content on a Web Page

If you're looking for specific text on the web page currently displayed
in Safari, there’s no reason to manually scan the entire contents of the
page! Instead, use Safari’s Find feature to locate every occurrence of
that text within the page:

1. After displaying in the Safari window the web page you
want to search, press 8+F (or choose Edit>Find=Find).

2. Safari displays the Find bar (which appears directly under
the toolbar).
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3. Type the word or phrase you're looking for in the Find
box — no need to press Return. Safari highlights any
matches it finds, as shown in Figure 14-4.

Safari highlights matching words.

Find bar

Ic radio online - Google Search "
&) |E| + -"lhltp / fwww.google.com/search?clientfsafari&rls=en&q=MLC+Radio&ie=UTF-8&oe=UTF- & | (O~ IEl
=  Howrse Atari 400/800 Games Google Apple Yghoo! VYouTube Wikipedia News (356)¥ Popularv CNN The Internat. upport Page »
|| micradio online - Google search [~ +
9 matches (4| » Q- 70s Done

I Everything MLC Books Online
www.micbooks.com/
Images Oct 5. 2011 — Jam to MLC RADIO ONLINE! Ready for a heady mixture of classic 70's
" music? If you're using a broadband DSL or caple modem connection ...
Videos MLC Radio Online - A 70s Time Machine - Radio Flood
www. radioflood.com/detail 33217, html
News MLC Radio Online - A 70: ine. Frpe Internet Radio - Shoutcast Radio -
Thousands Of Free Online io Statipns. http://www.shoutcast.com. 70 8 Mix ...
Shopping
More
www.radio.pervii.com/en|7 (s m - United Kingdom
23 November 2011 Live now: James Taylor - How Sweet It Is (To Be Loved By You)
Columbia, MO Genres: |70z Mixed Bitrate:128 kbps.
Change location

Online Radio: MLC Radio Online - A 70's Time Machine - Radio Pervii
wunw.radio. pervii.com/en|70s131144.htm - United Kingdom

Show search tools mic radio online - a 70's time mach ... 44100 Hz, 128.0 kbit ... If you want add new url
radio address, please leave a comment in contacts. Your name : 8+9= ...

MLC Radio Online - A|70s|Time Machine Listen internet Other radio ...
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www.radiomlc.org/
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Athat's racantly plavad an MILC Radin Onlina - A170:| Tima Machin \Alant tn ha ahla

Figure 14-4

4. Click the Next button on the Find bar to advance to each
spot within the page in order, all the way to the bottom
of the page. To search upward to the top of the page,
click Previous.

5. When you're finished searching, click the Done button.

Add Pages to the Reading List

Safari includes a Reading List, where you can store pages until you
have time to read them. To use the Reading List, follow these steps:
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1. While viewing a page, click the Show Reading List icon at
the left side of the toolbar; the icon looks like a pair of
eyeglasses. Alternatively, choose ViewtoShow Reading List.

Safari displays the Reading List pane at the left side of the
window, as shown in Figure 14-5.

Show Reading List icon

800 Gingrich Gave Push to Clients, Not Just Ideas - NYTimes.com e
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Reading List pane
Figure 14-5

2. To add the currently displayed page to the list, click the
Add Page button.

Hide the Reading List pane by clicking the toolbar
icon again while you continue browsing, or you can
leave the pane open.
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When you're ready to read pages you've saved, display the Reading List
pane again (if necessary) and click on the desired page entry.

When you're finished reading the page, remove it from your list. Just
hover your pointer over the item and click the Delete button that
appears (it bears an X symbol). To delete all pages from your list, click
Clear All.

Set Up a Home Page

270

Tired of www.apple.com as your home page? You can easily choose
a different web page that you check often during the day, or even open
Safari with a blank page:

1. Display the web page you want as your new home page

in Safari. (I recommend selecting a page with few graph-
ics or a fast-loading popular site.)

2. Choose Safaric>Preferences or press 38+, (comma).

3. Click the General button to display the General pane, as

shown in Figure 14-6.

el [d O =@/ o L & i

General | Appearance Bookmarks Tabs RSS  AutoFill Security Privacy Extensions Advanced

General

Default web browser: | & Safari (5.1.1)

Default search engine: | Google

New windows open with: | Homepage
New tabs open with: | Empty Page
Homepage: | http://www.apple.com/

Set to Current Page
Remove history items: | After one month

Save downloaded files to: | [&] Downloads
Remove download list items: | Manually
IET Open “safe” files after downloading

“Safe” files include movies, pictures, sounds,
PDF and text documents, and archives

Figure 14-6
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4.

Click the Set to Current Page button.

click the New Windows Open With pop-up menu

@ To set a blank page (for the fastest window display),

5.

and choose Empty Page.

Click the Close button to close the Preferences dialog.

Bookmark a Website

3.

You can set up bookmarks within Safari that make it easy to jump
directly to your favorite pages. (Unlike pages on your Reading List,
bookmarks are meant to remain after you visit the page — you can
return to bookmarked pages in future browsing sessions.) To book-
mark a website, follow these steps:

Launch Safari and navigate to a page.

. Choose Bookmarks>Add Bookmark or press the 8+D

keyboard shortcut. (You can also click the Add Bookmark
button on the toolbar, which appears just to the left of
the Address box and carries a plus sign.) Safari displays a
sheet where you can enter the name for the bookmark
and also select where it appears (on the Bookmarks bar,
which appears right below the toolbar, or the Bookmarks
menu at the top of the window).

Type a name and choose where to store the bookmark
from the drop-down menu.

mark entries and a submenu for the Bookmarks Bar

@ The Bookmarks menu includes both its own book-

4.

entries (Bookmarksw>Bookmarks Bar), so you can
reach both sets of bookmarks from the menu.

Click Add.

To find all your bookmarks, click the Show All Bookmarks button
(which carries an open book icon). The Collections pane (which
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displays everything on the Bookmarks Bar and Menu, as well as any
Bookmark Folders you've created), shown in Figure 14-7, opens in a
separate pane on the left side of the Safari window. Or from the menu,
choose Bookmarks=>Show All Bookmarks.

Show All Bookmarks icon

& [Safari File FEdit View History Bookmarks Window Help $ 40 a [ <> 4) Wed 2:27 AM Mark Chambers Q.
(2] Bookmarks Menu "
|%|§| [ur) [+ @nupymicbooks.com,  ¢|(Qcooge  ©)[0]
) £ Atari 400/800 Games Google Apple YouTube Wikipedia Popular ¥ CNN

Bookmarks Menu

COLLECTIONS
(&) History
1] Bookmarks Bar
B Bookmarks M
|| Address Book
9 Bonjour
[ All RSS Feeds

Bookmark Address

@ Apple http:/ fwww.apple.com/
A www.michooks.com http:/ fmichooks.com/

Collections pane Bookmarks organized in a folder.
Figure 14-7

Organize Bookmarks
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The more bookmarks you add, the more unwieldy the Bookmarks
menu and the Collections pane become. To keep your bookmarks
organized, follow these steps to create folders or do a little
spring-cleaning:
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1. With Safari open, choose Bookmarks=>Add Bookmark
Folder.

2. Type a name for the new folder and press Return.

3. Drag bookmarks into the new folder to help reduce the
clutter.

4. To delete a bookmark or a folder from the Collections
pane, click it and then press Delete.

To choose a bookmark from within a folder, display the Collections
pane and click the folder in the list at the left, and then click on the
desired bookmark.

View Your Browsing History

To keep track of sites you've visited, you can display the History list.
Your browsing history is the tool of choice when you want to quickly
return to a site that you recently visited (but haven’t bookmarked or
added to your Reading List). Follow these steps:

1. With Safari open, click the History menu.

2. To return to a page in the list, choose it from the History
menu.

3. Hover your pointer over past dates to display the sites

you visited on those days, and click to jump to a page, as
shown in Figure 14-8.

If you're not keen on keeping a list of where you've been, see the later
section, “Delete Cache and History Files.”
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Figure 14-8

Use Tabs

Safari also offers tabbed browsing, which many folks use to display (and
organize) multiple web pages at one time. For example, if you're doing
a bit of comparison-shopping for a new piece of hardware between
different online stores, tabs are ideal.

1. With Safari open, hold down the 8 key and click a link

or bookmark to open a tab for the new page (which

appears under the Bookmarks bar).

You can also choose File>New Tab or press 38+T to

work the same magic.

2. Click a tab at any time to switch to that page, as shown

in Figure 14-9.
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Open tabs
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Figure 14-9

You can remove a tabbed page by clicking the X button
next to the tab’s title.

To change settings for tabbed browsing (such as set-
ting Safari to always open new web pages in tabs
rather than windows), choose Safari>Preferences to
display the Preferences dialog and then click Tabs.

Download Files

If you visited a site that offers files for downloading, click the
Download button or the Download File link, and Safari takes care of
the rest. You see the Downloads pop-up list, which keeps you updated
on the progress of the transfer. While the file is downloading, feel free

275

www.it-ebooks.info


http://www.it-ebooks.info/

Part IV: Exploring the Internet

to continue browsing or even download additional files; the download
list helps you keep track of what'’s going on and when everything will
finish transferring. You can view the download list at any time by
clicking the Show Downloads button at the upper-right corner of the
window (which carries a down-arrow symbol), or by choosing
View=>Show Downloads.

Mac OS X Downloads folder on the Dock. To change
this, choose Safari>Preferences and click the General
button. Click the Save Downloaded Files To pop-up
menu and select a new location.

@ By default, Safari saves any downloaded files to your

To download a picture that appears on a web page, move your mouse
pointer over the picture and right-click. Then choose Save Image As
from the shortcut menu that appears. Safari prompts you for the loca-
tion where you want to store the file. To save the picture directly to your
Downloads folder on the Dock, choose Save Image to Downloads from
the right-click menu.

When a file has finished downloading, it remains as an item in the
download list, but you can click the Clear button in the list to delete
all successfully downloaded entries.

Keep Your Finances Safe Online
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Unfortunately, no list of “absolutely safe” online banks or investment
companies exists. Online security is a concept you should constantly
monitor while exchanging information with websites, especially when
that information includes personal data such as your Social Security
number and credit card information.

Keep these guidelines in mind while using online commerce sites to
greatly reduce the risk of identity theft (or worse):

m= Never use an online bank or investment house
that doesn’t offer a secure, encrypted connection
when you enter your personal information and
credit card number. If you're using Apple’s Safari
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browser, the padlock icon appears in the upper-right
corner of the Safari window. When the padlock icon
appears in the window, the connection is encrypted
and secure (and the address will start with the prefix
https rather than http). If the connection isn’t
secure, go elsewhere.

Avoid using Safari's AutoFill feature. If you fill out
many forms online — when you're shopping at web-
sites, for example, or trading online — you can add the
AutoFill button (which looks like a little text box and a
pen) to your toolbar. AutoFill can complete these
online forms for you. To be honest, however, I'm not a
big fan of releasing any of my personal information to
any website, so I never use AutoFill. You can specify
which information is used for AutoFill (or disable it
entirely) by running Safari and choosing Safari=>
Preferences. Clicking the AutoFill toolbar button in the
Preferences dialog displays the settings — to disable
AutoFill, just clear each check box.

If you decide to use this feature, make sure that the
connection is secure (again, look for the padlock
icon in the upper-right corner of the Safari window)
and read the site’s Privacy Agreement page first to see
how your identity data will be treated.

Look for a security symbol. A number of well-
respected online security companies act as watchdogs
for online banking and investing institutions. When
you see the symbol for one of these companies, it’s a
good indicator that the bank or broker is interested
in maintaining your privacy and protecting your
identity. Some of the better-known security compa-
nies on the web include TraceSecurity (www . trace
security.com), VeriSign (www.verisign.com),
and WebSense (www.websense . com). Luckily, you
don’t have to implement all the software and
assorted protection protocols that run behind the
scenes when you connect to your bank!
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Delete Cache and History Files

Safari speeds up the loading of websites by storing often-used images
and multimedia files in a temporary storage, or cache, folder. Naturally,
the files in your cache folder can be displayed, which can lead to
assumptions (hint, hint) about the sites you've visited.

Luckily, Safari makes it easy to dump the contents of your cache file.
Choose Safari>"Empty Cache; then click Empty to confirm that you
want to clean up your cache.

In a similar fashion, your History file leaves a clear set of footprints
indicating where you've been on the web. Maybe you don’t want
everyone to know you've been spending all your free time checking
out World of Warcraft online. If so, you can clear out your browser his-
tory. To do so, choose History=>Clear History.

Safari also allows you to specify a length of time to retain entries in
your History file. Choose Safari>oPreferences, click the General tab,
and then click the Remove History Items pop-up menu to specify a
length of time. Items can be rolled off daily, weekly, biweekly,
monthly, or yearly.

Delete Cookie Files

278

A cookie (a ridiculous term) is a small file that a website automatically
saves on your hard drive, containing information that the site will use
on your future visits. Unfortunately, for these purposes, cookies aren’t
yummy treats that we make from flour, sugar, butter, and eggs. For
example, a site might save a cookie to preserve your site preferences
for the next time or — in the case of a site such as Amazon.com — to
identify you automatically and help customize the offerings you see.

In and of themselves, cookies aren’t bad things. And unlike a virus, a
cookie file doesn’t replicate itself or wreak havoc on your system, and
only the original site can read the cookie it creates. However, many
folks don’t appreciate acting as gracious hosts for a slew of little snip-
pets of personal information.
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You can choose to accept all cookies — the default setting — or opt to
disable cookies altogether. You can also set Safari to accept cookies
only from the sites you choose to visit. To change your cookie accep-
tance plan (or CAP, if you absolutely crave acronyms), click the Safari
icon on the Dock and follow these steps:

1. Choose SafaricoPreferences.
2. Click the Privacy button.

Safari displays the Privacy preference settings, as shown
in Figure 14-10.

CXeX

0 O wE [/ Ok

General Appearance Bookmarks Tabs RSS  Autofill Security | Privacy

Privacy

o )

Extensions Advanced

Cookies and other website data: | Remove All Website Data..

1130 websites stored cookies or ather dara | Derails.._

Block cookies: (&) From third parties and advertisers F— Most MOC users

() Always

O Never should select this
Limit website access to location services: () Prompt for each website once each day COOk|e Ophon .

(_) Prompt for each website one time only

) Deny without prompting k 7 )

Figure 14-10
3. Choose how to block cookies (select one radio button):

e From Third Parties and Advertisers: 1 use this option,
which allows sites such as Amazon.com to work cor-
rectly without allowing a barrage of illicit cookies.

e Always: Block cookies entirely.

e Never: Accept all cookies, which essentially allows any
site to save cookies on your Mac.

4. To view the cookies now on your system, click the Details
button.
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If you block all cookies, you might have to take care
of some tasks manually, such as providing a pass-
word on the site that used to be read automatically
from the cookie.

5. Click the Close button to save your changes.

Delete the Safari Download History

Safari makes it easy to clear the list of files you downloaded over time.
The file list is maintained within the “pop-up” Downloads window,
which appears whenever you click the Downloads button (bears a
down-arrow icon) at the top-right corner of the Safari window. (You
can also display the Downloads window at any time by clicking View
on the Safari menu bar and then choosing the Show Downloads
item.)

To keep your Safari Downloads window tidy (and prevent other peo-
ple from seeing what you've been pulling down from the web), click
the Clear button at the top right of the Downloads window. Safari

removes any entries for downloaded items you successfully received.

Print a Web Page

Many web pages have a button you can click to print the page. If you
want to print a page and it doesn’t have a Print button or link, follow
these steps:

1. Click the Print button on the toolbar, choose FilersPrint
from the menu, or press 38+P.

2. Click the Printer pop-up menu to select the printer you
want to use, as shown in Figure 14-11.

3. When you're ready to print the pages, click Print.
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Keeping in Touch
by E-Mail

Mac OS X includes quite a capable and reli-
able e-mail client — Apple Mail (affec-
tionately called Mail by everyone except Bill
Gates). Mail provides all you need in order to

w= Send and receive e-mail messages.
m= Screen junk mail from your Inbox.
m= Receive and send attachments.

w= [Update your Address Book with new
e-mail contacts.

w= Organize your mail using folders.

Naturally, your Mac needs to be connected to
the Internet before e-mail starts flying into
your Inbox — if you haven't set up your
Internet connection yet, visit Chapter 13 for all
the details.
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Set Up an Internet E-Mail Account

Most Mac owners choose one of three sources for an Internet e-mail
account;

w= An existing Internet service provider (ISP): If you're
signed up with an ISP, that company almost cer-
tainly will provide you with at least one e-mail
address as part of your service. Contact your ISP for
your e-mail account information. Popular ISPs
include Mediacom, EarthLink, and Charter.

w= Apple’s iCloud online service: iCloud members
receive free e-mail service from Apple. Your iCloud
e-mail address should be yourname@me . com, where
yourname is the username you chose when you sub-
scribed. (I go into more detail on iCloud, Apple’s free
Internet service for storing data, in Chapter 13.)

w= A web-based e-mail provider: Many sites on the
web offer free e-mail services, such as Google Gmail,
Yahoo! Mail, and Microsoft Hotmail. You can sign
up for these e-mail accounts online. (I use and rec-
ommend Google Gmail, which you can access at
www . google . com. Just click the Gmail link in the
upper-left corner to start the sign-up process. If
you're using an Android-based smartphone, you can
use the Gmail address you've already set up.)

Apple Mail can accommodate most e-mail services, no matter where
they're hosted.

you use with Windows Mail, Microsoft Outlook, or
Outlook Express on your PC, you can use that
account easily under Apple Mail.

@ If you already have an existing e-mail account that

Note that iCloud e-mail accounts are set up automatically for you
within Apple Mail, so you typically don't have to follow the process

outlined in the next section for your iCloud account.
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After you set up an e-mail account with your ISP or another provider,
you need to add that account so that Apple Mail can access it.

Follow these steps to add an account to Apple Mail:

‘}'& looks like a postage stamp.

1. Launch Mail from the Dock by clicking the icon that

2. If the Add Account Assistant doesn’t automatically
appear, as shown in Figure 15-1, choose Files>Add

Account to display it.

Add Account

Add Account

You'll be guided through the steps to set up an
additional account.

To get started, provide the following information:

"" Full Name: |Mark Chambers
Email Address: |example@example.com

Password: ese

3

(?7) Cancel Go Back

| Continue

}— Fill in each field
and click Continue.

Figure 15-1

3. Type your full name, and then the e-mail address and the
password assigned to you by your ISP. (Mail uses the
e-mail address and password to log in to your ISP and

retrieve your messages.)

4. Click Continue.
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an e-mail service, such as Google Mail, it attempts to
automatically set up that account for you. If the setup
and testing are successful, you can skip the rest of
these steps.

@ Here’s a neat trick: If Mail can immediately recognize

5. In the next window that opens, click the Account Type
box and choose the type of account you're using (typi-
cally POP for most free services, including Gmail and
Microsoft’s Hotmail). Then click in the Incoming Mail
Server text box and type your incoming server address, as
shown in Figure 15-2. (Your e-mail provider should pro-
vide you with this information — if you're unclear what
goes where, I recommend a telephone call to the ISP’s
technical support number.)

Add Account

Incoming Mail Server

Account Type: | @ POP : ~€&—— Choose the type of

DA Description: |(optional) account YOUIre Using.

Incoming Mail Server:  mailserver.example.com F_ Enfer ]‘he incoming
User Name: |example mc1|| server.

‘-,' & Password: |ses

@) Cancel Go Back | Continue

Figure 15-2

can type a description for this account, such as work

@ To help keep track of multiple e-mail addresses, you
or home.

6. Click Continue.
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7. If your e-mail service uses SSL security (which encrypts
your e-mail communications and makes it harder for
someone else to intercept and read), select the Use Secure
Sockets Layer check box. After you select the Use Secure
Sockets Layer check box, Mail prompts you to choose an
authentication type, as shown in Figure 15-3. (Again,
your e-mail service provider should tell you whether it
uses SSL and what kind of authentication is required.)

Add Account
Incoming Mail Security
E‘]Use Secure Sockets Layer (S5L)

! Authentication: | Password : <€——— Choose the

¥ correct type of

y authentication.

'ql. ]
@) Cancel Go Back | Continue |
Figure 15-3

8. Click Continue.

9. In the next window that opens, click in the Outgoing
Mail Server text box, type your outgoing server address,
and then enter your username and password if authenti-
cation is required. (Yep, you guessed it — only your ISP
can tell you what to type here.)

710. Click Continue.

1 1. Click Create on the assistant’'s Summary screen to create
your account within Apple Mail.
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Get to Know Apple Mail

Figure 15-4 illustrates the Mail window. Besides the familiar toolbar,
which naturally carries buttons specific to Mail, you find these elements:

w= Status bar: This heading bar at the top of the Mail
window displays information about the current
folder — typically, how many messages it contains,

but other data can be included.

Mailbox list

Inbox Trash

Status bar

Preview box

® Mail File fdit |View Mailbox Message Format Window] Help [ 4» Thu9:37 PM Mark Chambers 1
800 Jinbox — Gmail (425 messages)| "
(A .=/[B8] (@ [ (<= |[=][®] Q
[ Hide | Inbox ¥ lent | Notes ¥ Flagged Drafts *

MAILBOXES ort by Date v
- Richard K 701 eBay Detals
| Q‘ fnbex Re: Rocky Horror 2011 at the Blue Note! Urdates for your purchase
Q MLC Books : : June 27,2011 11:33 AM
& iCloud
Gma Lone Star Steakhouse & Saloon 7M1 3
L $7.50 OFf name is included to show this message onginated from)
- E‘ Drafts : eBay. Learn more
b < Sent Here's your order update.
- E;w el ( Online@motel6.com 7611 View your updates
Motel 6 Reservation Confirmation e
& Junk Thanks for shopping on eBay! To help you keep | GO to order details J
track of your purchases, we're sending you this N
| s Celebrity Saloon 7M1 order update.You can also keep track of all your (
¥* Flagged John Travolta, Daniel Graig, Conan and More! purchases in My eBay.
> ﬁ Notes
Recent updates to your order
ON MY MAC Owlient - English Support 721 Tracking information is available for your item(s).

(] DVD Releases Ticket Closed (Admin)

£ wiley
CMAIL Lone Star Steakhouse & Saloon 6/28/11 Seller: Member id ( Feedback Score Of 2150 * )
> (] [Gmail] Lone Star, §7.50 OFF 2 Entrees Apple MacBook Unibody White 2.4GHz 2GR 25068 LED NICE

E’ Junk E-mail @ Paid on Jun-26-11

{3 Sent ltems eBay 627111 & Shipped on Jun-27-11 Qty: 1
L= Updates for your purchase Estimated delivery: July 11 - July 18, 2011 USPS Parcel Post

eBay sent this message to Mark Chambers
Note: Tracking information can take up to 48 hours to
be updated online after the order is shipped.
eBay 6/26/11
Thank you for purchasing Apple MacBook Unibo...
Email reference id: [#32bd#]
Please don't remove this number. eBay customer support may ask you for this
redbox 622111 number, if you should need assistance.
Have one on redbox! You've earned
Learn More to protect yourself from spoof (fake) emails.
+ E % " . - - : s
emana

}

Add button
Figure 15-4
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2

®

2

2

Message list: This box contains all the messages for
the chosen folder. To resize the list larger or smaller,
move your cursor over the border of the message list.
When the cursor changes to a double-sided arrow,
drag the border in the desired direction.

You can sort the messages in the message list from
the View menu.

Mailboxes: The column to the left of the main Mail
window is the Mailboxes list. (It's helpful to think of
a mailbox within Mail as a group of folders tied to
one account.) Click any of the folders to switch the
display in the message list. The Mailbox list can be
hidden or shown from the View menu by choosing
the Show Mailbox List option.

Preview box: This resizable list box displays the con-
tents of the selected message, including both text and
any graphics or attachments that Mail recognizes.

Mail uses the following folders (some of which appear at only certain
times):

2

1=

2

2

[T 2

Inbox: Mail already received.

Outbox: Messages that Mail is waiting to send.
Drafts: Messages waiting to be completed.
Sent: Mail you sent already.

Trash: Deleted mail. Like with the Trash in the
Dock, you can open this folder and retrieve items.
Alternatively, you can empty the contents of the
Trash at any time by choosing Mailbox=>Erase
Deleted Items=In All Accounts.
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w= Junk: Junk mail. You can review these messages or
retrieve any that you want to keep by choosing
MessageroMove To. After you're sure that nothing of
value is left, you can delete the remaining messages
straight to the Trash. (Junk mail filtering must be
enabled before you see this box; more on this later
in this chapter.)

Manage E-Mail Accounts

290

Choose Mail=>Preferences and click the Accounts button to display the
Accounts pane, as shown in Figure 15-5. From there, you can add an
account, edit an existing account, or remove an account from Mail.
Although many folks still have only one e-mail account, you can use a
passel of them. For example, you might use one account for your per-
sonal e-mail and one account for your business. To switch accounts,
just click the account that you want to use from this list to make it the
active account.

You can also edit any field on the Account Information tab. For exam-
ple, if you decide to change your e-mail “From” name, click in the Full
Name text box, press the Delete key to erase the existing name, and
then type a new name. Similarly, if you have to change your password
for your e-mail user account, click in the Password box, delete your
current password, and then type your new password. (Note that the
contents of the Password box are always displayed as dots, just to keep
your password secure.)

Sometimes you can’t reach one of your accounts. For example, maybe
you're vacationing with your MacBook and you can't access your ISP’s
mail server directly. To avoid all the error messages and futile attempts
to connect to an e-mail provider you can't reach, Apple Mail lets you
enable and disable specific accounts without enduring the hassle of
deleting an account and then adding it again.

To disable or enable an account, choose Mail=>Preferences to open the
Preferences dialog and click the Accounts button. Click to select an
account, click the Advanced tab, and then select (or deselect) the
Enable This Account check box as necessary.
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Your e-m0i| accounts Chonge YOUI' name.
&m0 Accounts
S T
RSS! i ' V4 / T2
o ol ) L |l
General | Accounts | RSS  Junk Mail Fonts & Colaors Viewing Composing Signatures| Rules
Accounts [ Account Information  Mailbox Behaviors  Advanced |
s Gmail
Gmail POP
Account Type: Cmail POP
Description: | Gmail
Email Address: | ml@gmail.com
Full Name:  Mark Chambers —~egf—
Incoming Mail Server: | pop.gmail.com
User Mame: ml
Password: ssssssssss %
Outgoing Mail Server (SMTP): | smtp.gmail.com:ml } t]
"] Use only this server
+ |- For support, visit Gmail Help Center l"?'l

Figure 15-5

If you disable an account, you should also deselect

the Include When Automatically Checking for New

Mail check box to make sure that Mail doesn’t dis-

play an error message.
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Read and Delete E-Mail

4

292

The heart and soul of Mail — at least the heart, anyway — is receiving
and reading stuff from your friends and family. After your account is
set up, use any of these methods to manually check for new mail:

wsp  Click the Get Mail button on the toolbar.

w= Choose Mailboxm>Get All New Mail or press
38 +Shift+N.

w= Choose Mailbox=>Get New Mail and then choose the
specific account to check from the submenu.

mail in another account without having to make it
active in the Preferences window.

@ The last method is a helpful way to check for new

If you have new mail in the active account, the mail appears in the
Message list. New, unread messages are marked with a snazzy blue dot
in the first column. The number of unread messages is displayed next
to the Inbox folder icon in the Mailboxes list.

unread messages you received. If you hid the Mail
window or sent it to the Dock, you can perform a
quick visual check for new mail just by glancing at
the Dock.

@ Mail also displays on its Dock icon the number of

To read any message in the message list, you can either click to select
an entry (which displays the contents of the message in the preview
box) or double-click the entry to open the message in a separate
window.

To quickly skim your mail, click the first message that you want to
view in the list and then press the down-arrow key when you're ready
to move to the next message. Mail displays the content of each mes-
sage in the preview box. To display the previous message in the list,
press the up-arrow key.
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If your vision isn't what it once was, why not let Mail
read you your mail? Simply select one message or a
group of messages and then choose Edit>Speech=>
Start Speaking. Wowsers!

To delete a message from the message list, click an entry to select it
and then click the Delete button on the toolbar (or press the Del key
on the keyboard). You can also right-click any message in the list and
choose Delete from the menu that appears. To delete a message from
within a message window, click the Delete button on the toolbar.

Reply to a Message
Replying to a message you receive is easy. Follow these steps:

1. Click to select a message entry in the Message list and
then click the Reply button on the Mail toolbar (which
bears a single arrow curving to the left).

To respond to a message that you opened in a mes-
sage window, click the Reply button on the toolbar
for the message window.

If a message was addressed not just to you but also to a
number of different people, you can send your reply to
all recipients. Just click the Reply All button on the Mail
window toolbar (it bears two arrows curving to the left).
This technique is a useful way to quickly facilitate a fes-
tive gathering, if you get my drift.

Mail opens the Reply window, as shown in Figure 15-6.
Note that the address has been added automatically
and that the default Subject is Re: <the original
subject>. Mail automatically adds a separator

line in the message body field that reads On
<day><date>at<time>, <addressee> wrote:, fol-
lowed by the text of the original message. The original
text is indented and prefaced by a vertical line to set it
apart.

293

www.it-ebooks.info


http://www.it-ebooks.info/

Part IV: Exploring the Internet

(Optional) Click in the Subject line and change the
default Subject line; otherwise, the cursor is already sit-
ting on the first line of the text box.

2. Start typing your reply in the text box.

Begin typing your reply.

800 Re: I've got a great real estate deal for you!

(=] [« ]|

To Fuad Ramses

Cc
Subject: Re: I've got a great real estate deal for you!

= v| From:| Mark Chambers + || Gmail

On Jan 12, 2012, at 8:07 PM, Fuad Ramses wrote:

How about buying some of my ocean-front property in Kansas? It's all the rage - and very exclusive!

Figure 15-6

3. (Optional) After you complete your reply, you can select
text in the message body and apply different fonts or for-
mats. (See the section, “Format E-Mail Messages,” later in
this chapter, for more information.)

4. (Optional) To add an attachment, click the Attach button
on the toolbar (which bears a paper clip icon). See the
upcoming sections, “Send an Attachment” and “Save an
Attachment That You Receive,” for the full lowdown on
attachments.

5. When you're ready to send your reply, you have two options:

e Click the Send button (bearing the nifty paper airplane
icon) to send the message immediately.

® Choose Filew>Save (or press 38+S) to store it in your Drafts
folder for later editing.
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Saving the message to your Drafts folder isn't the same as sending it.
You can save the message for a while so that you can later come back
and finish it. To send a message held in your Drafts folder, click the
Drafts folder in the Mailboxes list and then double-click the message
you want to send. Mail displays the message window — you can make
edits at this point, if you like — and then click the Send button on the
message window toolbar.

your reply to another person (rather than the original
sender). The new addressee receives a message con-
taining both the text of the original message you
received and your reply. To forward a message, click
the Forward button (which bears a right-facing arrow)
rather than Reply or Reply All on the Mail toolbar.

@ When you reply to a message, you can also forward

Create and Send E-Mail

[

To compose and send a new message to someone else, follow these
steps:

1. Click the New Message button on the Mail toolbar (which

bears a pencil and paper icon). You can also choose
File>New Message (or avail yourself of the handy 8+N
keyboard shortcut).

Mail opens the New Message window, as shown in
Figure 15-7.

2. Enter the recipient’s (To) address by taking one of these

actions:
e Type it directly in the To field.

e Paste it after copying it to the Clipboard, which I
discuss in Chapter 8.

¢ Drag an e-mail address from your Address Book.
(Read all about how to add Address Book contacts
by using Mail, later in this chapter.)
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Send your message.
Attach a file.

Open the Addresses window.

ey o
(=])[e])(e] (2]

Send Chat  Amach Address

New Message

(=] (E]

Photo Browser Show Stationery

To

Cc
Subject

E_E ¥ | From E_Mark Chambers ¢ i__Gmali

Figure 15-7

e Click the Address button, which shows you the
Addresses window, as shown in Figure 15-8. The
Addresses window displays the contacts you have
in your Address Book that include an e-mail
address. Click to select the address you want to use
and then click the To button. To pick multiple
recipients, hold down the 3 key while you select
the multiple addresses. Click the Close button in

the Addresses window to close it.

Click to add addresses to your message.

Addresses

Name Email
|| Soccer Hatline

E‘JI Directory Services [L|RIS

anexample@example.com

scards (Q

| | JC Penney
|* | Bob LeVitus

Select the address you want.
Figure 15-8
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(Optional) To send “carbon” copies of the message to
additional recipients, click in the Cc field. Again, you can
type the addresses directly, use the contents of the
Clipboard, or display the Addresses window.

If you use the Addresses window, select the addresses you
want to use and click the Cc button. Then click the Close
button in the Addresses window.

. Click in the Subject field, enter the subject of the mes-

sage, and then press Tab.

The text cursor now rests in the first line of the message
text box, and you're ready to type your message, my
friend!

. Type your message in the message box.

(Optional) Click the Show Stationery button at the far
right of the message window toolbar to display the
Stationery strip above the message text box, where you
can choose one of the many e-mail message backgrounds
that Apple supplies.

Stationery isn’t required, but it truly packs a visual wal-
lop! Double-click a thumbnail in the strip to add it to
your message; to display a different stationery category,
such as a Greeting or Invitation, click the category but-
tons on the left side of the Stationery strip.

rectly display a message with a stationery background,

@ Not all e-mail applications on other computers cor-

so if a recipient can’t open or read the message, avoid
sending stationery to that person in the future. Also,
it's important to note that adding a stationery back-
ground significantly increases the message size (and
therefore the transfer time to send and receive it, espe-
cially over a dial-up modem connection).
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7. (Optional) After you finish typing your message, you can
select text in the message body and apply different fonts
or formats. (I cover formatting in the “Format E-Mail
Messages” section, later in this chapter.)

8. (Optional) To add an attachment, click the Attach button
on the toolbar. (Attachments are described in the follow-
ing section.)

9. When you're ready to send, click the Send button to
immediately send the message, or press 3+S to store the
message in your Drafts folder.

Send an Attachment

Attachments are a fun way to transfer files by e-mail. However, you
must remember these three vital caveats:

w= Attachments can contain viruses. Even a message
attachment that was sent by your best friend can
contain a virus — either because your friend unwit-
tingly passed one along or because the virus took
control of your friend’s e-mail application and repli-
cated itself automatically. (Ugh.)

Never — I mean never — send or receive attachments

@ unless you have an up-to-date antivirus scanning
application running. I discuss antivirus applications
in Chapter 13.

w= Corpulent attachments don’t make it. Most ISP
mail servers have a 2-5MB limit for the total size of
a message, and the attachment counts toward that
final message size. Therefore, I recommend sending a
file as an attachment only if it's smaller than 5MB. If
the recipient’s e-mail server sends you an automated
message saying that the message was refused because
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it was too big, this is the problem. To display a file’s
size before you send it, right-click the file’s icon and
choose Get Info from the shortcut menu. (A typical
JPEG is about 1MB, so it's a good idea to send no
more than two or three photos at once.)

w= Not all e-mail applications accept attachments. Not
all e-mail programs support attachments in the same
way, and other e-mail programs are simply set for
pure text messages. If the message recipient receives
the message text but not the attachment, these are
the likely reasons.

With that said, it's back to attachments as a beneficial feature.

While replying to a message (or creating a new message), you can add
an attachment by clicking the Attach button on the toolbar — it’s the
one with the paper clip.

Mail displays a File Open sheet. Navigate to a file, select it, and click
the Choose File button to add the file to the message.

the Send Windows-Friendly Attachments check box
is selected. This results in a slightly larger e-mail mes-
sage, but helps ensure that PC e-mail programs, such
as Outlook and Windows Mail, can correctly open
your attachments.

@ If the recipient is running Windows, make sure that

Save an Attachment That Vou Receive

Sometimes, you don’t want to save (download) attachments that peo-
ple send to you. For example, if Cousin Fred sends you a funny car-
toon that you chuckle at but don't really need to save, you can safely
delete it. But what if someone sends you an attachment, such as a pic-
ture of your grandkids, that you truly want to hang on to? Follow
these steps to save an attachment that you receive in a message:
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1. Click the message with an attachment in your message list.

have attachments, choose Viewr>Message Attributes
and then click the Attachments option from the sub-
menu that appears, to toggle it on. Now every mes-
sage with an attachment appears with a tiny paper
clip icon displayed in its entry.

@ If you're having trouble determining which messages

If Mail recognizes the attachment format, it displays or
plays the attachment in the body of the message; if not,
the attachment is displayed as a file icon.

2. To open an attachment that’s displayed as a file icon,

right-click the icon and choose Open Attachment from
the shortcut menu.

3. To save an attachment, right-click the attachment (how-

ever it appears in the message) and then choose Save
Attachment from the shortcut menu.

In the Save dialog that appears, navigate to the location
where you want to save the file and then click Save.
(Note that you can also change the filename to some-
thing you'll recognize before you click Save.)

Format E-Mail Messages

300

Why settle for a boring, plain-text message when you can add special
fonts and colors? Mail makes it easy to format your messages, much

like you format text in a Pages document.

To change text formatting, choose Format=>Fonts. From the window
that appears, you can choose the font family, type size, and formatting
(such as italic or bold) for the selected text. Click the Close button on

the Fonts window to continue.

To apply color to selected text, choose Format=>Colors and then click
anywhere in the color wheel that appears to select that color. You can
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also vary the hue by moving the slider bar to the right of the Colors
window. After you find the color that expresses your inner passion,
click the Close button in the Colors window to continue.

Add Address Book Contacts

Lion comes equipped with a separate Address Book application, which
you can run by using Launchpad. The Mac OS X Address Book works
just like the paper variety, allowing you to save all sorts of contact data
for each entry. If you receive a message from your niece Harriet and
she isnt in your Address Book yet, you can easily add her to your
Address Book contacts from within Apple Mail (rather than manually
running the Address Book and creating a new entry by hand).

With the message selected in the message list, choose Messager>Add
Sender to Address Book. Mail automatically creates a new contact, and
the person’s name and e-mail address are added automatically to your
Address Book. Could it be any easier?

Customize Apple Mail

Like all other Apple software, Mail is easily customized to your liking
from the Preferences window (shown in Figure 15-9).

To choose a sound that plays whenever you receive new mail, choose
Mailc>Preferences and click the General button. Click the New
Messages Sound pop-up menu and choose one of the sounds that
Apple provides. Choose None from the pop-up menu to disable the
new mail sound altogether.

By default, Mail automatically checks for new mail every five minutes.
To change this delay period, display the General pane in the
Preferences window, click the Check for New Messages pop-up menu,
and then choose one of the time periods.

To disable automatic mail checking, choose Manually; you can click

the Get Mail toolbar button to manually check your mail anytime you
like. (For example, if you're using a dial-up analog modem connec-

tion, you may not fancy Mail taking control of the telephone line

every five minutes.) 301
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800 General

4]

General

@58 6l @ id et 5

Accounts RSS  Junk Mail Fonts & Colors Viewing Composing Signatures Rules

Default email reader: | (& Mail (5.1)
Check for new messages: | Every 5 minutes

New messages sound: | New Messages Sound

Dock unread count: | Inbox Only

Add invitations to iCal: | Never
Downloads folder: | [&] Downloads
Remove unedited downloads: | After Message is Deleted

If outgoing server is unavailable: | Show a list of alternate servers

When searching all mailboxes, include results from:

lgTrash
Junk
Encrypted Messages

@] Play sounds for other mail actions

i —

.

s - —

Ak

Figure 15-9

— Customize
Mail settings.

— Pick a new
sound alert.

If you like, Mail can be set to automatically delete sent mail (and per-
manently erase messages that you relegate to the Trash). To configure
these settings, click the Accounts button in the Preferences window
toolbar, click to select an account, and then click the Mailboxes
Behaviors tab. Then choose what you'd like:

w= Delete sent messages automatically: Click the
Delete Sent Messages When pop-up menu and
choose a delay period or action. You can choose to
delete mail after a day, a week, a month, or immedi-
ately after quitting Mail. Alternatively, you can leave
this field set to Never, and Mail never automatically
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deletes any messages from the Sent folder.

Delete junk messages automatically: Click the
Delete Junk Messages When pop-up menu and
choose a delay period or action. (These options are
the same as the ones available for sent mail.) I dis-
cuss junk mail later in this chapter.
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w= Delete messages from the Trash: Make sure that the
Move Deleted Messages to the Trash Mailbox check
box is enabled, and then click the Permanently Erase
Deleted Messages When pop-up menu and choose a
delay period or action. Again, your choices are the
same as for sent messages.

Add a Signature to All Outgoing Messages

To add a block of text or a graphical image to the bottom of your mes-
sages as your personal signature, follow these steps:

1. Choose Mail=>Preferences and click the Signatures
button.

2. From the Signatures pane that appears, click the Add
Signature button (which carries a plus sign) to display
the new signature entry you see in Figure 15-10.

3. Click the signature name to open an edit box and then
type an identifying name. Press Return to save the new
name.

4. Click inside the text entry box to the right to move the
Cursor.

5. Type the signature itself in the text entry box or copy the sig-
nature to the Clipboard and paste it into the text entry box.

Because downloading a graphical image in a signa-
ture takes a long time — and because some folks still

use plain-text e-mail — I recommend that you avoid
the temptation to include graphics in your signature.

6. If you have multiple signatures, click the Choose

Signature pop-up menu to choose which one you want
to use or to use them all randomly or in sequence.
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Type a name for your signature.

Type the text for your signature.

8e0e Signatures
O = . / 4 S
W] @ B fel| D R
General Accounts RSS  Junk M Fonts & Colors  Viewin omposing | Signatures | Rules
/ _All Signatures  l9nature #1 Mark Chambers
¥~ 1 signature www.micbooks.com
MLC Books
B o signatures
iCloud
G e
Gmail
Hotmail
(L
+ | = Always match my default message font
(Helvetica 12)
Choose Signature: | None
@Place signature above quoted text ( ? )

Figure 15-10

quoted text in a reply, click to select the Place
Signature above Quoted Text check box. (In e-mail
jargon, quoted text refers to the original message text
that’s inserted into your reply. Mail adds the quoted
text so that your recipient can keep track of the con-
tinuing discussion!)

Use Folders

You can add new personal folders to the Mailboxes list to further orga-
nize your messages. For example, you can put into a special folder all
messages from your quilting club that talk about patterns, making it
easy to refer back to them as a group.

@ If you want your signature to appear above the
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To create a new folder within the same mailbox account, click the Add
button in the lower-left corner of the Mail window and choose New
Mailbox from the pop-up menu that appears (or choose Mailbox=>
New Mailbox from the Mail menu). Choose On My Mac as your loca-
tion and then type the name for your new folder in the Name box.
Click OK to create the new personal folder. Remember: This folder
only appears on your desktop Mail. If you check your mail via the
Internet or your iOS device (iPhone, iPad, or iPod touch), you won't
see this folder.

Messages can be dragged from the message list and dropped into a
folder in the Mailboxes list to transfer them. Alternatively, you can
move them from the Message list by selecting the messages you want
to move, choosing Messager>Move To, and then clicking to select a
destination folder.

Handle Junk Mail

Unfortunately, everyone receives junk e-mail (or spam) these days, and
because chucking the First Amendment is not an option, I guess we'll

always have it. (Come to think of it, my paper mailbox is just as full of
the stuft.)

Thankfully, Apple Mail has a net that you can cast to collect junk mail
before you have to read it, and a separate Junk folder in your
Mailboxes list (you can view the unscrupulous contents by clicking on
the Junk folder icon). The two methods of handling junk mail are

w= Manually: You can mark any message in the message
list as junk mail. Select the unwanted message in the
message list and then click the Junk button on the
Mail window toolbar, which marks the message as
junk. However, the junk message is not automati-
cally moved to the Junk folder when it's marked
manually. (If you like, you can drag it there for safe-
keeping, or it can simply stay in your inbox.) If a
message is mistakenly marked as junk but you want
to keep it, click the message to display it in the
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preview box and then click the Not Junk button at
the top of the preview box (or click the Not Junk
button in the Mail tool bar, which sports a thumbs-
up icon), as shown in Figure 15-11.

w= Automatically: Apple Mail has a sophisticated Junk
Mail filter that you can train to better recognize junk.
(Keep reading to discover how.) After you train Mail
to recognize spam with a high degree of accuracy,
turn it to full Automatic mode and it moves all those
worthless messages to your Junk folder.

This e-mail is marked as junk. Undo your Junk marking.

800 Junk (1 mess§ge)

(2](=)(8] [(814)(& ®=+)(E)(F ] a

[ Hide | Inbox~¥ Sent¥ Notes¥ Flagged Drafts ¥ v

MAILBOXES Sort by Date v

~ Y
= 5l Y . (7)] Leadl Not Junk
v (@ Inbox Fuad Ramses = 808 PM fi5] Youmar.. (7) [ Load images || Notjunk |

I've got a great real estate deal for you! Junk - Gmail
@ MLC Books How about buying some of my ocean-front property in Kansas? It's all the Fuad Ramses Details
&) iCloud rage - and very exclusive! Ive got a great real estate deal for you!
@ Cmail January 12, 2012 8:08 PM

@ Hotmail

» B Drafts How about buying some of my ocean-front property in Kansas?
It's all the rage - and very exclusive!

» 5/ Sent
> '\éf Trash
> 5 Junk
REMINDERS
¥ Flagged
> E Notes
ON MY MAC
] DVD Releases
(] Wiley
GMAIL
» (] [Cmail)
(£ Junk E-mail
[_] Sent ltems

+ E %

Figure 15-11
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Not Junk does not move it back to the inbox where it
was originally received! If you want to restore the
inoffensive message to its original inbox (or move it
to another folder), drag the message over to the desti-
nation in the Mailboxes list.

E s Note that marking a message in the Junk folder as

You customize and train the Junk Mail filter from the Preferences dia-
log (available from your trusty Mail menu); click Junk Mail to show
the settings. I recommend that you first try the option labeled When
Junk Mail Arrives, Mark as Junk Mail but Leave It in My Inbox. Junk
Mail then takes its best shot at determining what's junk. When you
receive more mail and mark more messages as junk (or mark them as
not junk), you're teaching the Junk Mail feature how to winnow the
wheat from the chaff. Remember, with this setting junk messages
aren’'t moved anywhere — they're just marked with a particularly fit-
ting, grungy brown color, and they stay in your inbox.

After you're satisfied that the Junk Mail filter is catching just about
everything it can, display the Mail preferences again and choose the
Move It to the Junk Mailbox option. Mail creates a Junk folder and
prompts you for permission to move all junk messages to this folder.
After you review everything in the Junk folder, you can delete the mes-
sages it contains and send them to the Trash folder.

To save a message from junkdom, click the Not Junk

@ button in the preview box and then drag the message
from the Junk folder message list to a folder in the
Mailboxes list.

If you don't receive a lot of spam — or you want to be absolutely sure
that nothing is labeled as junk until you review it — click to deselect
the Enable Junk Mail Filtering check box. (And good luck.)

To reset the Junk Mail filter and erase any training you gave it, visit the
Junk Mail settings in Preferences again and click Reset. Then click the
Yes button to confirm your choice.
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®

By default, Mail exempts certain messages from Junk
Mail status based on three criteria: if the sender is in
your Lion Address Book, if you sent the sender a
message in the past, or if the message is addressed to
you with your full name. To tighten up your Junk
Mail filtering to the max, you might want to disable
these check boxes as well.
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Connecting with
People Online

Fnroughout human history, our drive has
been to communicate — from the earliest
cave paintings to written language and then to
the telegraph, the telephone, and the mobile
phone (including newer phones that connect
to the Internet; let you check e-mail, take pho-
tos, play music; and more). I'm here to tell you
that your Mac is the ultimate communications
device, no matter whom you need to converse
with or what the topic may be!

In this chapter, you find out how to

w= Chat with someone by typing messages
or talking over a microphone and even
viewing each other by way of video.

w= Add to and manage your collection of
online friends (otherwise called a “Buddy
List”).

w= Start audio and video conversations
across the Internet (“chatting”).

m= Access online journals (blogs) and web
discussion groups (forums).

w=  Start using web meeting sites (social net-
works) such as Facebook and MySpace.
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Check Vour Equipment

Forget that silly mobile phone and your complicated calling plan! By
using your Mac, you can easily chat with your friends and family
whether they're across the street or halfway across the world. Here’s
what you need to get started:

w= Your Mac: It comes with iChat software preinstalled,
allowing you to send and receive instant messages
(IM) with other computer users.

w= An Internet connection: (See Chapter 13.) For audio
or video chat, make sure that you have a broadband
connection.

w= A microphone for audio chat and a video camera
for video chat: If you have an iMac computer or a
MacBook laptop (the most popular models), you
have a built-in microphone for audio chat and a
built-in iSight video camera for video chat. You're all
set. (Some Apple monitors also have cameras and
microphones built in.) If you have a MacPro or Mac
mini, you need to buy these two devices separately
and plug them into the correct port on your Mac —
you find all the facts on ports in Chapter 2.

through iChat), you see each other in glorious, full-
color video! This fulfills the decades-old promise of
the video telephone quite well, thank you. Audio
chat is similar to talking on the phone, but without
the expense of a calling plan. If you haven’t used
FaceTime yet, it's a full-tilt video chat system
although both sides of the “conversation” have to be
using Apple devices that support FaceTime. (As of
this writing, that includes Macs, iPhone 4/4S smart-
phones, iPads, or iPod touch units.)

@ When you use video chat (either in FaceTime or

310
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Set Up iChat

So why use iChat? When family and friends want to communicate
with you by using their computers, they could certainly send e-mail —
but that’s certainly not immediate, and you'd miss out on hearing or
seeing them. iChat allows you to “plug in” to the popular world of
computer Internet instant messaging, which many Mac owners have
used before through various sources: AOLs AIM, Google’s GoogleTalk,
Jabber, and Yahoo! Messenger.

Sending a text message to another person is practically instantaneous —
hence the name — and many of these services allow you to also engage
in audio chats (sound only) or video chats (sound and real-time video).

When you first run iChat, you have a little setup work to do. The fol-
lowing steps walk you through the process:

m 1. Click the iChat icon on the Dock, and you're prompted to

, create an iChat account. If you decided to not open an
iCloud account during the Lion setup process, you can still
get a free iChat account through Apple. (iCloud is the free
online service offered by Apple, which I cover in Chapter 2.)
Click the Get an iChat Account button and enter the
required information on the Apple web page that appears.

2. In the Account Setup dialog that appears, shown in
Figure 16-1, select your account type and fill out the
boxes, depending on which of the following options best
fits your situation:

e You want to use the iCloud account that you set up
when you first installed Mac OS X (referred to here as
me.com). In this case, your Apple ID account name
and password are entered automatically for you,
and you're good to go.

e You want to use an existing chat account for AIM,
GoogleTalk, Yahoo!, or Jabber instead: Click the
Account Type pop-up menu and choose the correct
service — and then enter the account information
required for that service. 311

www.it-ebooks.info


http://www.it-ebooks.info/

Part IV: Exploring the Internet

Account Setup

iChat supports me.com, Mac.com, AIM, Yahoo!, Google
Talk, and Jabber accounts.

Account Type: | AIM

A

Username: |

Password:

I_Cancel | [ Done

Figure 16-1

Select your
account type.

3. Click the Done button in the Account Setup dialog. iChat
displays the iChat Buddies window, as shown in Figure
16-2. Although this figure shows my list already popu-
lated with (my) buddies, a new account will be empty.

clicking its icon from the Dock. From within

@ After you configure iChat, you can always run it by

Launchpad, click the iChat application icon.

A list of your buddies

enon

Mark Chambers
~  Awvailable «

iChat Buddies

@

¥ Bonjour
¥ Offline

¥ Buddies

® Sylvester Cat

%

[+

Al e D

312 Figure 16-2
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Add Friends to Vour iChat Buddy List

In iChat, a buddy is anyone whom you want to chat with, whether the
topic is work related or your personal life. iChat keeps track of your
buddies in its Buddy List.

Because iChat is tied closely to Address Book, if you

@ have any potential buddies lurking in your Address
Book who have instant messaging accounts, | recom-
mend updating those contacts with their IM account
information. (You can simply ask the person you
want to add for this information.) It's much easier to
allow iChat to pull the account information in auto-
matically while creating a buddy than typing the
account names manually!

To add a new buddy, follow these steps:
1. Open iChat by clicking its icon on the Dock.

2. From the iChat menu bar at the top of the screen, choose
Buddies=>Add Buddy to display the Add Buddy sheet, as
shown in Figure 16-3.

668 iChat Buddies
= Mark Chambers E
Available +

Enter the buddy's account:

Account name:
Add to group: | Buddies

First name:

Lot  ~€—— Select a name from
Cancel Add your Address Book.

Figure 16-3 313
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3. To create a buddy entry from an Address Book contact
who has an instant messaging username, click the down-
arrow button next to the Last Name box to display the
contacts list from your Address Book. Click the entry to
select it.

4. To add a person who isn't already in your Address Book,
type the person’s instant messaging account name.

5. Click the Add button to save the buddy information.

Even when you add a new buddy and that name

@ appears on the Buddy List, don’t be concerned if the
name literally fades out after a few seconds. The fad-
ing just indicates that the person is offline and
unavailable. You can also tell when a person is avail-
able if her name appears next to a green bullet in the
Buddy List. These indicators show a person's status,
and your buddies can see your status, too. Find out
more about status in the next section.

Set Vour Status in iChat

314

Your iChat status lets your iChat buddies know whether you're avail-
able to chat. The status options fall into one of two categories:

w= Online: When you're online, folks can invite you to
chat and communicate with you.

w=  Offline: When you're offline, you're disconnected. iChat
isn’t active, you can't be paged, and you can't chat.

name directly, which automatically switches iChat to
online mode and opens the paging window for that
buddy. (Naturally, you have to have the proper net-
work or Internet connection first.)

@ Even when you're offline, you can click a buddy
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Now that you know what's going on behind the scenes, here’s the
scoop on the live options you can choose from:

w= Available: You're at your Mac and willing to chat. In
addition to plain old Available, Apple provides you
with some more specific choices, such as Surfing the
Web.

m=  Away: You can use Away mode whenever iChat is
running and you're still online but not available. For
example, if 'm away from my Mac for a few min-
utes, | leave iChat running but switch my status to
Away. My buddies see a message saying that I'm
away so that they don’t bother trying to contact me.
Apple also offers a few specific options for Away,
too, such as In a Meeting.

m= A custom status: You, too, can create a custom
mode — such as Bored Stiff! or Listening to My
Significant Other — and use it rather than the some-
what mundane choices of Available and Away. You
find out how to create a custom status later in this
section.

To choose an existing mode, follow these steps:

Click the Mode button in the iChat Buddies window
(which should read either Off1ine or Online). Modes
with a green bullet are Available modes, and red bullet
modes are Away modes. See Figure 16-4.

If you chose an Away mode, when you return to your
computer, simply move your mouse, and iChat intelli-
gently inquires whether you want to return to Available
mode.

www.it-ebooks.info
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800 iChat Buddies
Mark Chambers 3

A Offline

® Available
@ Surfing the web

@ Reading email

@ At home

@ Custom Available...

@ Current iTunes Song

@ Away

@ Out to lunch

@ On the phone
@ In a meeting

@ Custom Away...

Edit Status Menu...
¥ Use Same Status for All Accounts

Choose an existing mode.
Figure 16-4

To create a custom status, follow these steps:

1. In the iChat Buddies window, click the word Available
beneath your name, and a drop-down menu appears.

2. Click the Custom Available or Custom Away menu
entries to create the new mode.

3. In the edit box that appears, type the message you want
to appear for the new mode.

4. Press Return to automatically add the newcomer to your
mode list. You can also switch modes from this pop-up
menu.

Chat with a Buddy

A basic text chat doesn’t require a microphone or video camera on
both ends — both sides of the conversation just rely on old-fashioned
typing.

316

www.it-ebooks.info


http://www.it-ebooks.info/

To invite someone to a text chat, follow these steps:
1. Select that person from the Buddy List.

2. Click the Buddies menu, and then choose Invite to Chat.
Figure 16-5 shows a text invitation in progress.

Click to end your chat.

Chat Buddies

Mark Chambers — [
| [mq] i 800 Sylvester Cat — Chat
Available i e
& i Jabber Chat with Syivester Cat
¥ Buddies R SEsosl SR Today 1:18 PM
0 Sylvester Cat §

¥ Bonjour
¥ Offline

Hey, I'm inviting you, slacker! | Invite ]
I}

Type your invitation to chat.

Invite more buddies to chat. Add an emoticon to your message.

Figure 16-5

by clicking the plus button (+) in the lower-left area
of the Participants list and choosing another buddy.
If the Participants list isn’t visible, choose Viewr>
Show Chat Participants.

@ You can invite additional buddies to enter the chat

3. Type your invitation text into the entry box at the bottom
of the window.

text and press 8+B for Bold (B) or 3+I for Italic (I).
You can also add an emoticon (a symbol that conveys
emotion, in tech-speak, also called a smiley) to your
invitation text: Click in the text where you want the

@ If you want to use bold or italic text, highlight the
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emoticon to appear, click the Smiley button to the
right of the text entry field, and then choose the
proper smiley from the list.

4. To send the invitation text, press Return.

If the chat is accepted, iChat displays a message saying
that the buddy you invited has joined the chat and you
now can begin the chat. You don’t have to alternate send-
ing messages back and forth between participants —
everyone in a chat can compose and send messages at the
same time — but I personally like to alternate when I'm
chatting one-on-one.

If someone invites you to a chat, you experience the oppo-
site side of the coin: A dialog appears to prompt you, and
you can choose to accept or decline the invitation.

5. Click in the text entry box at the bottom of the Chat win-
dow, type a line of text, and then press Return to send it.

ple, a photo or a Pages document — simply drag the

@ To send a file to someone during a chat — for exam-
file into the message area.

6. When you're done with your conversation, click the red
Close button at the upper left of the Chat window to end
the chat.

Start an Audio Chat

318

If the green phone icon appears next to both your name
and your buddy’s name in the Buddies list, you can enjoy
a two-way audio (or voice) chat.

don’t see the phone icon, click the Video menu in
the iChat menu bar and make sure that the Audio
Chat Enabled menu item is checked.

@ If your Mac has a microphone hooked up but you
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To invite a buddy to an audio chat, follow these steps:
1. Select that person from the Buddy List.

2. Click the Buddies menu, and then choose Invite to Audio
Chat (or One-Way Audio Chat, if only one of you has a
microphone). An Audio Chat window opens with a
Waiting for Reply message, as shown in Figure 16-6.

Inviting a buddy to an audio chat.

® O 7 Audio Chat with doom¢
A\

L+ L (———0w

Waiting for reply... A
I\

Waiting on a chat buddy.
Figure 16-6

3. After your buddies accept your invitation, you can begin
speaking. (No need to press a button to speak — just talk
normally into the microphone.)

To change the volume of your outgoing audio, drag the
volume slider under your name in the Audio Chat win-
dow to the left. To change the volume of your buddy’s
voice, drag the volume slider under that name in the
Audio Chat window to the left. (If you're not hearing any
audio after adjusting the volume, make sure that your
speakers are on and that your Mac’s sound isn't muted.)

4. To end your audio chat, click the red Close button at the
top left of the Audio Chat window.

319
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Start a Uideo Chat

320

When you use iChat, you can jump into a real-time, two-
way video chat room, complete with audio. To do so,
both you and your buddy (or buddies) must have
Apple’s FaceTime camera or another brand of web cam-
era connected to your Macs. If that’s the case, you see
video icons next to her name in your Buddy List (as well
as next to your own name at the top of the list).

hooked up but you don't see the video icon, click the

@ If your Mac has a microphone or video camera

1.
2.

5.

Video menu and make sure that the Video Chat
Enabled menu item is checked.

Starting a video chat is similar to starting an audio chat:
Select that person in the Buddy List.

Click the Buddies menu and choose either Invite to
Video Chat or Invite to One-Way Video Chat, depending
on the available hardware.

If your buddy accepts the chat, a Video Chat window
appears and you can begin to talk while also seeing facial
expressions, the new baby, and whatever else is going on
over the video stream.

(Optional) Click the Effects button to choose from a
range of effects for your outgoing video (like black and
white, sepia, x-ray, or thermal camera). Click a thumb-
nail to apply that effect to your video and then click the
Close button at the top left of the Video Effects dialog to
return to the Video Chat window.

When you're done chatting, click the red Close button at
the top left of the Video Chat window.
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As with an audio chat, a prompt appears if you're
invited to a video chat, and you can accept or
decline. (You even see a video preview of the person
inviting you.)

Conversing with FaceTime

Although iChat’s standard video chat is downright nifty, it has limits:
You're confined to your instant messaging buddies, and those folks
may not have the necessary video hardware. With Apple’s FaceTime
technology, however, you can video chat with owners of iOS devices
(think iPhone, iPod touch, and iPad) and other Macs without the con-
straints of instant messaging accounts. And if they can run FaceTime,
they're guaranteed to have the right video hardware!

At the time of this writing, FaceTime-compatible devices include
w= Macs running Lion

Mac owners running Snow Leopard 10.6.6 or later
can also buy the FaceTime application from the App
Store.

w= An iPhone 4 or 4S running iOS 4.1 or higher
w= An iPad 2

w= A fourth-generation iPod touch running iOS 4.1 or
higher

You do need a Wi-Fi connection to use FaceTime with a mobile
device — a 3G cellular connection (from your cellular provider) will
not work — and your computer requires either a wired or Wi-Fi (wire-
less) connection to the Internet.

321
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To launch FaceTime, click the jaunty-looking video cam-

@ era icon on the Dock. The first time you use the applica-
tion, you have to enter your Apple ID (which I show you
how to create in Chapter 2, as part of the Setup Assistant)
and your e-mail address. The folks you chat with on the
other end use that same e-mail address to call you via
FaceTime. iPhone 4/4S owners can be called, using their
telephone numbers.

To change the e-mail address that other FaceTime

@ users use to call you, choose FaceTimer>Preferences
and click the E-mail link under the heading You Can
Be Reached For Calls At.

After you've signed in, FaceTime displays your Address Book Contacts
list by default. To initiate a call with any contact, click the name in the
list. FaceTime displays the e-mail and telephone numbers for the con-
tact (once again, taken from your Address Book). Click the e-mail or
telephone number that FaceTime should use, and the connection pro-
cess begins. To return to the Contacts list and choose another person,
click the All Contacts button at the top of the window.

When the call is accepted, you'll see a large video window with a
smaller “picture-in-picture” display, as shown in Figure 16-7. The
video from the other person fills the large window, and the video that
you're sending to them appears in the small display. To end the
FaceTime call, click the End icon.

322
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FaceTime with Mark Chambers

Figure 16-7

Share on a Blog (An Online Journal)

In its purest form, a blog is simply an online journal kept on the web
by an individual or group — at least, that's what they started as several
years ago. Most blogs are now online podiums, where personal opin-
ion is king. (Remember: Anyone can put up a blog — no matter how
wildly inaccurate or biased the content they present may be.) You can
keep up with people you know or your favorite organizations or writ-
ers if they keep a blog. The following tips help you understand what a
blog is and how it works:

w= A blog can contain text, photos, audio, and video.

323
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w= A blog is basically a website with a special format.
You visit a blog by typing its web address into your
Safari browser. Chapter 14 explains using Safari to
check out websites.

w= You can find blogs that focus on any topic that inter-
ests you: For example, politics (of course), garden-
ing, travel, and photography are well represented on
the Internet.

w= Some blogs allow you to add a comment to a post.
To do so, you'll typically click the Comment button
or link next to that post. Just keep in mind that
whatever you post is public, and everyone on the
Internet can read it.

Communicate on Message Forums

324

Unlike a blog, a message forum is more like a conversation — think of
a series of public e-mail messages. On a message forum, however, an
original topic message leads to replies from multiple forum members.
These discussions can last for weeks (I've been part of topics that have
spanned months, including literally dozens of replies.)

Forums are known as a source of information and recommendations
on a particular topic, like Mac troubleshooting or genealogy. For
example, I often use my favorite photography forum to gather opin-
ions on cameras and lenses before I buy. I also enjoy reading the vari-
ous tips and “spirited” conversations from professional photographers
on all sorts of optical topics.

Forum message bases include a number of features, depending on the
software used to host the forum. For example, the forum site likely
keeps track of the messages you read, enabling you to read just the
new messages on the topics you choose. You likely can format your
messages as you like, with color, italic, and emoticons.
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Suppose that you need tips on how to fine-tune a slide show within
iPhoto. Follow these steps:

1. Visit Apple’s iPhoto forums at www . apple.com/
support/iphoto.

2. Click the Support Communities link to display the
iPhoto forum page.

3. To read a discussion, just click the topic line (which
appears in bold blue type).

perform a search. Click in the Search Communities
box at the top-right side of the page and type your
search term. Because I'm interested in a specific iPhoto
feature, I would type slideshow. Then press Return to
display discussions on your particular topic.

@ If you don't see the topic you're interested in, you can

4. To start a new discussion, type the question or subject
into the Ask Your Question text box, and then click the
Submit My Question to the Community link. The web-
site prompts you to log in, using the Apple ID you cre-
ated during registration — most forums require you to
create a user account before you can reply to a discussion
Or post a new topic.

Again, anyone can host a forum message base. Companies offer them
to allow discussions among employees, and it’s easy for a club to offer
a forum for its members. As with a blog, you find both free and com-
mercial forum hosting sites by making a simple Google search at www .
google.com.

Network with Others

I'll be honest: I find social networking sites such as Facebook (www .
facebook.com) and Twitter (http://twitter.com) simply
addictive!
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They make the following activities so easy:

Search for friends and family who are also mem-
bers of the network. The list includes old friends
you lost touch with over the years. For example, you
can search for members from your hometown or
high school.

Share photos and commentary with everyone. These
services make it easy to share photos by providing you
with your own photo page that other users can see.
You can choose the images you want to share with
everyone. You can also join in simple discussions with
others by posting messages on their pages.

Play games with network contacts. Games on a
social network site are usually quick to play and
involve a lot of users, so competition can be heavy
on the more-popular games! For example, Facebook
offers you the chance to build your own country, or
engage in battles with others as a superhero.

Find fun activities. I use Facebook to check on local
live concerts in my area, as well as throw virtual
“snowballs” at others and swap favorite jokes.

Share your contact list with others. If you know
people who are friends in real life (or went to the
same school or worked at the same company), you
can recommend them to each other so that they can
become friends online as well.

Both Facebook and MySpace are free to join, and you
can feel safe knowing that your personal information
is secure. (You should never post personal informa-
tion, however, such as your address or telephone
number, in your public member record.)
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aking Care of
our Computer

The 5th Wave By Rich Tennant
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“No, that’snot the icon for iCal, it’s the
icon for iCan’t, the database of vreasons
you forgot an appointment.”
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Protecting Lion

Fne wise Mac owner is aware of the security
issues that surround today’s computers —
from the Internet and from unauthorized use
directly from the keyboard!

If you're concerned that your Mac is vulnerable
to attacks by Bad CyberGuys, rest assured that
your computer is surrounded by defenses that
you can’t even see. In this chapter, you find out
how to

w= Keep Lion current with the latest security
updates from Apple.

w= Protect your data and applications
behind your Lion firewall.

w= Configure FileVault to protect your hard
drive.

w= Configure your Mac for the tightest login
security.

If some of this vocabulary is new to you, or
maybe you've heard about a firewall but aren't
quite sure what one is, you're in good hands
here.
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Understand Computer Security
Computers now face three major security challenges:

w= Attacks from the Internet: A hacker (a computer user
who wants to take control of your computer) can use
your Internet connection to monitor your communi-
cations or receive copies of your data.

w= Viruses: You've probably heard of viruses, which are
applications that can damage Lion or your files or
slow down your Mac. Although viruses are far less
common on Macs than on Windows machines, you
should invest in a good antivirus application to
ensure that your computer remains pristine. Lion
doesn’t come with a built-in antivirus application,
but I use the excellent freeware antivirus application
ClamXav2, available from www.clamxav. com.

w= Unauthorized users: Whether a user is your niece at
your desktop keyboard or someone who has stolen
your MacBook laptop, you want to protect your pri-
vate documents and prevent anyone from using your
Mac without your permission.

With the right security safeguards in position, you can rest easy,
knowing that your Mac is well protected.

of your Mac as a “security safeguard,” it definitely is.
With a full backup safely stored in your home or
office, you're protected in case your files and data are
stolen, damaged, or destroyed. Hey, life happens.

@ Although you might not consider creating a backup

Configure and Run Software Update

I prefer that my Mac take care of cleaning up after itself, so updating
Lion with the latest security fixes should be automatic as well. In

330
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Mac OS X Lion, operating system updates are performed by the

Software Update application.

Software Update uses the Internet, so you need an Internet connection
to shake hands with the Apple server and download any updates. (The
faster the connection, the better.) To see how to get online, see

Chapter 13.

You can find Software Update in two convenient spots:

w= On the Apple menu: Click the Apple menu (the
& icon at the far left of the Finder menu) and then
choose Software Update, which displays the Update
dialog and alerts you to any new updates that are

available.

w= In System Preferences: Click the System Preferences
icon on the Dock, and then click the Software
Update icon to display the Software Update pane, as

shown in Figure 17-1.

800 Software Update

|« /> || showan | Q

Installed Software |

Software Update checks for new and updated versions of your software
based on information about your computer and current software.
Check Now

Last check: Mo new software updates were available
Saturday, November 26, 2011 11:08 AM

[ Check for updates: | Daily = <

B] Download updates automatically
You willpe notified when the updates are ready to be installed.

il
i QE Click the lock to prevent further chdnges.

Download critical uploads automatically.
Figure 17-1
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If you take the System Preferences route, you can set Software Update
to check for updates automatically:

1. In the Software Update pane within System Preferences,
mark the Check for Updates check box to enable it.

2. Choose the frequency from the Check for Updates pop-
up menu.

Software Update covers every Apple application, so I
usually configure it to check for updates once per day

just to make sure that I don’t miss anything.
3. Select the Download Updates Automatically check box.

If something needs to be updated, the program alerts
you. Critical updates are automatically downloaded, and
minor updates are displayed for your confirmation
before they're downloaded. You're prompted for your
account password before the updates are installed.

from the Software Update pane in System Preferences

@ You can even also check for updates immediately
by clicking the Check Now button.

Customize the Lion Firewall

Lion’s built-in software firewall acts as the wall surrounding your

castle — I mean, your Mac — by allowing in the communications you
want while preventing unknown communications from potential
threats. The firewall works with your Internet connection and with any
networks you might have joined.

To display the Firewall settings, click the System

EEE}! Preferences icon on the Dock and then click the Security
|
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& Privacy icon. Click the Firewall tab to display the set-
tings in Figure 17-2.
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If your firewall hasn’t yet been turned on, click the Start button to start
the ball rolling. (In the figure, the Start button has toggled to Stop
because I have my firewall already on.)

Select this option for your firewall.

8 0 ( Security & Privacy

[« »]][ showan ] Q

| General FileVault Firewall Privacy |

@ Firewall; On

The firewall is turned on and set up to prevent unauthorized applications, programs, and
services from accepting incoming connections.

Stop Click Stop to turn the firewall off.

Advanced. ..

o
J_%l Click the lock to prevent further changes.

Figure 17-2

the padlock icon in the lower-left corner. If Lion
prompts you for your Admin user account password,
type it and then click Unlock.

@ Is the Start button disabled? Don't panic — just click

Click the Advanced button, and Lion presents you with three options
you can set (see Figure 17-3):

w= Block All Incoming Connections: | recommend not
using this option because turning it on reduces the
data you receive, cutting off access to the Internet for
virtually all of your applications. (In other words,
blocking all incoming Internet connections is overly
drastic security that prevents you from doing many
of the nifty things I demonstrate in this book). Use
this feature only if you suspect that your Mac is the
target of an Internet hacking attack.
333
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26886 Security & Privacy

Block all incoming connections
Blocks all incoming connections except those required for basic Internet services,
such as DHCP, Bonjour, and IPSec.

File Sharing (AFP, SMB) @ Allow incoming connections
Printer Sharing @ Allow incoming connections

+

E‘]Aulomali(ally allow signed software to receive incoming connections

Allows software signed by a valid certificate authority to provide services accessed
from the network

—Ej Enable stealth mode
Don't respond to or acknowledge attempts to access this computer from the network
by test applications using ICMP, such as Ping.

| M. AtariB00MacX @ Allow incoming connections +
it Bento @ Allow incoming connections +
|l DAZStudio @ Allow incoming connections +

@ Cancel | [ 0K

n
Jil CIick the TacK To prevent further changes.

Enable these two settings for best security.
Figure 17-3

w= Automatically Allow Signed Software to Receive
Incoming Connections: Enable this one. Now, soft-
ware you've installed that's accompanied by a valid
security certificate (including any application from
Apple and most major third-party software develop-
ers) is automatically added to the Allowed list you
see on the Advanced sheet. If an application without
a security certificate tries to access the Internet, your
Mac displays a dialog prompting you for confirma-

tion, and you can decide yes or no.

e Yes: Manually add an application to the Allowed
list. Click the button with the plus sign at the bot-
tom of the list and then navigate to the application
that needs to communicate with the outside world.
Click the application to select it and then click Add.
Remember: Only third-party applications you
install yourself will likely need to be added to the
Allowed list, because all the applications that Apple
includes with your Mac are already on the list.
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e No: Delete an application and return it to blocked
status. Select it in the Allowed list and click the
button with the minus sign.

You can edit the settings in a specific application

@ by clicking the pop-up menu on the right side of
the entry. By default, the setting is Allow Incoming
Connections (including both your local network
and the Internet). However, you can also choose
Block Incoming Connections to prevent that appli-
cation from receiving any communications.

w= Enable Stealth Mode: Here’s an option I recommend
that you turn on. Stealth mode helps prevent hackers
from attacking your Mac by preventing it from
responding to simple identification queries across the
Internet. Hackers often search the Internet for available
computers that automatically respond to such queries.

If you suddenly can’t connect to other computers or share files that you
originally could share, review the settings that you enabled from this
pane: They might be the culprits. You can also verify that the correct
sharing services are still enabled in the Sharing pane within System
Preferences, as shown in Figure 17-4. (When you enable a service
through the Sharing pane, Lion automatically adds that service to the
Allowed list. For example, when I turn on Printer Sharing on the
Sharing pane, Lion adds a Printer Sharing entry to the firewall’s Allowed
list.) Open the System Preferences window and click the Sharing icon,
and make sure that the services you want to provide are selected.

Configure and Run FileUault

As I mention earlier in this chapter, every Mac owner should be inter-
ested in securing personal files from prying eyes. Granted, this isn't a
problem if you're the only one using your Mac. However, if you're
sharing a computer with others or your MacBook is a mobile beast,
you might want a little more protection for those all-important tax
records and that journal you're keeping.
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- NsNs) Sharing

[« /> || Showal | Q

Computer Name: SilverDragon

Computers on your local network can access your computer at:
SilverDragan.local

@ Printer Sharing: On <

| Edit... |

On | Service

DVD or CD Sharing Printer Sharing allows others on your netwark to use printers and fax

Screen Sharing modems connected to this computer.

[  File Sharing | Open Print & Scan Preferences...

& Printer Sharing

Scanner Sharing Users:

Printers:

Weh Sharing

Remote Login
Remote Management
Remote Apple Events
Xgrid Sharing
Internet Sharing
EBluetooth Sharing

™ & HP LaserJet M1..
™ . HP Laserjet M1..

m Everyone Can Print

d
U5 Click the lock to prevent further changes.

x

Make sure that
Sharing settings
are enabled.

Figure 17-4

Never fear: Lion offers the FileVault feature, which provides hard drive
encryption that prevents just about anyone except the NSA or FBI from
gaining access to the files on your hard drive. You can enable the
FileVault feature from the Security & Privacy pane in System

Preferences, as shown in Figure 17-5.

8eo0n Security & Privacy

[« > |[ Showal | Q

| General Firewall | Privacy |

FileVault secures the data on your disk by encrypting its contents. It
p @ . automatically encrypts and decrypts your files while you're using them.

WARNING: You will need your login password or a recovery key to access your data. A
recovery key is automatically generated as part of this setup. If you forget both your
password and recovery key, the data will be lost.

FileVault is turned off for the disk “Wolfgang™.

| Turn On FileVault... *

Jﬂ“ ) )
§5 " Click the lock to prevent further changes. :

— Click to turn
on FileVault.

Figure 17-5
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To configure FileVault, follow these steps:

R 1.Click the System Preferences icon on the Dock.

Ej -‘F.

»42, Click the Security & Privacy icon and then click the
FileVault tab.

3. Click the Turn on FileVault button to display the Enable
User sheet shown in Figure 17-6. If your system has mul-
tiple user accounts, each user must enter her password to
be able to access your encrypted drive (because FileVault
uses your login account password as your primary
encryption password.) Then, all accounts in the list
should have a check mark next to them.

4. Click Continue.

5. Make sure to write down the recovery key that Lion dis-
plays, and store that key in a secure spot. (Note that the
key is case-sensitive.)

0 Security & Privacy

Each user must type in their password before they will be able to unlock
the disk.

m Benjamin Franklin Enable User...
@. F‘é Mark Chambers
%

Admin -

it

Cancel | Continue

il
i 'll Click the lock to prevent further changes.

Figure 17-6
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If you have a printer available, you can also print a
hard copy of the recovery key. Press 38+Shift+3 to take
a screen shot while the recovery key is visible and Lion
saves the screen shot to your Mac desktop. Double-
click on the screen shot icon to load the image in
Preview, and then press 8+P to print. (Don't forget to
drag the screen shot file to the Trash afterward, and
store the printed copy in your secure spot.)

6. Click Continue to begin the encryption process.

I love this feature, and I use it on all my Macs running Lion. Yet, a risk
is involved (insert ominous chord here). To wit:

DO NOT forget your login password, and make doggone sure that your admin
user has a copy of that all-important recovery key!

Mac OS X displays a dire warning for anyone who's considering using
FileVault: If you forget these passwords, you can't retrieve any data
from your Mac’s hard drive. Period. As Jerry Reed used to say, “It's a
gone pecan.”

I should also mention that FileVault protection slows things down
somewhat when you're loading or saving a very large document —
100MB (megabytes) or more — to your hard drive.

need to disable automatic login (as I discuss in the
next section). Think about this possible security back-
door: From the Users & Groups pane, you've set your
Mac to automatically log you in every time you boot
your computer. This is the very definition of Not
Secure because your login account password automati-
cally decrypts the FileVault data! Therefore, make sure
that you actually have to log in to access your account.

@ To take full advantage of an encrypted hard drive, you
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Configure Secure User Options

You can also configure Lion for tighter login security, making it much
harder for anyone to sit down at your Mac and “break in” to your sys-
tem. The secure login options are found within the System Preferences
Security & Privacy pane, so click the System Preferences icon on the
Dock and click the Security & Privacy icon. Click the General tab to
display the settings in Figure 17-7.

Select these security options.

®0C Security & Privacy
|« | > || Showal | Q

FileVault Firewall Privacy |

-+@ Require password | 1 minute + | after sleep or screen saver begins

For all accounts on this computer:
»E] Disable automatic login

Require an administrator password to access system preferences with lock icons

Log out after &0 minutes of inactivity

Show a message when the screen is locked:

E‘]Aulomali(ally update safe downloads list

Disable restarting to Safari when screen is locked

Do :
JE- Click the lock to prevent further changes. \£/

Figure 17-7

If you're an admin-level user, you can set the global
security features, in the For All Accounts on This
Computer section, which affect all user accounts.
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For tighter security, | recommend that you enable these options:

I

=y

=y

Require Password After Sleep or Screen Saver
Begins: Select this option to add an extra layer of
password security to a laptop (or a Mac in a public
area). Mac OS X then requires that you enter your
login password before the system returns from a
sleep state or exits from a screen saver. The pop-up
menu specifies the amount of time that must pass
before your password is required.

Disable Automatic Login: Enable this option to
force a full login every time you boot your Mac.
(Laptop owners, take note: Turn on this option to
prevent a thief from accessing your data!) As I men-
tion in the preceding section, you should also dis-
able automatic login if you're using FileVault
encryption.

Automatically Update Safe Downloads List: Select
this option to allow Lion to automatically update the
data files it uses to mark downloads as safe from
malicious applications and spyware.
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Vour Mac

A Ithough your Mac doesn’t roam the high-
way like your car does, a computer still
needs regular maintenance. Over time, regular
use (and unexpected events, such as power
outages) can produce problems ranging from
hard drive errors to slower browser
performance.

Don’t worry, there’s no oil filter to change! In
this chapter, you find out how to

w= Detect and correct errors in your Mac’s
file system.

w= Repair permissions errors that can pre-
vent applications from loading and run-
ning properly.

w= Back up your important files and folders
with an inexpensive USB flash drive.

w= Trim those unnecessary and outdated
files from your drive to reclaim space.

www.it-ebooks.info

Chapter

Getready to. ..

w= Scan a Drive for Errors.......

w= Fix File Permission
Problems ...,

w= Back Up Important Files
and Folders...........ccco......

w= Remove Unnecessary
Files ..voveiiiiiiiei,


http://www.it-ebooks.info/

Part V: Taking Care of Your Computer

Scan a Drive for Errors

Lion’s Disk Utility is a handy tool for troubleshooting and repairing
your hard drive (whether you're noticing that your Mac has slowed
down considerably, or you have problems opening files and applica-
tions). You can find it in the Utilities folder within the Applications
folder. From Launchpad, click the Utilities folder and then click the
Disk Utility icon.

In the left column of the Disk Utility window, you can see

w= The physical hard drives in your system (the actual
hardware)

w= The volumes (the data stored on the hard drives)
@ You can always tell a volume because it’s indented
underneath the physical drive entry.
w= Any CD or DVD loaded on your Mac
w= ISB or FireWire flash drives

Flash drives (like a thumb drive) are external hard-
ware devices that you can add to your Mac for addi-
tional storage room or as a secure place to back up
your data.

For example, in Figure 18-1, I have one hard drive (the 320.07GB
entry) and one USB flash drive (the 16.01GB entry). The hard drive
has one volume (Wolfgang), and the USB drive has one volume
(Transporter).

Disk Utility can use Verify Disk to check the format and health of both

hard drives and volumes — and, if the problem can be corrected, use
Repair Disk to fix any error.
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The hard drive’s volume

A hard drive

[ NsNs] Wolfgang
D 4 - T
w A s = = EM EE
Verify Info  Burm Unmount Eject Enable Joufnaling [New Image Convert Resize Image Log
— Erase
132007 GB ST3320820A5_P Media ~a—
& Wolfgang ¥ore having trouble with the selected disk
16.01 GB SanDisk Cruzer Media 4 Repair Disk. If the repair fails, back up and erase the disk.
= + If Rfpair Disk is unavailable, click Verify Disk. If the disk needs repairs, start up from your Mac 05 X installation disc, and
- TRANSPORTER < thep choose Utilities > Disk Utility.
If youdhave a permissions problem with a file installed by the Mac OS X installer, click Repair Disk Permissions.
™ Shbw details tory
| verfy Disk Permissions | | Werify Disk |

[ Red

=l Mount Point: /
=" Format : Mac 05 Extended (Jpurnale
Owners Enabled : Yes

5 Number of Folders : 193,084

4

Capacity
Available :

Used :

Number of Files :

hir Disk Permissions |

319.21 GB{319,213,174,784 Bytes)
30.9 GB (30,897,602,560 Bytes)
288.32 CB (288,315,572,224 Bytes)
851,602

Repair Disk

The USB drive’s volume

A USB flash drive

Figure 18-1

Using Disk Utility to repair your hard drive carries a couple of caveats:

w= You can't repair the boot disk or the boot volume.
This statement makes sense because you're using that
disk and volume right now. (The boot volume is usu-
ally your Mac’s internal hard drive, where Lion is

installed.)
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To verify or repair your boot hard drive, you need to
boot your Mac from Lion’s Recovery HD volume.
Hold down the Option key immediately after you
hear the startup chord to display the Mac OS X boot
menu, and choose the Recovery HD volume. When
the Recovery window appears, run Disk Utility.
Because you've booted the system from the Recovery
HD volume, you can verify and repair problems with
your start-up hard drive.

You should be able to select your boot hard drive or
volume, and the Verify Disk and Repair Disk buttons
should be enabled.

w= You can’t repair CDs and DVDs. Because CDs and
DVDs are read-only media, they can’t be repaired (at
least by Disk Utility).

If your Mac is having trouble reading a CD or DVD,
wipe the disc with a soft cloth to remove dust, oil,
and fingerprints. If that technique fails, invest in a
disc-cleaning contrivance of some sort. Look for a
CD/DVD cleaning kit.

If you need to verify and repair a disk or volume, follow these steps:

1. Save all open documents and reboot from either an exter-
nal drive or Lion’s Recovery HD volume (as described
earlier).

2. Choose which drive your Mac boots from by clicking the
System Preferences icon on the Dock. Then click the
Startup Disk icon, select a drive from the list, and click
Restart.

3. To repair a disk or volume other than your boot drive or
volume, double-click the Disk Utility icon in the Utilities
folder. From Launchpad, click the Utilities folder and
then click the Disk Utility icon.
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4. 1n the list on the left side of the Disk Utility window,
click the disk or volume that you want to check.

5. Click the Repair Disk button.

6. 1f changes were made (or if you had to boot from a disc or
external drive), reboot after repairing the disk or volume.

Fix File Permission Problems

Shifty-eyed, sneaky, irritating little problems can bother your hard
drive: permissions errors. Incorrect disk and file permissions can

w=  Make your Mac lock up.
w= Make applications act goofy (or refuse to run).

w= Cause strange behavior within a Finder window or
System Preferences.

Permission errors are usually introduced on your system by a faulty
application installer. Sometimes the application itself has a bug that
produces errors when it tries to open or close files. Fortunately, you
don’t have to investigate the cause of a permission error. (That’s good
because you and I aren’t likely to understand such technogibberish,
anyway.) You just need to know that Disk Utility fixes the errors.

@ To keep Lion running at its best, fix permissions
errors at least once per week.

To fix any permissions errors on your system, follow these steps:
1. Click Launchpad and click the Utilities folder.
2. Click the Disk Utility icon.

3. Click the volume on the left that you want to check. (In
this case, it's a named partition, such as Macintosh HD,
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which appears under your physical hard drive.) Figure
18-2 illustrates my hard drive Mac volume, musically
named Wolfgang in honor of Mozart.

4. Click the Repair Disk Permissions button. Disk Utility
does the rest and then displays a message about whatever
it has to fix. (When will someone invent a car with a
Repair Me button?)

@00 Wolfgang

o ISR
.§ LI SRy v < . ‘ - Eil = i
Verify Info  Burn Unmount Eject Enable Journaling New Image Convert Resize Image Log

Erase = RAID | Restore |

1320.07 GB ST3320820A5_P Media

& Wolfgang If you're having trouble with the selected disk

16.01 GB SanDisk Cruzer Media » Click Repair Disk. If the repair fails, back up and erase the disk.
- = If Repair Disk is unavailable, click Verify Disk. If the disk needs repairs, start up from your Mac OS X installation disc, and

. TRANSPORTER then choose Utilities > Disk Urility.

If you have a permissions problem with a file installed by the Mac OS X installer, click Repair Disk Permissions.

@Shuw details | Clear History |

Permissions differ on "System/Library/CoreServices /Remate. .| /UIAgent.nib™; should be -rw-r--r-- ; they are drw-r--r-- _
Repaired “System/Library/CoreServices /RemoteManagement...op Message.app/Contents /Resources /no.lprojfUlAgent.nib”
Permissions differ on "System/Library/CoreServices (Remote _jfUlAgent.nib"; should be -rw-r--r--; they are drw-r--r-- _
Repaired “System /Library/CoreServices jRemateManagement._top Message.app/Contents /Resaurces/fi.lpraj/UlAgent.nib”
Permissions differ on “System/Library/CoreServices /Remate...j/UlAgent.nib"; should be -rw-r--r--; they are drw-r--r-- .
Repaired “System/Library/CoreServices /RemateManagement...op Message.app/Contents /Resources /da.|proj/UlAgent.nib”
Group differs on “Library/Preferences/com.apple.alf.plist”; should be 80; group is 0.

Repaired “Library/Preferences/com.apple alf plist"

Warning: SUID file “System/Library/CoreServices/RemateMa.__acOS/ARDAgent” has been modified and will not be repaired
ACL found but not expected on “private/var/root”

Repaired “private/var/root”

ACL found but not expected on “private/var/root/Library”

Repaired “private/var/root/Library”

ACL found but not expected on “private/var/raot/Library/Preferences”

Repaired “private/var/root/Library/Preferences”

Permissions repair complete

| Verify Disk Permissions | Verify Disk |

| Repair Disk Permissions Repair Dish

=i Mount Point: [ Capacity : 319.21 GB (319,213,174,784 Bytes)
Sl Format: Mac OS Extended (Journaled) Available : 30.9 GB (30,897,467,392 Bytes)
Owners Enabled : Yes Used: 288.32 GB (288,315,707,392 Bytes)
Number of Folders: 192 667 MNu r of Files : 851,606

Click here to fix permissions problems.

Figure 18-2

Back Up Important Files and Folders

Have you ever accidentally deleted a file or folder that was very impor-
tant to you, like your genealogy data files or your Great American
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Novel in progress? It’s truly a painful experience. You can avoid that
heartache with an inexpensive USB flash drive and a little preparation!

doesn’t protect your entire system automatically like
Lion’s built-in Time Machine backup system.
However, it's much cheaper than buying an external
500GB USB hard drive, and there’s no setup
involved. Computer owners have been using this
simple trick ever since the invention of the floppy
disk. If you do decide to use Time Machine, you'll
find complete instructions on how to set things up in
the Lion Help system (which I discuss in Chapter 7).

@ I call this process a “down and dirty” backup, and it

If you don't already have a USB flash drive handy, drop by your local
electronics or computer store and buy one. Make sure that the drive
you choose is labeled as compatible with Mac OS X, and it should
provide at least 8GB of storage capacity.

Then you can use your USB flash drive to back up your important
files:

,\I; 1. Plug the drive into your Mac’s USB port.

The drive should now show on your Desktop, and in
the Devices section at the left side of any Finder window.

2. Drag the files you want to back up to the USB drive icon
in either location. You can drag one file at a time, or an
entire folder’s worth of files.

With a “down and dirty” backup, you're only copying
those files that you absolutely can't afford to lose. For
example, before I travel I typically open my
Documents folder on my MacBook and copy the files
I'll use on the trip to my USB drive. Even if my
MacBook is lost or stolen, I'll still have that USB
backup in my pocket or suitcase.
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3. When you're done copying files, eject the flash drive by

right-clicking on the flash drive icon and choosing Eject
from the pop-up menu.

Store that drive in a safe location (repeating the process again as neces-
sary to “freshen” your backup files). Restoring a file is as easy as plug-
ging in the flash drive and copying the files back to your Mac’s hard
drive.

Remove Unnecessary Files

348

If you're running low on drive space (and you've already deleted any
unneeded downloads), it may be time to consider deleting “old”
applications to reclaim some space! In contrast to Windows 7, Mac OS
X doesn’t have a stand-alone utility for uninstalling software. It doesn't
need one because virtually all Macintosh applications are self-
contained in a single folder or series of nested folders.

Because of this rule, removing an application is usually as easy as delet-
ing the contents of the installation folder from your hard drive (for
example, removing the Quicken folder to uninstall Quicken). You find
the application’s installation folder within your Application folder.
Choose Go=>Applications (or press 3+Shift+A) to jump there directly.

But don't just delete that folder immediately. Take a second to make
sure, and always check the application’s README file (this usually has
the oh-so subtle filename of README) and documentation for any
special instructions before you delete any application’s folder! If
you've created any documents in that folder that you want to keep —
maybe you plan to reinstall the application later — don’t forget to
move them before you send the folder and its contents to the Trash. In
fact, some applications may come complete with their own uninstall
utility, so checking the README and documentation may save you
unnecessary steps.
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creating, 125-126
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buying a Mac

central processing unit (CPU), 19-20
computing power decision, 14-16

desktop versus laptop, 13-14

graphics processing unit (GPU), 20

hard drive space, 20
monitor selection, 17-19

online versus Apple Store, 21-22

price range, 16-17
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Chart Inspector dialog, 186-187
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characteristics, changing, 186-187

inserting, 185-187
type selection, 186
chats
audio, 318-319
with buddies, 316-318
video, 320-321
Chess game, 232-233
ClamXav 2, 258
Clipboard
for copying text, 157
for cutting text, 156-157
pasting text from, 157-158
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closing

programs, 82

windows, 81-82
color scheme, Desktop, 88-89
Column view, 71-72
columns, inserting/deleting, 183
Command key, 74
computing power

in buying a Mac, 14-16

high-demand tasks, 14-15

low-demand tasks, 15
cookies

acceptance plan, 279

blocking all, 280

defined, 278

deleting, 278-280
cooling pads, 24
copying

between drives, 123

files and folders, 123-124

target, 124

text (Pages), 157
corner-selection handles, 163, 164
Cover Flow view (iTunes), 218
CPU (central processing unit), 19-20
cropping photos, 205-207
CRT (cathode ray tube) monitors, 19
cutting text, 157-158

o) e

Dashboard

defined, 64

displaying, 64-65

illustrated, 65

installing widget games, 235-237
widgets, 64-65
data collection, as a Mac function, 10

date, setting, 45-47
Date & Time Preferences, 45-47
default printer, 131-132
Desktop
background, changing, 84-88
color scheme, changing, 88-89
defined, 52
elements, 52-54
icons, organizing, 92-94
illustrated, 53
Desktop & Screen Saver settings,
89-90
desktop Macs
defined, 13
laptops versus, 13-14
types of, 13
dial-up connections, 246-247, 251
digital media
as a Mac function, 10
playing, 218-219
disabling hot corner, 90
Disk Utility
defined, 342
Repair Disk Permissions option,
345-346
steps for using, 344-345
Verify Disk, 342
volume identification, 342
what you can't repair, 343-344
displays. See monitors
Dock
adding favorites to, 58-60
defined, 52
functions, 56
hiding feature, 63
icons, removing, 59-60
location, changing, 63

www.it-ebooks.info

351


http://www.it-ebooks.info/

Macs For Seniors For Dummies, 2nd Edition

Dock (continued)
magnification settings, 62-63
opening/switching programs
from, 56
size, changing, 61-62
stacks, 60-61
Track icon, 63-64
documents
defined, 107
double-clicking, 110-111
Pages, 151-170
PDF, 114-115, 133-134
previewing, 130
printing, 129-131
recently used, launching, 118
spreadsheet, 171-188
viewing with Quick Look, 112-114
download history, deleting, 280
downloading
games, 237-238
with Safari, 275-276
drilling, 112
DVD Player
controls, 191-192
playing movies with, 190-192
Viewer window, 190-191
windows, 190
DVI connector, 29, 31

of o

editing
Pages text, 155-156
photos, 204-207
spreadsheet data, 177-178
e-mail accounts
disable/enabling, 290-291
iCloud, 284
ISP, 284
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managing, 290-291
setting up, 284
sources, 284
web-based, 284
e-mail addresses, selecting, 297
e-mail attachments
adding, 294
application acceptance of, 299
monitoring, 257
opening, 300
received, saving, 299-300
sending, 298-299
size, 298-299
virus security, 259, 298
e-mail messages
adding photos to, 208-209
addressing, 295-296
backgrounds, 297
creating, 295-296
deleting, 293
finding, 67
formatting, 300-301
forwarding, 295
junk, 305-308
quoted text, 304
reading, 292-293
replying to, 293-295
saving to Drafts folder, 295
selecting, 293
sending, 298
signatures, 303-304
sorting, 289
virus security, 259
Ethernet jacks, 24
Ethernet port, 28
events
contents, displaying, 202
defined, 195, 202
external hard drive, 16
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Facebook, 325-326

FaceTime
calls, initiating, 322
defined, 321
device compatibility, 321
illustrated, 323
launching, 322

Fast User Switching. See also user

accounts

defined, 43
steps to use, 43-44
turning on, 43

faxes
receiving, 136
sending, 135

files. See also documents
adding to Dock, 59
backing up, 346-348
cache, 278
cookie, 278-280
copying, 123-124
creating links to, 116-117
defined, 106
deleting, 121-122
digital media, 218-219
displaying in results list, 67
History, 278
icons, 52-53
Internet security and, 258
moving from place to place,

124-125

opening, 109-112
organizing, 107-109
printing, 128-131
program link, 106
renaming, 121

running programs with, 57-58
stacking, 60-61
storing on Mac, 106-107
unnecessary, 348
FileVault
automatic login and, 338
configuring, 337-338
defined, 336
warning, 338
Find & Replace dialog, 167
Finder
availability, 54
Column view, 71-72
default appearance, 68
defined, 54
Flow view, 72-74
Help menu, 139-140
in Icon view, 68-70
List view, 70-71
menu bar, 52, 53-54
opening, 110
firewall
customizing, 332-335
defined, 332
settings, 332-334
Stealth mode, 334
FireWire port, 27
floating objects, 161-162
Flow view
defined, 72
illustrated, 73
tricks, 73-74
folders
adding to Dock, 59
backing up, 346-348
copying, 123-124
creating, 120-121
creating links to, 116-117
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folders (continued)
defined, 107
deleting, 121-122

displaying in results list, 67

e-mail mailbox, 304-305
Home, 38, 108-109
icons, 52-53

moving from place to place,

124-125
opening, 109-112
organizing, 107-109
program, 57
renaming, 121
spring-loaded, 123
stacking, 60-61
subfolders, 108, 121
Format bar, 158
formatting
character, 181
e-mail messages, 300-301
with shading, 181-182
spreadsheet, 178-179
text, 178-179
formulas
defined, 183
equal sign (=), 183
steps for adding, 184-185
forums
Apple, 142-143
message, 324-325
function keys, 75-77

o (G o

games
Chess, 232-233
downloading, 237-238

with network contacts, 326
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playing online, 238-239

Tile game, 233-235
General settings, 88-89
graphics processing unit (GPU), 20
Grid view (iTunes), 218

o/l o

hackers, 255, 256, 330
hard drives
icon, 52, 55
importing images from, 194
running programs from, 57-58
solid-state, 20
space, 20
hardware, 11
HDMI connector, 29, 31
headphone/optical output, 29
Hearing settings, 99-100
help
in Apple forums, 142-143
resources, 146-147
searching for, 139-142
sharing screens, 143-146
Help Center
controls, 139
defined, 138
topics, searching, 140-141
using songs in, 141-142
window, 138-139
history, browsing, 273-274
Home folders
defined, 108
other user viewing and, 38
subfolders, 108-109
home page, 262, 270-271
Hot Corner sheet, 90
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iChat
audio chats, 318-319
buddy chats, 316-318
Buddy List, 313-314
custom status, 316
defined, 311
existing mode, 315-316
live options, 315
screen sharing and, 145
setting up, 310-312
status, setting, 314-316
video chats, 320-321
iCloud
defined, 252
e-mail account, 284
functioning of, 252-253
setting up, 35
settings, 253-254
storage purchase, 253
Icon view, 68-69

icons
CDs/DVDs, 55

Desktop, organizing, 92-94

file, 52-53
folder, 52-53
grid spacing, 93
hard drive, 52, 55
iPod, 55
label text, 93
Lion, 54-55
previewing, 94
resizing, 93
sorting, 94
iMac desktop model, 17
images. See photos
Info dialog, 121

inline objects, 161, 163
Inspector window, 179-180
Internet
accessing, 29-30
antivirus basics, 257-258
attacks, 255-256
basics, 243-260
broadband connections, 245-246,
247-249
common sense tips, 258-260
connections, 245-247
dial-up connections, 29-30,
246-247, 251
high-speed access, 30
how it works, 244-245
iCloud and, 252-254
as a Mac function, 10
network connections, 247
online commercial site safety,
276-277
routers, 11
satellite connections, 246
security, 254-257
wireless connections, 249-250
Internet service providers (ISPs), 244,
248, 251, 254, 284
invoice, 26
iPhoto
albums, 194-195, 200-202
displaying digital images in,
195-197
events, 195, 202-203
Facebook connection, 206
Flickr connection, 206
illustrated, 196
keywords, 198
menu bar, 196-197
slide shows, 203-204
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iPod icon, 55 ° ] °
ISPs (Internet service providers), 244,
248, 251, 254, 284 junk mail
item selection handling, 305-308
Command key in, 119 Junk Mail filter, 306-308
dragging box for, 119 manually handling, 305-306
multiple, 119 saving messages from, 307
options, 118-119 Junk Mail filter, 306-308
use of, 118
items. See documents; files; folders oK o
1Tun§s . keyboard
adding music from CDs to, customizing, 90-92
215-218 options, 91

Album View,. 217 . repeat, 91, 92
burning audlg CDs in, 222-224 setting up, 31
Cover Flow view, 218 Slow Keys, 92

Qrid view, 218 Sticky Keys, 91-92
illustrated, 216, 217 keywords

import.ing into, 215-218 assigning, 198-200
lqunChlng, 215 iPhoto-included, 198

List view, 217 . tagging photos with, 197-200
Music Library display, 217-218 viewing images by, 200

playlists., creating, 219-222 Keywords window, 199
source list, 215

uses, 211 Y L °

volume control, 214-215
iTunes Store LANs (local area networks), 34, 247

Apple ID and, 226, 227 laptop Macs

downloading from, 227 defined, 13

finding and buying media at, desktop Macs versus, 13-14

224-227 MacBooks, 13-14

free downloads, 226 Launchpad, 57

illustrated, 225 hnks

items, browsing, 225-226 alias as, 116

shopping cart, 226 to files and folders, 116-117
iWork, 21 website, adding to Dock, 59
356
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Lion
account creation, 34
customizing, 83-104
defaults, 33-34
defined, 33
fine-tuning, 84
icons, 54-55
performance, 1
protecting, 329-340
setting up, 33-35

Lion Setup Assistant, 35

List view, 70-71

List view (iTunes), 217

local area networks (LANs)

connections, 34, 247

o o

Mac mini desktop model, 16
Mac OS X. See Lion
Mac Pro desktop model, 17
MacBook Air
price range, 17
storage, 15-16
uses, 17
MacBook Pro, 17
Macs. See also specific Macs
buying, 9-22
desktop models, 13, 14
functions of, 10
laptops, 13-14
maintaining, 341-348
prices ranges, 16-17
setting up, 23-48
turning off, 47-48
unpacking, 25-27
Magic Mouse, 32-33
maintenance
backups, 346-348

file permission, 345-346
scanning drives, 342-345
unnecessary file removal, 348
managed accounts, 39
manuals
downloading, 26-27
reading, 26
Media Browser, 162
message forums, 324-325
minimizing windows, 79
Mission Control
defined, 75
illustrated, 76
to switch windows, 75-77
modems, 246, 247
monitors
brightness, 95
CRT, 19
resolution, 18, 95, 96
selecting, 17-19
setting up, 31-32
sizes, 18-19
mouse
customizing, 94-95
multitouch gestures, 32
scroll wheel, 95
setting up, 31
movies, playing, 190-192
moving
files and folders, 124-125
windows, 80
music
adding from CD to iTunes, 215-218
CD, playing in iTunes, 218
digital, playing in iTunes, 218-219
finding and buying, 224-227
MySpace, 325-326
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network connections, 247
newsgroup security, 260
Numbers. See also spreadsheets
accessing, 172
defined, 171
format, choosing, 178-179
formulas, 183-185
movement shortcut keys, 176
templates, 173

o () o

One to One, 21
online commercial site safety,
276-277
online games, 238-239
online radio stations, 228-229
opening
files and folders, 109-112
Finder, 110
Pages documents, 153-154
programs, 56
optical line in, 29

oo

packing material, keeping, 26
Pages
accessing, 152
defined, 151
editing text within, 155-156
Outline mode, 153
typing text within, 155-156
Pages documents
background shapes, 164-165
closing, 170
creating, 152-153
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defined, 151
finding and replacing text in, 167
images in, 161-164
opening, 153-155
printing, 167-169
saving, 169
spell-checking, 165-166
tables in, 159-161
passwords
changing, 35-37
new account, 41-42
requirement with sleep and screen
saver, 340
security, 42, 260
pasting text, 157-158
PDF documents, 114-115, 133-134
permission errors
defined, 345
fixing, 345-346
reasons for, 345
phishing, 259
Photo Library, 194
photography, computing power
requirement, 14
photos
adding, 161
adding to e-mail, 208-209
cropping, 205-207
editing, 204-207
formats, 194
importing from hard drive, 194
improving, 207
moving, 163
organizing in albums, 200-202
orientation, changing, 205
red-eye, fixing, 207
removing from albums, 201
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resizing, 163-164
sharing, 326
slide shows, 203-204
tagging with keywords, 197-200
uploading from digital camera,
192-195
viewing in iPhoto, 195-197
viewing with Preview, 114-115
playlists
creating, 219-222
defined, 219
deleting, 222
illustrated, 221
iTunes creation of, 221
playing, 220
renaming, 221
selecting tracks first and, 220
tips, 220-222
tracks, adding, 220
tracks, deleting, 222
tracks, reordering, 222
tracks, reusing, 222
podcasts
finding and buying, 224-227
playing, 218-219
pointing device, customizing, 94-95
ports
Ethernet, 28
external video/audio connectors, 29
FireWire, 27
Thunderbolt, 28
USB, 28
power, for new Mac, 27
Preview, 114-115
price ranges, 16-17
Print & Scan settings, 131, 132
printers
default, choosing, 131-132

removing, 132

USB, 128
printing

application-specific parameters,

130-131

files, 128-131

Pages documents, 167-169

web pages, 280-281
productivity, as a Mac function, 10
programs

adding to Dock, 58-59

closing, 82

defined, 106

files and, 106

opening/switching from Dock, 56

recently used, launching, 118

running from hard drive, 57-58
pushing, 252

QQO

Quick Look
defined, 112
steps for using, 113-114
viewing documents with, 112-114

o R e

radio stations, online, 228-229
random access memory (RAM),
19-20
Reading List
adding pages to, 268-270
defined, 268
removing pages from, 270
steps for using, 269
real-time scanning, 258
red-eye, fixing, 207
requirements, this book, 2-3
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resizing windows, 81
resolution (monitor), 18, 95, 96
resources
local, 147
publications, 146-147
technical support, 146
user groups, 147
Restart option, 47
restoring windows, 79
rows, inserting/deleting, 183

oS e

Safari
Add Bookmark button, 265
Address text box, 262
AutoFill feature, avoiding, 277
automatic launching, 262
Back button, 264
bookmarks, 271-273
cache file, dumping, 278
download history, 280
downloading files with, 275-276
Find bar, 267-268
Forward button, 264
History file, 278
History menu, 273-274
Home button, 265
illustrated, 263
opening, 262
padlock icon, 266
Print button, 265
Search box, 266, 267
Search button, 265
Show Reading List option, 269
Stop/Reload button, 264
tabbed browsing, 274-275
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toolbar icons, 265

in visiting websites, 262-263
satellite connections, 246
saving

e-mail attachments, 299-300

e-mail messages to Drafts folder,

295

Pages documents, 169

spreadsheets, 187-188
scanners, installing, 134-135
screen savers

password requirement, 340

selecting, 89-90
screen sharing

caution, 144

defined, 143

ending, 146

sessions, ending, 146

setup steps, 144

turning on in iChat, 145
screen snapshots, 115
scroll bars, 77, 78
scrolling windows, 77-78
searching

with Spotlight, 65-68

the web, 266-267

web pages, 68
security

challenges, 330

e-mail, 259

e-mail attachment, 257, 259, 298

FileVault, 335-338

finances, online, 276-277

firewall, 332-335

Internet, 254-258

Lion, 329-340

network, 250
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newsgroup, 260
online purchase, 260
password, 42, 260
symbol, 277
user options, 339-340
security certificate, 334
setting up a Mac
account password, 35-37
date and time, 45-47
Internet access, 29-30
keyboard, mouse, and monitor,
30-32
lighting and, 25
location selection, 24-25
mouse use, 32-33
outlets and, 24-25
ports, 27-29
power, 27
temperature and, 24
turning off, 47-48
turning on and OS X setup, 33-35
unpacking and, 25-27
user account switching, 42-44
shapes
adding to document background,
164-165
resizing, 165
Shut Down option, 48
side-selection handles, 163
Sleep option, 47
slide shows, 203-204
Slow Keys, 92
social networking, 325-326
software. See also specific software
computing power requirement,
14-15
decisions in Mac purchase, 20-21

defined, 11-12
example, 12
upgrades, patches, updates, 12-13
versions, 13
Software Update
defined, 330-331
finding, 331
steps for using, 331-332
solid-state drivers, 20
sound
replacing with visual cues, 99-100
speaker setup, 212-213
volume control, 214-215
Sound settings, 213
speakers
connections, 212
setting up, 212-213
volume control, 214-215
Speech Recognition
accessing, 101
applications supporting, 104
Calibration option, 103
defined, 100
Feedback window, 103-104
Listening Method options, 102
settings, customizing, 102-104
Speakable Items folder, 103
Speakable Items On/Off, 102
Speech Commands window, 104
spell-checking, 165-166
Spotlight
defined, 65
items, opening, 67
search field, 66
search results, 66
search tips, 67-68
searching with, 65-68
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spreadsheets. See also Numbers Sound settings, 213
cells, navigating and selecting, Speech settings, 101-104
175-177 Startup Disk settings, 343
character formatting, 181 Universal Access settings, 97-98, 99
charts in, 185-187 Users & Groups settings, 36-37,
columns, inserting/deleting, 183 39-42
creating, 172-173
data, entering/editing, 177-178 oTe

defined, 172

examples, 172

format with shading, 181-182

formulas, 183-185

opening, 174-175

rows, inserting/deleting, 183

saving, 187-188
spring-loaded folders, 123

tabbed browsing, 274-275
tables
defined, 159-160
inserting, 159-161
technical support, 146
telephone jacks, 24
text
cell, alignment, 179-180

stacks i
_ copying, 157
Apple-provided, 61 cutting, 156-157
creating, 60 deleti 155
defined, 60 litine.

editing, 155-156
finding and replacing, 167
formatting, 158-159
pasting, 157-158
typing, 155-156
Thunderbolt port, 28
Tile Game widget

displaying items in, 60
removing from Dock, 60-61
standard accounts, 39
Stealth mode, 334
Sticky Keys, 91-92
streaming, 228

Syst.em.Preferences displaying, 233-234
?)de];ll:::)ng’&lGSsgeen Saver settings illustrated, 234
\% , )
89—9% & playing, 234-235

time, setting, 45-47
TraceSecurity, 277
tracks. See also playlists
adding, 220
deleting, 222
picking first, 220
reordering, 222
reusing, 222

Display settings, 96-97

General settings, 88-89

iCloud settings, 253-254

ISPs and, 254

Print & Scan settings, 131, 132

Security and Privacy settings,
339-340

Software Update, 331
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Trash
contents, checking before emptying,
122-123
emptying, 63-64
tossing files into, 122
turning off the Mac, 47-48
Twitter, 325-326

o[l o

unauthorized users, 330
uninterruptable power supply (UPS),
24
Universal Access tools
defined, 97
Hearing, 99-100
turning on, 97-98
Universal Resource Locators (URLs),
59, 244-245
UuSB
connectors, 31
flash drives, 347
port, 28
printers, 128
scanners, 134-135
user accounts
additional, adding, 38-42
administrator, 39
Home folder, 38
information, 38
managed, 39
naming, 41
password, changing, 35-37
standard-level, 39
switching between, 42-44
Users & Groups settings
Change Password, 36-37
New User, 39-42

o (/o

VeriSign, 277

version control, 124

video cards, 231

video chats
with FaceTime, 321-323
with iChat, 320-321
microphone for, 310

video editing, computing power

requirement, 14

videos
finding and buying, 224-227
playing, 218-219

VirusBarrier X6, 258

viruses, 255, 257-258, 330

volume control, 214-215

o/ o

web
navigating, 264-266
searching, 266-267

web pages
adding to Reading List, 268-270
content, finding, 267-268
home, 262, 270-271
printing, 280-281
searching, 68

web-based e-mail, 284

WebSense, 277

websites
bookmarking, 271-272
links, adding to Dock, 59
visiting, 262-264

widgets
Dashboard, 64-65, 236
installing, 235-237
Tile Game, 233-235

www.it-ebooks.info

363


http://www.it-ebooks.info/

Macs For Seniors For Dummies, 2nd Edition

windows wireless connections
closing, 81-82 Ethernet, 249
defined, 53-54 secure network, 250
illustrated, 75 setting up, 249-250
minimizing, 79
moving, 80 ® Z o
0p?9’74_75 Zoom Options sheet, 98
resizing, 81 zooming
restoring, 79 disabling, 80
to screen side, 77 mixed results, 80
scnﬂhng,77—78 with one click, 79-80
showing all open, 75, 76-77 with scroll wheel 95
switching, 56, 75-77 windows. 79-80
tiled, 76 '

zooming, 79-80
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